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Without the prior written consent of ZKTeco, no portion of this manual can be copied or forwarded in any
way or form. All parts of this manual belong to ZKTeco and its subsidiaries (hereinafter the "Company" or
"ZKTeco").

ZK is a registered trademark of ZKTeco. Other trademarks involved in this manual are owned by
their respective owners.

This manual contains information on the operation and maintenance of the ZKTeco equipment. The
copyright in all the documents, drawings, etc. in relation to the ZKTeco supplied equipment vests in and
is the property of ZKTeco. The contents hereof should not be used or shared by the receiver with any

third party without express written permission of ZKTeco.

The contents of this manual must be read as a whole before starting the operation and maintenance of
the supplied equipment. If any of the content(s) of the manual seems unclear or incomplete, please
contact ZKTeco before starting the operation and maintenance of the said equipment.

It is an essential pre-requisite for the satisfactory operation and maintenance that the operating and
maintenance personnel are fully familiar with the design and that the said personnel have received
thorough training in operating and maintaining the machine/unit/equipment. It is further essential for
the safe operation of the machine/unit/equipment that personnel have read, understood and followed

the safety instructions contained in the manual.

In case of any conflict between terms and conditions of this manual and the contract specifications,
drawings, instruction sheets or any other contract-related documents, the contract

conditions/documents shall prevail. The contract specific conditions/documents shall apply in priority.

ZKTeco offers no warranty, guarantee or representation regarding the completeness of any information
contained in this manual or any of the amendments made thereto. ZKTeco does not extend the warranty
of any kind, including, without limitation, any warranty of design, merchantability or fitness for a

particular purpose.

ZKTeco does not assume responsibility for any errors or omissions in the information or documents
which are referenced by or linked to this manual. The entire risk as to the results and performance
obtained from using the information is assumed by the user.

ZKTeco in no event shall be liable to the user or any third party for any incidental, consequential, indirect,
special, or exemplary damages, including, without limitation, loss of business, loss of profits, business

interruption, loss of business information or any pecuniary loss, arising out of, in connection with, or
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relating to the use of the information contained in or referenced by this manual, even if ZKTeco has been

advised of the possibility of such damages.

This manual and the information contained therein may include technical, other inaccuracies or
typographical errors. ZKTeco periodically changes the information herein which will be incorporated into
new additions/amendments to the manual. ZKTeco reserves the right to add, delete, amend or modify
the information contained in the manual from time to time in the form of circulars, letters, notes, etc. for
better operation and safety of the machine/unit/equipment. The said additions or amendments are
meant for improvement /better operations of the machine/unit/equipment and such amendments shall

not give any right to claim any compensation or damages under any circumstances.

ZKTeco shall in no way be responsible (i) in case the machine/unit/equipment malfunctions due to any
non-compliance of the instructions contained in this manual (ii) in case of operation of the
machine/unit/equipment beyond the rate limits (iii) in case of operation of the machine and equipment

in conditions different from the prescribed conditions of the manual.

The product will be updated from time to time without prior notice. The latest operation procedures and

relevant documents are available on http://www.zkteco.com.

If there is any issue related to the product, please contact us.

ZKTeco Industrial Park, No. 32, Industrial Road,
Tangxia Town, Dongguan, China.

+86 769 - 82109991

+86 755 - 89602394

For business related queries, please write to us at: sales@zkteco.com.

To know more about our global branches, visit www.zkteco.com.
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ZKTeco is one of the world'’s largest manufacturers of RFID and Biometric (Fingerprint, Facial, Finger-vein)
readers. Product offerings include Access Control readers and panels, Near & Far-range Facial Recognition
Cameras, Elevator/floor access controllers, Turnstiles, License Plate Recognition (LPR) gate controllers and
Consumer products including battery-operated fingerprint and face-reader Door Locks. Our security
solutions are multi-lingual and localized in over 18 different languages. At the ZKTeco state-of-the-art
700,000 square foot 1ISO9001-certified manufacturing facility, we control manufacturing, product design,

component assembly, and logistics/shipping, all under one roof.

The founders of ZKTeco have been determined for independent research and development of biometric
verification procedures and the productization of biometric verification SDK, which was initially widely
applied in PC security and identity authentication fields. With the continuous enhancement of the
development and plenty of market applications, the team has gradually constructed an identity
authentication ecosystem and smart security ecosystem, which are based on biometric verification
techniques. With years of experience in the industrialization of biometric verifications, ZKTeco was
officially established in 2007 and now has been one of the globally leading enterprises in the biometric
verification industry owning various patents and being selected as the National High-tech Enterprise for 6

consecutive years. Its products are protected by intellectual property rights.

This manual introduces the operations of ZKBio CVSecurity SmartLock.

All figures displayed are for illustration purposes only. Figures in this manual may not be exactly
consistent with the actual products.

Features and parameters with % are not available in all devices.
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Document Conventions

Conventions used in this manual are listed below:

GUI Conventions

Convention Description
Bold font Used to identify software interface names e.g. OK, Confirm, Cancel.
> Multi-level menus are separated by these brackets. For example, File > Create >
Folder.
Convention Description
<> Button or key names for devices. For example, press <OK>.
[1 Window names, menu items, data table, and field names are inside square

brackets. For example, pop up the [New User] window.

/ Multi-level menus are separated by forwarding slashes. For example,
File/Create/Folder.

Symbols

Convention Description

#*

¥ This represents a note that needs to pay more attention to.

The general information which helps in performing the operations faster.

[ B¢

adl

The information which is significant.

Care taken to avoid danger or mistakes.

> ©

The statement or event that warns of something or that serves as a cautionary
example.
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Wireless Hotel Lock Module
Statistic
Statistic Interface Description
The interface is divided into four statistics charts, as shown in Figure 1.1-1.
Each chart can be viewed across three-time dimensions: Week, Month, and Year.
(JZKBio CVSecurity 3 @ aimin ~
B ARR- Average Room Rates Week Month Years
8 g Monday Tuesday Wednesday Thursday Friday day Y
RAR- Revenue per room Week Month Years
TR- Total Revenue Week Month Years
-

ARR-Average Room Rates

Figure 1.1-1

The statistical period for a Week runs from Monday to Sunday, a Month starts from the 1st day

to the last day, and Years runs from January to December.

Click the icon in the upper right corner of the chart will refresh the current chart.

ARR-Average Room Rates
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Figure 1.1-2

Copyright © 2025 ZKTECO CO., LTD. All rights reserved.



ZKBio CVSecurity Smart Lock User Manual

Page |9

RAR-Revenue Per Room

RAR-Revenue per room is calculated as the total non-hourly check-out revenue divided by the
total number of rooms for the day.

The statistical period for a Week runs from Monday to Sunday, a Month starts from the 1st day
to the last day, and Years runs from January to December.

Click the icon in the upper right corner of the chart will refresh the current chart.

RAR- Revenue per room Week Month Years

180

Figure 1.1-3
Occupancy Rate (Excluding Hourly Rentals)

The occupancy rate excludes hourly rentals and is calculated by dividing the number of daily

stays by the total rooms.

The statistical period for a Week runs from Monday to Sunday, a Month starts from the 1st day
to the last day of the month, and Years runs from January to December.

Click the icon in the upper right corner of the chart will refresh the current chart.

OR-- OccupancyNot included hourly rate Week Month Years

Monday: 0.80

Figure 1.1-4
Total Revenue
Total Revenue is the sum of all check-out charges generated for the day.

The statistical period for a Week runs from Monday to Sunday, a Month starts from the 1st day
to the last day of the month, and Years runs from January to December.

Click the icon in the upper right corner of the chart will refresh the current chart.
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TR- Total Revenue Week Montf Years
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Figure 1.1-5

Device Management

Device Interface Description

Device management is the interface used to manage hotel lock and their associated Gateway. The

following section explains how to add a Gateway and a hotel lock to the system.

As shown in Figure 1.2-1, the interface is divided into two sections: the Gateway device list on
the left and the lock list of the selected Gateway device on the right.

You can resize the display area by dragging the divider in the middle.

IJZKBio CVSecurity i % @ zdmin
1 Sutistic y  Hotel Device Management / Device
Gateway < Browse Gateway: (a0-a3-b9-63-31-26) Lock List of the Gateway >
Device Management v
Gateway Name Gatewey MAC Addess Q ¢ Lock Name Lock MAC Address Q ¢
ORefresh  QSearch [ Delete ¥ Enable Pairing Mode  ® Disable Pairing Mode & How to add Gateway? ORefresh @ Sync Time [ Get Unlock Records (8 Emergency Unlock  C@ Cancel Emergency Uniack
Gateway Name Gatevay MAC Addr... Pairing Sta..  Gateway St.. Operations Lock Name  LockMAC .. Room Name  Hotel Facility Gateway Name Lock Status ~ Enable Fir
a0-a3-b963-3128  a0-a3b9-63-3128  Close Online 2 00-0D-6F-00-1 00-0D-6F-00-1 yinaolou1F100 a0-a3-9-63-31-28  Onine Enable 1
00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F101 a0-a3-09-63-31-28  Onine Enable 1
00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F102 20-23-09-63-3128  Onine Enable 1
00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F1 20-23-60-63-3128  Onine Enable 1
00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F104 a0-a3-49-63-31-28  Onlne Enable 1
<
[Ef  Hotel Management >
T2 Card Management >
[ Room Management >
1 50 rows per page * JumpTo 1 11Pzge  Total of 1 records 5 50 rows per page *  JumpTo 1 1 Page  Total of 5 records

E] ReportManagement >

Figure 1.2-1

Gateway

Adding a Gateway by Searching

Using a mobile device, connect to the Wi-Fi network using the information (credentials)
provided on the back of the Gateway, log in, configure the Remote Server address, and save

the settings, as shown in Figure 1.2-2.
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<« @ O 8 192168827/cgi-t B T 2 » =

@) ZKBio CVSecurity

OpenWrt  Staws~ System~ Network~ ZKTeco Logout

ZKTeco
Remote server

P 172.16.12.23

PORT | 18088

Save & Apply

Powered by LuCl ZhongKong branch (git-22.132.62904-b5befa7) / OpenWit
18.06-SNAPSHOT r0-babefi71

Figure 1.2-2

In Hotel > Device Management > Device module, click Search to find the Gateway

information, and click Add to complete the Gateway addition, as shown in Figure 1.2-3.

New x

Searched devices count:2

Total Progress 100% Number of devices added:1
Gateway |IP Address Gateway MAC Address
Gateway IP Address Gateway MAC Address Operations
192.168.51.190 a0-a3-b9-63-30-be dd
192.168.51.191 al0-a3-b9-63-31-28 This device has been

Figure 1.2-3

Other Function Description

In the upper search bar, you can search for a Gateway device by Gateway Name and Gateway
MAC Address, as shown in Figure 1.2-4.

Gateway

Gateway Mame Gateway MAC Address Q &
Figure 1.2-4

The middle row is the operation bar. To Delete, Enable Pairing Mode, or Disable Pairing Mode,

first select the desired Gateway, as shown in Figure 1.2-5.
> Refresh ( Search I Delete =+ Enable Pairing Mode (& Disable Pairing Mode {3 How to add Gateway?
Figure 1.2-5

The refresh button is used to refresh the Gateway device list when the data in the Gateway

device list is not synchronized.

The search button is used to search for a new Gateway device and add it to the Gateway

device list.
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Users can click the Edit icon or Gateway name at the end of the Gateway device list to enter
the Gateway editing window, and you can modify the Gateway name for easy identification.
Additionally, the Gateway MAC address cannot be edited. As shown in Figure 1.2-6.

Gateway < Edit x
Gateway Name Gateway MAC Address Q ¢ Gateway Name™ | a0-a3-b9-63-30-be
Gateway MAC Address™ al-a3-b9-63-30-be

O Refresn Q Search @ Delete = Enable Pairing Mode ~ © Disable Pairing Mode {5 How to add Gateway?

Gateway Name Gateway MAC Addr... Pairing Sta... Gateway St.. Operations

80-33-b9-53-30-be a0-a3-b9-63-30-be Qnline frd

Cancel
20-a3-b9-63-31-28 a0-a3-b9-63-31-28 Online a

After selecting the Gateway and clicking the Delete button, the system will confirm whether
to delete the Gateway device again. (Are you want to perform the Delete operation?) In
addition, if the Gateway is connected and a lock device is in use, the Gateway cannot be
deleted. Users must first delete the lock device, as shown in Figure 1.2-7.

Gateway

< Browse Gateway: (a-a3-b9.63-30-be) Lock List of the Gateway
Gateway Name Gateway MAC Address Q @

Lock Name Lock MAC Address Q &

O Refresh  Q Search [ Delete  =F Enable Pairing Mode  © Disable Pairing Mode & How to add Gateway? O Refresh @ Sync Time (& Get Unlock Records

GG Emergency Unlock & Cancel Emergency Ur
Gateway Name Gateway MAC Addr... Pairing Sta... Gateway St.. Operations Lock Name Lok MAG Room Name ~ Hotel Facility ~Gateway Name Lock Status
a0-a3-b9-63-30-be  a0-a3-09-63-30-be  Close Online 2
a0-23-b9-63-21-28  a0-a3-09-63-31-28  Close Online 2

Prompt

Are you want to perform the Delete operation?

Cancel

Mo data

Figure 1.2-7

After selecting the Gateway and clicking the Enable Pairing Mode button, the Gateway will

enable the pairing mode. In the list, the Pairing Status will display as Open after refresh. This
mode automatically closes after 1 hour, as shown in Figure 1.2-8.

Gateway Name Gateway MAC Addr...  Pairing Status Gateway Status Operations

a0-a3-b3-63-30-be al-a3-b9-63-30-be Op

pen Online ﬁ
a0-a3-b9-63-31-28 al-a3-b9-63-31-28 Close Online Z
Figure 1.2-8

A Pairing Status displaying as Open indicates that the Gateway allows the addition of hotel

lock devices via the Default Net Card. A Pairing Status of Close indicates that the Gateway
does not allow the addition of hotel lock devices through the Default Net Card.
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Check the Gateway Status to verify whether the network status of the Gateway is normal.

Online indicates that the Gateway's network status is normal, while Offline indicates that the

Gateway is disconnected, as shown in Figure 1.2-9.

Gateway Mame Gateway MAC Address Pairing Status Gateway Status Operations

a0-a3-b9-63-31-28 al-a3-h9-63-31-28 Open Online ﬁ
a0-a3-b9-63-30-be al-a3-b9-63-30-be Close Offline e
Figure 1.2-9

Note: Pairing Status simply indicates whether the Gateway allows new hotel locks to be added. It

does not affect normal communication between the Gateway and already added hotel locks.

Click How to add Gateway? to open a help document where users can learn how to configure

the Gateway's local IP, server IP, and port settings.

Lock List of the Gateway
Hotel Lock Binding Gateway
Connect to the card reader and register a Default Net Card in Room Management > Hotel

Settings module, as shown in Figure 1.2-10.

ZIK CVSecurity "

Figure 1.2-10

Enable Pairing Mode on the Gateway, and swipe the Default Net Card over the card reader on
the hotel lock. When you hear two prompts followed by the same prompt again, the lock is

successfully added, as shown in Figure 1.2-11.

O Refresh @ Sync Time B Get Unlock Records 0@ Emergency Unlock  C@ Cancel Emergency Unlock T Delete Lock ~ Enable  ® Disable

Lock Name Lock MAC . Room Name Hotel Facility Gateway Name Lock Status Enable Firmware V Last Sync Time Operations

00-0D-6F-00-1 00-0D-6F-00-1 Add Room aD-a3-b9-63-31-28 Online Enable 147 2023-08-15 04:31:00 2 W @

Figure 1.2- 11
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Hotel Lock Binding Room

After the hotel lock is added, click the lock name, the Edit icon under Operation, or the room

name to assign a room. This will open the lock editing interface, as shown in Figure 1.2-12.

Edit *®
Lock Name™ DD-DD—BF-DD-W-ED—BZ-EB_i
Lock MAC Address® 00-0D-6F-00-17-60-62-EB
Room Name*
Hotel Facility
Cancel
Figure 1.2-12

Click room name, select the room to be bound, click > or double click the room name, and

click OK to finish, as shown in Figure 1.2-13.

Select Room Name X
Room Name Q ¢
Alternative Selected(1)
Room Name Room Name
yihaolou2F200 yihaolouiF100

yihaolou2F201

4 — >

1-2 50 rows per page
. ] »

Cancel

Figure 1.2-13

When the selected room is bound to the public room of the hotel, the system will
automatically identify the hotel facility to which the room number belongs and display it in

the column of Hotel Facility, which cannot be edited, as shown in Figure 1.2-14.
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Edit x
Lock Name* ;pU-OD—6F~00-1?-60—52-EB |
Lock MAC Address™ (0-0D-6F-00-17-60-62-EB
Room Name® yihaolou1F100
Hotel Facility Public Room 1
Cancel
Figure 1.2- 14
Click OK again to complete room binding, as shown in Figure 1.2-15.
Lock Name Lock MAC ... Room Name Holel Facility Gateway Name Lock Status Enable Firmware V... Last Sync Time Operations
00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F100 Public Room 1 a0-a3-b9-63-31-28 Online Enable 147 2023-08-16 04:31:00 w @

Hotel Lock Unbinding Room

Figure 1.2-15

Users can click the Reset icon in Operations module to unbind the room, as shown in Figure

1.2-16.

S Refresh @ Sync Time & Get Unlock Records

Lock Name Lock MAC ... Room Name

LG Emergency Unlock

Hotel Facility Gateway Name

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F100 Public Room 1 a0-a3-b9-63-31-28

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F101

00-0D-6F-00-1 00-0D-6F-00-1 yinaolou1F102

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F103

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F104

a0-a3-b9-63-31-28

a0-a3-b9-63-31-28

a0-a3-b9-63-31-28

a0-a3-b9-63-31-28

Cd Cancel Emergency Unlock

Lock Status

Qnline

Online

Online

Online

Online

Enable

Enable

Enable

Enable

Enable

Enable

Figure 1.2-16

O Delete Lock

~ Enable  © Disable
Firmware V Last Sync Time
1.4.7 2023-08-16 04:31:00
147 2023-08-16 04:31:01
147 2023-08-16 04:31:02
147 2023-08-16 04:31:03
147 2023-08-16 04:31:05

After the process is complete, the room is unbound and its status is displayed

shown in Figure 1.2-17.

Lock Name Lock MAC .. Room Name Hotel Facility

Gateway Name

FUrOD—SF—UO—ﬂ 00-0D-6F-00-1 Add Room

30-a3-p9-63-31-28

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F101
00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F102
00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F103

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F104

Other Functions Description

a0-a3-b9-63-31-28

a0-a3-b9-63-31-28

a0-a3-b9-63-31-28

a0-a3-b9-63-31-28

Lock Status

Online

Online

Online

Online

Online

Enable

Enable

Enable

Enable

Enable

Enable

Figure 1.2-17

Firmware V

Last Sync Time

2023-08-16 04:31:00

2023-08-16 04:31:01

2023-08-16 04:31:02

2023-08-16 04:31:03

2023-08-16 04:31:05

Operations

2 a[m]

2 W @

I

w

&

I
B

o

I

j

)

as unbound, as

Operations

2 W

=
B

2

| |
E = G
5 8 &

|
=]
]

The hotel lock device list displays all added hotel locks by default. When a Gateway is

selected on the left, all hotel locks associated with that Gateway will be automatically filtered

and displayed on the right, as shown in Figure 1.2-18.
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Gateway

< Browse Gateway: (a0-a3-b9-63-31-28) Lock List of the Gateway

Gateway Name Lock Name Lock MAC Address € |l

G Refresh Q search G Refresh @ sync Time [ Get Unlock Records (@ Emergency Unlock  [d Cancel Emergency Unlock @ Delete Lock  +/ Enable  ® Disable

Gateway Name Ga Lock Name Lock MAC .. Room Name  Hotel Facility Gateway Name Lock Status  Enable Firmware V.. Last Sync Time Operations

&

80-33-D9-63-31-28 a0 00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F100 a0-a3-b9-63-31-28 Online Enable 147 2023-08-14 10:01:32

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F101 ad-a3-b0-53-31-28 Online Enable 147 2023-08-14 09:44:57

L LY
E B &
8

1]

00-0D-6F-00-1 00-0D-6F-D0-1 yihaolou1F102 a0-a3-b9-63-31-28 Online Enable 147 2023-08-14 09:44:59

k)

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F103 a0-a3-b9-63-31-28 Online Enable 147 2023-08-14 09:45:00

(LS
B &
]

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F104 a0-a3-b0-53-31-28 Online Enable 147 2023-02-14 00:45:01

Figure 1.2-18

In the search bar, users can search for a hotel lock device by lock names and lock MAC address,

as shown in Figure 1.2-19.

Lock Name Lock MAC Address Qa ¢
Figure 1.2-19

The middle row is the operation bar. To perform operations, select the hotel lock to be

operated, as shown in Figure 1.2-20.

3 Refresh (& Sync Time & Get Unlock Records (@ Emergency Unlock Cg Cancel Emergency Unlock  © Delete Lock ~ Enable & Disable

Page |16

Figure 1.2- 20

The Refresh button can refresh the list of hotel lock devices. If a new hotel lock is added to the
network, the interface doesn’t update automatically, users can manually click the Refresh

button to see the newly added hotel lock.

Clicking the Delete Lock button delete the selected lock. Alternatively, click the Delete icon

next to each lock in the lock list is the same function.

Note: When the hotel lock is deleted, the Gateway will remove the hotel lock out of the Zigbee
network. If the hotel lock wants to be added again, it is necessary to swipe the Default Net
Card to re-enter the network again (the Gateway has enabled the Enable Pairing Mode
firstly). Swipe the Default Net Card directly at the bound hotel lock, the lock can be forcibly
deleted, and if the Enable Pairing Mode is enabled, it will be added again after deletion.

Sync Time manually synchronize the time. If the last Sync Time of a lock has not been updated
for a long time, users can use this button to manually synchronize the time.

Note: Last Sync Time refers to the last time the system synchronized with the hotel lock.
Normally, the system and the hotel lock will automatically synchronize the time at 4:00 AM
every day, but the actual synchronization typically occurs around 4:30 AM. The hotel lock will
also automatically synchronize the time when the power is off and then restarted. Additionally,
when a hotel lock is added to the network, it will synchronize the time once, as shown in
Figure 1.2-21.
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O Refresh @ Sync Time Get Unlock Records 0@ Emergency Unlock [g Cancel Emergency Unlock T Delete Lock + Enable & Disable

Lock Name Lock MAC Room Name Hotel Facility Gateway Name Lock Status Enable Firmware V.. Last Sync Time Operations

00-0D-6F-00-1 00-0D-6F-00-1 Add Room a0-a3-b9-63-31-28 Online Enable 147 2023-08-15 04:31:00 2 W @

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F101 a0-a3-b9-63-31-28 Online Enable 1.47 2023-08-15 04:31:01 2 W E

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F102 a0-a3-b9-63-31-28 Online Enable 1.47 2023-02-15 04:31:02 2 W @

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F103 a0-a3-b9-63-31-28 Online Enable 1.47 2023-08-15 04:31:03 ﬁ E EJ

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F104 a0-a3-b9-63-31-28 Online Enable 147 2023-08-15 04:31:05 Z W @
Figure 1.2- 21

¢ Get Unlock Records: When users notice that the unlock records of a hotel lock are not
complete, can manually fetch all the unlock records saved by the hotel lock device through

Get Unlock Records button (the device can save a maximum of 200 unlock records).

* Emergency Unlock: When requiring an emergency unlock, users can use Emergency Unlock
button to keep the lock normally open. In the normally open state, the hotel lock can directly
press down the handle to open the door, without swiping the card. At the same time, on the
Room Monitor interface, the normally open icon is displayed in the room status

corresponding to the hotel lock, as shown in Figure 1.2-22.

yihaolouiF100
Figure 1.2-22

¢ Cancel Emergency Unlock: If users need to restore the lock to its normal state after the
emergency is resolved, they can click the Cancel Emergency Unlock button. This action will
return the hotel lock to its normal operating mode. On the Room Monitor interface, the
normally open icon corresponding to the room status disappears, as shown in Figure 1.2-23.

yihaolou1F100

Figure 1.2-23

o Disable: When the hotel lock needs to be disabled for some reasons, users can click Disable
button to set the hotel lock to the suspended state. In the suspended state, the system will

suspend communication with the hotel lock.
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Enable: If users want to cancel the suspended use of the hotel lock, clicking Enable button to
re-enable the hotel lock. The system recovers the communication with the hotel lock and
sends the synchronization time and basic lock settings to the hotel lock again, as shown in
Figure 1.2-24,

Lock Name Lock MAC Room Name Hotel Facility Gateway Name Lock Status Enable Firmware V. Last Sync Time Operations
00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F100 a0-a3-b9-63-31-28 QOnline Enable 147 2023-08-14 10:01:32 Z W ®
00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F101 a0-a3-b9-63-31-28 Online Disable 147 2023-08-14 15:54:31 Z W @/

Figure 1.2-24

Firmware Version: The firmware version of the hotel lock. After the hotel lock is added to the
network, the firmware version information will be displayed synchronously. This function is
used to provide the firmware version information when the hotel lock requires after-sales

support, as shown in Figure 1.2-25.

Lock Name Lock MAC .. Room Name Hotel Facility Gateway Name Lock Status Enable Firmware Version Last Sync Time Operations

00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F100 Public Room 1 a0-a3-b9-63-31-28 Online Enable 147 2023-08-15 04:31:00 Z W @
00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F101 a0-a3-b9-63-31-28 Online Enable 147 2023-08-15 04:31:01 Z W E
00-0D-6F-00-1 00-0D-8F-00-1 yihaolou1F102 al-a3-b9-63-31-28 Online Enable 1.4.7 2023-08-15 04:31:02 2 uw =
00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F103 a0-a3-b9-63-31-28 Online Enable 147 2023-08-15 04:31:03 2 W @
00-0D-6F-00-1 00-0D-6F-00-1 yihaolou1F104 a0-a3-b9-63-31-28 Online Enable 147 2023-08-15 04:31:05 2 w @

Figure 1.2-25
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1.3 Hotel Management

1.3.7 Room Monitor

On Room Monitor interface allows users to view and manage room status, including displaying
room details, performing both individual and team check-ins and check-outs, and making room

reservations simultaneously, as shown in Figure 1.3-1.

(JZKBio CVSecurity = % @ admin ~

B swtistic 5 Hotel/ Hotel Management / Room Monitor

E% Device Management > Room Status: Al 7 ® Vacant  (7) ® NeedsCleaning (0) @ Checkedn (0) ® Overstayed (0) ® Mantaning () @ StopUse  (0)

[ Hotel Management R More: DailyRent  (0) By Hour ©) Double Lock  (0) Due in © Due out ©)

B oM menme
Reservation List

Read Card Clear Card Reader Driver-Installed, Version1.0.13 Printer Driver-Installed, Version6 2.2.6
N
”~N

Building:yihaolou _Floor:1F. Room No.:yihaolou1F100
Status:Vacant
Public Room Vacant Vacant Vacant Lock Name: 00-0D-6F-00-17-60-
62-EB
Checkin  Reservation Roor
yiaolou1F100 yihaolouiF101 yhaolou1F102 yihaoloutF103 yihaolouiF104

Notes: test room
Building:yihaclou _Floor:2F Device: TV,Safe Box
Room Type: shuangren

Room Size: 10
Number of Beds: 2

Maximum Number of Guests: 3
Daily Rate: 200

Hourly Rate: 20

Overstay Hourly Rate: 40
Deposit Amount: 100

yinaolou2F200 yinaolou2F201

3 Card Management >
Room Management >
[E] Report Management >

Figure 1.3-1
1.3.1.1 Search

o Building and Floor search bar: Select the name of the building and floor through the drop-
down list, and the following room list will be synchronized to screen out eligible rooms. Click

the Clear Search button to clear the filter criteria.

Note: Users need to select the building first, and then select the floor, as shown in Figure 1.3-2.

o Floor: e =
Building: I 2
== 2F
yinaolou || Ressuecd :
5 1F i
[ . il —Hmm‘

Figure 1.3-2

¢ Room Type search bar: Select the room type name from the drop-down list, the following
room list will be synchronized to screen out eligible rooms. Click the Clear Search button to

clear the filter criteria, as shown in Figure 1.3-3.

Room Type: — %

shuangren

Figure 1.3-3
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Room Status and More search bar: Clicking the corresponding room status, eligible rooms

[ ]
will be automatically selected from the following room list, as shown in Figure 1.3-4.
Room Status: All 7) L] Vacant () @ Needs Cleaning (0) @ Checked-in (@ @ Qverstayed (0) ®  Maintaining ) ® Stop Use (0)
More: Daily Rent  (0) By Hour ©) Double Lock  (0) Due in ©) Due out (0)

Figure 1.3-4

All: Screen All rooms, click the All button, the system will filter and show all available

1)
rooms. The number in parentheses indicates how many rooms match the selected status,

as shown in Figure 1.3-5.

® Overstayed () ® Maintaining (1) @ StopUse (1)

Room Status: Al 7) ®  Vacant (4)  ® NeedsCleaning (0) ® Checked-n (1)
More: Daily Rent (0 ByHour (1) Double Lock (1) Due in ©) Dueout (1)
Building: — ~| Floor: I— ~| Room Type: I— - Ciear Search

Read Card Clear Card Reader DriveriInstalled, Version1.0.13 Printer Driver-Installed, Version.2.2.6
~
N

Room No.:
Status:

Building:yihaolou__Floor:1F
Lock Name:

Public Room

test Maintaining Not In Use
Check-in - Reservation Room
& X
yinaolou1F103 yihaolou1F104

yihaoloulF101

yihaoloutF102

yihaolou1F100
Building:yihaolou__Floor:2F

No Lock

yihaolou2F200 yihaolou2F201

Figure 1.3-5

Clean (Vacant): Click Vacant button, the system will screen out all unoccupied rooms.

2)
The number in parentheses indicates how many rooms match this status. Empty rooms

are displayed in green, as shown in Figure 1.3-6.

® NeedsCleaning (1) @ Checkedn (1) @ Overstayed (0) ® Maintaining (1) @ StopUse (1)

Room Status: Al @ ®  vacant
More: DailyRent  (0) ByHour (1) Double Lock (1) Duein  (0) Dueout (1)
Building: [— ~| Floor fm— ~| Room Type: — - et

Read Card Clear Card Reader Driverinstalled, Version1.0.13 Printer Driverinstalled, Version6 22,6
~
N

Room No.:yihaolou1F100

Building:yihaolou _Floor:1E
Status:Vacant
Lock Name: 00-0D-6F-00-17-60-

62-EB

Public Room

Checkin Reservation Room

yihaolou1F100

Building:yihaolou _Floor:2F

Figure 1.3-6

Dirty Room (Need Cleaning): Click Need Cleaning button will filter out rooms that

3)
require cleaning. The number in brackets indicates the count of dirty rooms, which are

displayed in an earthy yellow color, as shown in Figure 1.3-7.
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Room Status: Al [4) ®  Vacant (2 @ NeedsCle ) ® Checkeddn (1) ® Overstayed (1) ® Maintaining (1) @ StopUse Q)
More: DailyRent (1) By Hour V) Double Lock (1) Due in ) Due out )
Building: - | Floor. — + | Room Type: Fl

Clear Card Reader Driver:Installed, Version1.0.13 Printer Driver:Instalied, Version6 2.2.6
N

N
Building:yihaolou _Floor:1F Room No.:yihaolou1F100
Status:Needs Cleaning
Public Room Lock Name: 00-0D-6F-00-17-60-62-EB

Check-in Reservation Room

Figure 1.3-7

4) Checked-In: Click Checked-in button, the system will screen out all occupied rooms. The
following brackets represent the number of rooms that match the status of the room. The
room is displayed in sky blue, as shown in Figure 1.3-8.

Room Status Al 4] ® vacant  (2) ® NeedsCleaning (1) ® Checkedr ® Overstayed (1) ® Maintaining (1) @ StopUse (1)
More: Daily Rent (1) ByHour (1) Double Lock (1) Duein (1) Dueout (1)
Building: ~| Floor. e ~|  Room Type =

Clear Search
Read Card Giar Cara ReaderDnveristale,Version1 .13 Prinr Dverinsae, Version6 226
A
N
Building:yihaolou Floor:1F

Room No.:yihaolou1F101
Status:Check-in
test

Lock Name: 00-0D-6F-00-17-60-57-91

Reservation Room

yinaolou1F 101 First Name: test
Last Name: bug
Phone Number: +86 18800001111
E-mail: jiakal.zha@zkteco.com
Card No.: 3320407305 Report Card Loss
CheckeIn Time: 08-15 1525
Check-Out Time: 08-16 12:00
Days/Hours to Stay: 1Day(s)
Guest Count: 1

Figure 1.3-8

5) Overstayed: Click this button, the system will screen out all late check-out rooms. The
following brackets represent the number of rooms that match the status of the room.

Delayed rooms are shown in blue purple, as shown in Figure 1.3-9.

Room Status: Al 4 ® vacant  (3) ® NeedsCleaning (0) @ Checkedn (1) @ ® Maintaing (1) @ StopUse (1)

More DailyRent (1) ByHour (1) Double Lock (1) Duein (1) Dueout (1)

Building: ~| Fioor: — ~| Room Type: p—

Clear Search
Read Card Clear Card Reader Driver:Installed, Version1.0.13 Printer Driver:Instalied, Version6 2.2.6
N

~N

Building:yihaolou Floor:1F Room No.:yihaolou1F102
Status:Overstayed
test

Lock Name: 00-0D-6F-00-17-60-49-B7

Check Reservation Room
yinaolou1F102

First Name: test

Last Name: bug

Phone Number: +86 18800001111

E-mail: jiakai zhan@zKeco.com

Card No.: 1104696834 Report Card Loss
Check-In Time: 08-15 15:17

Check-Out Time: 08-15 18:17

Days/Hours to Stay: 3Hour(s)

Guest Count: 1

Figure 1.3-9

6) Maintaining: Click this button, the system will screen out all the rooms to be maintained.
The following brackets represent the number of rooms that match the status of the room.

The room to be repaired is displayed in grey, as shown in Figure 1.3-10.
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Room Status: Al 4] ® Vacant  (3) ® NeedsCleaning (0) ® Checkeddn (1) ® Overstayed (1) @ Mantaining ® sSopuse (1)
More: DailyRent (1) ByHour (1) Double Lock (1) Duein (1) Dueout (1)
Building == ~| Fioor: = ~| Room Type:

5 [ cearsearcn ]
Read Cara ReaderDivernstates, Version 015 i Dver s Versions 226
A
”~N

Building:yihaolou _Floor:1F

Room No.:yihaolou1F103
Status:Maintain

Maintaining Lock Name: 00-0D-6F-00-17-60-46-47
K Reservation Room
%0 e

yinaoiou1F103

Figure 1.3-10

7) Stop Use: Click this button, to filter out all the suspended rooms. Rooms in Stop Use
status cannot be booked or checked into. The suspended room is displayed in dark grey,

as shown in Figure 1.3-11.

Room Status; Al @ ® vacant  (2) ® NeedsCleaning (1) @ Checkedin (1) @ Overstayed (1) ® Maintaining (1) ® &
More: DailyRent (1) ByHour (1) Double Lock (1) Duein (1) Dueout (1)
Building J— ~| Fioor: J— ~ | Room Type:

B [ cearseaen ]
Reader Driver:Installed, Version1.0.13 Printer Driver:Installed, Version6 2.2.6
N

~N

Building:yihaolou Floor:1F Room No.:yihaolou1F104
Status:Stop Use
Not In Use Lock Name: 00-0D-6F-00-15-62-47-60
Reservation Room
yinaolou1F104

Figure 1.3- 11

8) Daily Rent: Click this button, to filter out all the rooms rented by the day after clicking.
The following brackets represent the number of rooms that match the status of the room,

as shown in Figure 1.3-12.

Room Status: Al U] ® Vacant  (2) ® NeedsCleaning (1) ® Checkeddn (1) ® Overstayed (1) ® Maintaining (1) ® StopUse (1)
More: r ByHour (1) Double Lock (1) Duein (1) Dueowt (1)
Building J— < | Floor: f— ~| Room Type:

-
Read Cara Ciear Card Reader rverinsated, Versian. 013 Pinler Orherinsaled Version 226
R

Building:yihaolou _Floor:1F

Room No.:yihaolou1F101
Status:Check-in
Lock Name: 00-0D-6F-00-17-60-57-91

Reservation Room

yinaolou1F101 First Name: test

Last Name: bug

Phone Number: +86 18800001111

E-mail: jiakal zha@zkteco.com

Card No.: 3320407305 Report Card Loss
Check-In Time: 08-15 15:25

Check-Out Time: 08-16 12:00

Days/Hours to Stay: 1Day(s)

Guest Count: 1

Figure 1.3-12

9) By Hour: Click this button, to filter out all rooms rented by the hour. The following
brackets represent the number of rooms that match the status of the room, as shown in
Figure 1.3-13.
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Room Status: Al @ Vaant (2 ® NeedsCleaning () @ Checkeddn (2) ® Overstayed (0) ® Mantaning (1) @ StopUse (1)
More: DaiyRent (1) ByHour (1 Double Lock (1) ouein (1) Dueout (1)
Buikding = | Fioor = ~ RoomType: = 5 Clear Search
Read Card Clear Card Reader Driver:installed, Version1.0.13 Printer Driver Installed, Version6.2.2.6
~

~N

Building:yihaolou _Floor:1F. Room No.:yihaolou1F102

Status:Check-in
test Lock Name: 00-OD-6F-00-17-60-49-B7
Checkin Resenvation Room
&
yinaokoutF102 First Name: test

Last Name: bug

Phone Number: +86 4001053868

E-mail: jiakai zh@zkteco.com

Card No.: 1104696834 Report Card Loss
CheckIn Time: 08-15 15:42

Check-Out Time: 08-15 18:42

Days/Hours to Stay: 3Hour(s)

Guest Count: 1

Figure 1.3-13

10) Double Lock: Click this button, to filter out all the unlocked rooms. The following
brackets represent the number of rooms that match the status of the room, as shown in
Figure 1.3-14.

Room Status: Al (U] ® vacant  (2) @ NeedsCleaning (1) ® Checkeddn (2) ® Overstayed (0) @ Maintaining (1) ® StopUse (1)
More: DailyRent (1) ByHour (1) ouble Lock (1 Duein (1) Dueowt (1)
Building: ~| Fioor ~ | Room Type:

.4 Clear Search
[T G ST TSR e rver insiales, Vrsiont 0.13 Prter ier nsialed, Vrsiond 226
n

N

Building:yihaolou _Floor:1F

Room No.:yihaolou1F100

Status:Needs Cleaning
Public Room Lock Name: 00-0D-6F-00-17-60-62-EB
Check Resenvation Room
Pl

yinaoloutF100

Figure 1.3- 14

11) Due in: Click this button, to filter out all the rooms booked for today. The following
brackets represent the number of rooms that match the status of the room, as shown in
Figure 1.3-15.

Room Status: Al m ® vaant  (3) ® NeedsCleaning (1) ® Checkeddn (2) @ Overstajed (0) @ Maintaining (0) ® StopUse (1)
More DailyRent (1) ByHour (1) Double Lock (1) Due i 1) Dueowt (1)
Building: ~| Fioor = ~| Room Type:

:
Read Card Clear Card Reader Drivernstalled, Version1.0.13 Printer DriverInstalied, Version6.2.2.6
N
N

Building:yihaolou _Floor:1F. Room No.:yihaolou1F103

Status:Vacant
test Lock Name: 00-0D-6F-00-17-60-46-47

Checkin Reservation Room

yinaolou1F103 Booking Time: 2023-08-15 19:30:13

‘Scheduled Check-in Time: 2023-08-15 12:00:00
Scheduled Check-out Time: 2023-08-16 12:00:00
Reservation Range: 1Day(s)

First Name: test

Last Name: bug

Phone Number: 4001053868

E-mail: jiakai zh@zkteco.com

Figure 1.3-15

12) Due out: Click this button, to filter out all the rooms that are expected to check out today.
The following brackets represent the number of rooms that match the status of the room,

as shown in Figure 1.3-16.
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Room Status: Al (Y} L] Vacant (@) ® Needs Cleaning (1) ®  Checked-In @ ®  Overstayed ) ®  Maintaining ©) ®  StopUse ()
More: Daily Rent (1) By Hour [0 Double Lock (1) Due in [V Due ou 1)
Building: To— + | Floor. - | Room Type: s

Read Card Gar Card Reader Over nsated, Versont. 0 13 Priter Drver saled, Versiond 226
mn
A

Building:yihaolou _Floor:1F

fest

&

yinaokou1F102

Figure 1.3-16

1.3.1.2 Room Status

Room No.:yihaolou1F102
Status:Check-in

Lock Name: 00-0D-6F-00-17-60-49-B7

Reservation Room

First Name: test

Last Name: bug

Phone Number: +86 4001053868

E-mail: jiakal zh@zkteco.com

Card No.: 1104696834 Report Card Loss
Check-In Time: 08-15 15:42

Check-Out Time: 08-15 18:42

Days/Hours to Stay: 3Hour(s)

Guest Count: 1

The Room Status button pops up when you right-click the room icon. The operable options are

shown in Figure 1.3-17.

Public Room

Individual =

Group Management= ] AE
Room Siatus yihaolou1F100
Needs Cleaning
Maintain

Stop Use

Figure 1.3-17

Building:yihaolou rrwworaer—

Vacant

Maintain

Stop Use

o  Vacant: Restore the normal use of the room, when the room is set to a special room status (to

be cleaned, to be repaired, suspended), users can use this function to restore the room status.

* Needs Cleaning: The room needs to be cleaned.

¢ Maintain: The room needs to be maintained.

e  Stop Use: The room is not in use.Rooms in Stop Use status cannot be booked or checked into.

* Relieve still Open: When a door is opened with a card and remains open for more than one

minute, an alarm is triggered (indicated by 10 buzzer sounds), and an alarm icon appears in

the room list. Hotel staff can use this function to clear the alarm icon for the unlocked door.

Shown in Figure 1.3-18.
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Individual =

= ihaolou1F103

Relieve still Open

Figure 1.3-18
1.3.1.3 Main Status Change Process of Rooms
¢ Vacant > Due in > Checked-in > Due out > Overstayed > Needs Cleaning.
e Vacant > Individual > Checked-in > Due out > Overstayed > Needs Cleaning.
e Vacant > Group Management > Checked-in > Due out > Overstayed > Needs Cleaning.

1.3.1.4 Other Status Change Process of Rooms

—
y_mmmwwz' molou1F1lH
Threw the deadbolt closed Unlock deadbolt
-
yihaolou1F102 MM1F1'H
Door open alarm Turn off alarm
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Public Room

P

yihaolou1F100
Needs cleaning

Maintaining

yihaolou1F104
Maintenance

Public Room

yihaolou1F100

Public Room

yihaolou1F100
Clean up

Vacant

yihaclou1F 104

Complete maintenance

Pubfic Room

yihaolou1F100
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Emergency unlocking

Not In Use

yihaolou1F104

Cancel unlocking

Vacant

yihaclou1F 104

Stop use Return to use
No Lock Vacant
-
yihaclou2F201 yihaolou1F 104
No lock Bound lock
-
yihaolou1F104
C2F004
Low battery power Sufficient Power

1.3.1.5 Room Status and Check-in Reservation

When a room is in a "Stop Use" or "No Lock" state, it cannot be booked and checked into, and it will
not appear in the Room Monitor interface. If the room is in a "Maintaining" state, it can be booked

but not checked into.

When you right-click these types of room in the real-time room list, it will be found that the
Individual and Group Management services in the menu are grey and not optional, as shown in
Figure 1.3-19.

Maintaining

Not In Use

yihaolou1F104 yihaolou2F201

yihaolou1F104

Rooem Status = Room Status = =

Figure 1.3-19

Room in the 'Uncleaned' state can still be reserved, even though it has not been cleaned. It will

continue to appear in the Reservation Management list, as shown in Figure 1.3-20.
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g

yinaolou1F 104

Room Status =

Figure 1.3-20
1.3.1.6 Room Information

In the Room List, selecting any room on the right side of the room page will display its current
information, including Room No., Status, and Lock Name in the header. The available tabs are

Check-In Information, Reservation Information, and Room Information, as shown in Figure 1.3-21.

Room No.:yihaolou1F100
Status:Vacant

Lock Name: 00-OD-6F-00-17-60-62-EB

Check-in Reservation Room

Figure 1.3- 21

e  When one of the rooms in the list is selected, the room information bar will be refreshed
according to the latest information.

e It displays basic information such as Room Number, Room State, and the name of the hotel
lock, as shown in Figure 1.3-22.

Room No_-Masai mara
AZ2Floor-002

Status Vacant

Figure 1.3-22
e  Also, it shows the room reservation information or the room check-in information, as shown in

Figure 1.3-23.

Check-in Reservation Room

Figure 1.3-23

o In the room check-in information, users can see the name, contact number, check-in time,
expected check-out time, the number of days (hours), and the number of people who have

checked-in already, as shown in Figure 1.3-24.
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Reservation Room

First Name: test

Last Name: bug

Phone Number: +86 18800001111

E-mail: Jiakai.zha@zkteco.com

Card No.: 3320407305 Report Card Loss
Check-In Time: 08-15 15:25

Check-Out Time: 08-16 12:00

Days/Hours to Stay: 1Day(s)

Guest Count: 1

Figure 1.3-24

In the room check-in information, the user can also see how many room cards have been

issued to the current room. There is a Report Card Loss button on the back of each room, click

this button to Report the Lost Card immediately. After reporting the loss, click the Clear Lost

Card Report button to cancel the loss report of this room card.

In the room reservation information, users can see the booked guest's name, contact number,

scheduled check-in time, scheduled check-out time, number of days (hours), and number of

guests, as shown in Figure 1.3-25.

Check-in AL Room

Booking Time: 2023-08-1517:23:45

Scheduled Check-in Time: 2023-08-17 12:00:00
Scheduled Check-out Time: 2023-08-15 12:00:00
Reservation Range: 2Day(s)

First Name: test

Last Name: bug

Phone Number: 4001053868

E-mail: jiakai.zh@zkteco.com

Figure 1.3-25

In the room information, users can see the room type name, room size, the number of beds,

maximum occupancy, daily room rate, and the furniture and facilities, as shown in Figure 1.3-

26.
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Check-in Reservation

Notes: test room

Device: TV,Safe Box

Room Type: shuangren

Room Size: 10

Number of Beds: 2

Maximum Number of Guests: 3
Daily Rate: 200

Hourly Rate: 20

Overstay Hourly Rate: 40
Deposit Amount: 100

Figure 1.3-26
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Printer and Reader Driver

Printer Driver

The status bar of the printer driver makes it easy for users to know whether the printer driver is

installed on the current system and whether the version of the printer driver is up to date.
When the status of the printer driver is displayed as shown in Figure 1.3-27, it represents that the
printer driver is installed and is the latest version, the version number is Ver 6.2.2.6.

Printer Driver:Installed, Versions.2.2 6

Figure 1.3-27

Reader Driver

The status bar of the reader driver makes it easy for users to know whether the reader driver has

been installed on the current system and whether the version of the reader driver is the latest.
When the status of Reader’s Driver is displayed as shown in Figure 1.3-28, it means the reader’s
driver is installed and is the latest version, version number: Ver 1.0.13.

Reader Driver:installed, Version1.0.13

Figure 1.3-28

Read, Clear and Reissue Card
Read Card

After installing the driver and plugging the reader into the system, click the Read Card button. The

card information display window will pop up, as shown in Figure 1.3-29.

Read Card ®x

Physical Card Number | 1104696834 Card No. 104696834
Issued Date 2023-08-15 15:42:32 Card Expiration Time | 2023-08-17 00:42:32
Cardholder Name fest Card Type Room Card
Hotel Name test hotel Building Name yihaolou
Floor Name 1F Room Name yihaolou1F102
Facility 1 Facility 2
Facility 3 Facility 4
Facility 5 Facility 6
Facility 7 Facility 8
Facility 9 Facility 10
Facility 11 Facility 12

Figure 1.3-29
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Note: If the latest driver is not installed, the reader is not plugged in, or no card is placed on the
reader, click the Read Card button and the system will report "The Operation Failed!” as shown in
Figure 1.3-30.

"0
The operation failed!

Figure 1.3-30

Cancel Card

The Cancel Card button is used to clear the card data. When clicked, the system will prompt for

confirmation, as shown in Figure 1.3-31.

Prompt

Are you sure to cancel this card?

Cancel

Figure 1.3-31

After clicking the OK button, the card data will be cleared, and the card status will marked as

invalid in the card-issuing table, as shown in Figure 1.3-32.

Card Status  Card Type Room Name Card No Physical Card Num... Name Last Name 1D Type 1D Number Card Issued Date Card Expiration Date Issued Time
Invalid Room Card yihaolou1F102 104696834 1104696834 test bug 1D 2 2023-08-15 15:42:54 2023-08-16 10:02:07 2023-08-15 15:42.54

Valid Room Card yihaolou1F101 320407305 3320407305 test bug 1D 2233 2023-08-15 15:26:37 2023-08-16 12:00:00 2023-08-15 15.:26:37
Figure 1.3-32

The user information is deleted from the check-in information, as shown in Figure 1.3-33.
Reservation Room

Check-In Time: 08-15 1542
Check-Out Time: 08-17 00:42
Days/Hours to Stay: 33Hour(s)
Guest Count: 0

Figure 1.3-33

Note: The blocklist card cannot clear the card.

Reissue Card

It is used when the user's room card is cancelled abnormally, reported lost or the peer reissues it.
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Select the room for which the room card needs to be reissued, then click Reissue Card. The

reissue room card window will pop up, as shown in Figure 1.3-34.

Current Room
Check-In Time
Number of Cards Issued

Number of Guests

First Name

test

test

Add Guest
Cerlificate Type™
ID Number®
Hotel Facility

E-mail

yihaolou1F102
2023-05-15 15:42:32
2

2

ID Type

Passport

D

Q

Reissue Card

Room Type
Check-Out Time

Maximum Number of Cards

Maximum Number of Guests

ID Number

1122

11

First Name™
Last Name

Phone Number

Figure 1.3-34

shuangren
2023-08-17 00:42:32
1

1

Card No

4004238539

1104696834

o

Check Add Guest options, enter the guest information, and click Write Card, as shown

Figure 1.3-35.

Current Room
Check-In Time
Number of Cards Issued

Number of Guests

First Name

test

test

Add Guest
Certificate Type™
ID Number®
Hotel Facility

E-mail
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yihaolou1F102
2023-08-15 15:42:32
2

2

ID Type

Passport

D

Q

Reissue Card

Room Type
Check-Out Time
Maximum Number of Cards

Maximum Number of Guests

ID Number

1122

11

First Name™
Last Name

Phone Number

Figure 1.3-35
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Reservation

Make individual or group hotel reservations.

Click the Reservation button on the Room Monitor interface, and a reservation window will

appear, as shown in Figure 1.3-36.

Please enter the search criteria:

Checkin Type"
Starttime *

End time *

First Name*

Last Name
Certiicate Type®
1D Number*
Phone Number*
E-mai

Booking Method"
Booking Type"
Company Name
Daysto Stay *
Ghecicin Time*
Checlc-Out Time*
Total Number of
Rooms*

Deposit Amount"

Total Charge”

@Daily Rent ()By Hour
[2023-08-16

2023-08-17

Booking by Phone

Person

1
2023-08-16 12:00:00
2023-08-17 12:00:00
0

0
0

Building Name:

Building Name

yihaolou

yihaolou

12

Building Name

Floor Name

~ | FloorName
Floor Name Room Name
1F yihaolou1F103
1F yihaolou1F104

50 rows per page

Room Name

50 rows per page

Figure 1.3-36

Reservation

Room Type

shuangren

shuangren

Jump To 1

Room Type

Jump To 1

~ | RoomType

Type

Room

Room

11 Page

Type

10 Page

~ | RoomName

Room Gapacity ~ Number of Be.
3 2
3 2

Total of 2 records

Room Capacity Number of Be

Total of 0 records

Daily Rate

Daily Rate

Q

Hourly Rate

20

20

Hourly Rate

Deposit A

100

100

Deposit A

Select the booking type "Daily Rent" or "By Hour", choose the start time and end time, and click

Query. The available rooms within the time range of the current query conditions will be

displayed in the list on the top right. As shown in Figure 1.3-37.

Please enter the search criteria:

Checkin Type'
Starttime *

End time *

First Name*
Last Name
Certificate Type®
1D Number"
Phone Number®
E-mai

Booking Method"
Booking Type™
Company Name
Daysto Stay *
Check-in Time*

Check-Out Time*

Total Number of
Rooms*

Deposit Amount™
Total Charge®

@0aily Rent OBy Hour
2023-03-20
2023-08-31

Booking by Phone

Person

i
2023-08-20 12:00:00
20230831 12:00:00
0

0
0

Building Name.

Building Name

yinaclou

yinaclou

yinaclou

yinaclou

14

Building Name

~ | FloorName
Floor Name Room Name
1F yinaolou1F101
1F yihaolou1F102
1F yihaolou1F103
1F yihaolou1F104

50 rows per page

Floor Name Room Name

50 rows per page

Reservation

Room Type

shuangren

shuangren

shuangren

shuangren

JumpTo 1

Room Type

JumpTo 1

v RoomType

Type

Room

Room

Room

Room

11 Page

Type

10 Page

v | Room Name

Room Capacity Number of Be.
3 7
3 2
3 2
3 2

Total of 4 records

Room Capacity ~ Number of Be..

Total of 0 records

Daily Rate

Daily Rate

Q
Hourly Rate
20
20
20
20
Hourly Rate

Q

Deposit A

100

100

100

100

Deposit A...

Figure 1.3-37

Select building name, floor name, room type, and room name, then fill in the required items.

Click Completed, as shown in Figure 1.3-38.
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Reservation x

Building Name ~ | FloorName ~ | RoomType ~ |  RoomName Q ¢
Please enter the search criteria:
Checkin Type* (@Daily Rent C)By Hour Building Name  Floor Name Room Name Room Type Type Room Capacity Number of Be.. Daily Rate Hourly Rate Deposit A.
Starttime el yihaolou F yihaolouTF102  shuangren Room 3 2 200 20 100
End time * 20230831
yinaolou F yihaolouTF103  shuangren Room 3 2 200 20 100
First Name* [test |
Last Name bug
Certfiate Type* D -
1D Number* 333444555 J
Phone Number* Bl - 4001053868
= ¢ < 12 > > S0rowsperpage ~ JumpTo 1 /1Page  Total of 2 records
E-mail fiakai Zn@zkteco.com
Booking Method* Bookingby Phone  +
Building Name  Floor Name Room Name Reom Type Tyve Room Capacity ~Number of Be... Daily Rate Hourly Rate Deposit A...
Booking Type™ Person -
Company Name ZKTeco yinaolou F yinaolou1F101  shuangren Room 3 2 200 20 100
Days S shay 4l yihaolou 1F yihaolouiF104  shuangren Room o 2 200 20 100
CheckIn Time® 2023-08:20 12:00:00
Check-Qut Time" 2023-08-31 12:00:00
Total Number of 2
Rooms*
Deposit Amount” 200
Tokat Charge® o K o< 12 50 rows per page = Jump To 1 11Page  Total of 2 records

Figure 1.3-38

4. After making a reservation, users can view the reservation record in the Reservation List, as

shown in Figure 1.3-39.

Hotel / Hotel Management / Reservation List

First Name Mobile Number E-mail Morer Q &

G Refresh @ Delete

Booking number FirstName  LastName  Mobile Number  E-mail Check-in Type  Booking Method  Booking Time Scheduled Check-in Time ~ Scheduled Check-out Ti... Reservatio.. Booking Type Reservation Room Num... Reserve

16921768098145540  test bug 4001053868 jiakai.zh@zkteco. Daily Rent Booking by Phone 2023-08-16 17:06:49  2023-08-20 12:00:00 2023-08-31 12:00:00 1 Person yihaolou1F101,yihaoloutF1 shuangr

Figure 1.3-39

5. Thereservation information is displayed in the room information, as shown in Figure 1.3-40.

Room No_:Masai mara AZFloor-
003

Status:Vacant

Checkin Reservation Room

Booking Time: 2025-0:

Scheduled Check-in Time:
12:00:00

Scheduled Check-out Time:
12:00:00

Resarvation Range: 1Day(s)
First Mame: test

Last Mame:

FPhone Mumber: 1

E-mail:

Figure 1.3-40

Page |33 Copyright © 2025 ZKTECO CO., LTD. All rights reserved.



ZKBio CVSecurity Smart Lock User Manual

1.3.1.10 Individual Business
1.3.1.10.17 Check-in

1. Right-click the available rooms and select Individual-> Individual check-in function from the
pop-up menu to check-in as shown in Figure 1.3-41.

Individual

Group Management=

yinaolou1F103

Room Status 5,

Figure 1.3-41

2. The individual check-in window will be displayed, after filling in the check-in information, as

shown in Figure 1.3-42.

Check-In Registration X

Room Name* yihaolou1F101 -
Certificate Type* ID - Phone Number - * 4001053868 Q
ID Number™ 2233 E-mail jiakai.zh@zkteco.com L
First Name” test Emergency Contact Phone |4()D105385H |
Last Name bug Check-in Type* (@ Daily Rent (_)By Hour
Gender Male - Guest Count* 1 -
Home Address zkteco Check-In Time* 2023-08-17 10:26:56
Days to Stay” 1 Check-Out Time™ 2023-08-17 12:00:00
Discount(%) e Daily Rate™ 200.00
Deposit Amount™ 100.00 Payable Amount® 208.00

2023-08-20 12:00:00The room has been booked.

Figure 1.3-42

¢ Room Name: The default Room Name is the previously selected or booked Room number.

The Room number cannot be changed when registering.

* Certificate Type: The Certificate Type can be selected from the drop-down list such as ID,
Passport, Driver's License, Others.

o ID Number: The system will obtain the information of the guests who have checked in.
When the same ID number is entered for the next time, the other information of the

guests will be automatically filled in.
e  First Name: Enter the first name of the guest, required fields.
e Last Name: Enter the last name of the guest, non-required fields.
¢ Gender: Select the gender from the drop-down list.

¢ Home Address: Not required.
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Phone Number: If the customer needs to use the mobile phone HTML5 function, he/she
must fill in the mobile phone number which can receive the successful check-in SMS and
the mobile phone HTML5 link. Remember to select the country before entering the

guest’s phone number. It will be automatically saved as the default number.

E-Mail: The email address of guests is not required, but it can be used to send

consumption bills.

Emergency Contact Phone: Enter the Emergency Contact Number.
Check-in Type: The options are Daily Rent and Hourly Rent.

Guest Count: The Guest count must be within the limits of room regulations.

Days of Stay: The default value is displayed according to the hotel parameter settings,
which can be changed, and the maximum value is 99 days.

Check-in Time: Automatically fills according to the actual check-in time.

Check-out Time: The date is automatically calculated according to the estimated number
of days of stay, and the check-out time is automatically filled according to the default

check-out time set on the hotel parameters.

Discount (%): Select the discount percentage as per the norms and the range is 0%
t0100%.

Deposit Amount: Automatically fills according to the rental deposit set on Room Type.

Daily Rate: Automatically calculates the rate according to the estimated number of days

and the room fee set on Room Type.

Payable Amount: Rental cost + deposit. Guests should pay the room fee in advance
including the total deposit. Note: This system is only responsible for the auxiliary
calculation of rents according to preset rules and does not involve POS business of cash

collection.

After filling in the required information above, click the Check-in Registration button to enter
Register or Issue a Card interface, set the elevator control (optional), access control (optional),

and hotel facility, as shown in Figure 1.3-43.

Copyright © 2025 ZKTECO CO., LTD. All rights reserved.



ZKBio CVSecurity Smart Lock User Manual

Page |36

Register or Issue a Card x 1
Room Name* yinaolou1F101
Room Type* shuangren
Check-In Time" 2023-08-17 11:00:16
Check-Out Time* 2023-08-17 12:00:00
Check in without card
Certificate Type®
1D Number* 112233
First Name™ test
Last Name bug
Phone Number Bl - 4001053868 Q
E-mail jiakai zh@zkteco.com Q
Access Level(s)
Elevator Control
Hotel Facility
|  MNumberof Cards Issued: 0  Number of Available Guests: 1
First Name ID Type ID Number Card No.
Figure 1.3-43

Room Name: The room number to be checked in, after the previous reservation is

selected, will only be displayed here, and cannot be modified.

Room Type: The Room Type will be automatically displayed according to the selected

guest room and cannot be modified.
Check-in Time: The system fills the current time by default and cannot be modified.
Check-out Time: The time will be filled automatically and cannot be modified.

Check in without card: The first guest must be issued a room card, and the second guest

can only check-in without a room card during group check-in.

Certificate Type: The information of the first guest will be automatically filled in
according to the previous order without manual input. But the second guest needs to

enter the registration manually.

ID Number: The information of the first guest will be automatically filled in according to
the previous reservation list without manual input. But the second guest needs to enter

the registration manually.

First Name: The information of the first guest will be automatically filled in according to
the previous reservation list without manual input. But the second guest needs to enter

the registration manually.
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Last Name: The information of the first guest will be automatically filled in according to
the previous reservation list without manual input. But the second guest needs to enter

the registration manually.

Phone Number: The information of the first guest will be automatically filled in according
to the previous reservation list without manual input. But the second guest needs to enter

the registration manually.

Access Level(s): Click to add the room card to the Access Level that can be accessed, such
as hotel lobby access control, swimming pool access control, chess room access control,
etc. After selecting the corresponding access level here, the room card has both the

guestroom unlock access and these access control rights.

Elevator Control: Click to add the room card to the Elevator Control. For example, the
guest room is on the 3rd floor. After selecting the elevator control on the 3rd floor, the

room card has both the guestroom unlock and the elevator rights on the 3rd floor.

Hotel Facility: Click to add the room card to the room area, such as VIP entertainment
room, private hot spring, etc. After selecting the corresponding room area, the room card

has both the unlocking guestroom and the unlocking the special room permissions.

Number of Cards Issued: Indicates the current number of room cards issued, and the
room card information will be displayed in the list. It includes the guest’s name of the

cardholder, ID card number, and room card number.

Number of Available Guests: Indicates the number of fellow guests who can still check

in, depending on the maximum number of occupants of the room settings.

Place the card on the card reader, click Write Card, complete the card issuance. Click
Complete, the pop-up window will close, and the check-in information can be viewed in the

room information on the right side, as shown in Figure 1.3-44.

Room No.:yihaolou1F101
Status:Check-in

Lock Name: 00-0D-6F-00-17-60-57-91

Reservation Room

First Name: test

Last Name: bug

Phone Number: +86 4001053868

E-mail: jiakai zh@zkteco.com

Card No.: 3700054240 Report Card Loss
Check-In Time: 08-17 11:00

Check-Out Time: 08-17 12:00

Days/Hours to Stay: 1Day(s)

Guest Count: 1

Figure 1.3-44
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Reservation Check-in

In the Reservation List, locate the guest who is checking in today, and click Check-In

Registration once earliest check-in time is reached, as shown in Figure 1.3-45. Or right-click

the reservation room in the Room Monitor interface and click the Individual button.

ZKBio CVSecurity i % O amin ~

Statistic

5 Hotel / Hotel Management / Reservation List

First Name Mobile Number E-mail More Q ¢

Device Management >

Hotel Management

Room Monitor

v O Refresh B Delete
reck-in Type  Booking Method  Booking Time Scheduled Check-in Time ~ Scheduled Check-out Ti...  Reserval tio.. Booking Type Reservation Room Num... Reservation Type Reservation Status ~ Company Name ~ Operations

Valid ZKTeco AN

sily Rent Booking by Phone 2023-08-17 11:19:10  2023-08-17 12:00:00 2023-08-19 12:00:00 2 Person yihaolou1F103

Figure 1.3-45

In the Check-In pop-up window, the corresponding information will be automatically filled in

according to the reservation information, as shown in Figure 1.3-46.

Check-In Registration ®
Room Name* yihaolou1F101 -
Certificate Type* D - Phone Mumber Bl - 001053868 ()
ID Number* 2233 E-mail jiakai zh@zkteco com Q
First Name*® test Emergency Contact Phone 40010538591 i
Last Name bug Check-in Type” (@ Daily Rent (_)By Hour
Gender Male - Guest Count* 1 -
Home Address zkteco Check-In Time* 2023-08-17 10:26:56
Days to Stay™ 1 Check-Out Time* 2023-08-17 12:00:00
Discount{%}) G | Daily Rate™ 200.00
Deposit Amount™ 100.00 Payable Amount® 298.00

2023-08-20 12:00:00The room has been booked.

Figure 1.3-46

Room Name: The default Room Name is the previously selected or booked Room number.

The Room number cannot be changed when registering.

Certificate Type: The Certificate Type can be selected from the drop-down list such as ID,

Passport, Driver's License, Others.

ID Number: The system will obtain the information of the guests who have checked in.
When the same ID number is entered for the next time, the other information of the

guests will be automatically filled in.

First Name: Enter the first name of the guest, required fields.
Last Name: Enter the last name of the guest, non-required fields.
Gender: Select the gender from the drop-down list.

Home Address: Not required.

Phone Number: If the customer needs to use the mobile phone HTML5 function, he/she
must fill in the mobile phone number which can receive the successful check-in SMS and
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the mobile phone HTML5 link. Remember to select the country before entering the

guest’s phone number. It will be automatically saved as the default number.

E-Mail: The email address of guests is not required, but it can be used to send

consumption bills.

Emergency Contact Phone: Enter the Emergency Contact Number.
Check-in Type: The options are Daily Rent and Hourly Rent.

Guest Count: The Guest count must be within the limits of room regulations.

Days of Stay: The default value is displayed according to the hotel parameter settings,

which can be changed, and the maximum value is 99 days.
Check-in Time: Automatically fills according to the actual check-in time.

Check-out Time: The date is automatically calculated according to the estimated number
of days of stay, and the check-out time is automatically filled according to the default

check-out time set on the hotel parameters.

Discount (%): Select the discount percentage as per the norms and the range is 0%
t0100%.

Deposit Amount: Automatically fills according to the rental deposit set on Room Type.

Daily Rate: Automatically calculates the rate according to the estimated number of days

and the room fee set on Room Type.

Payable Amount: Rental cost + deposit. Guests should pay the room fee in advance
including the total deposit. Note: This system is only responsible for the auxiliary
calculation of rents according to preset rules and does not involve POS business of cash

collection.

After filling in the required information above, click the Check-in Registration button to enter
Register or Issue a Card interface, set the elevator control (optional), access control (optional),

and hotel facility, as shown in Figure 1.3-47.

Copyright © 2025 ZKTECO CO., LTD. All rights reserved.



ZKBio CVSecurity Smart Lock User Manual

Page | 40

Register or Issue a Card x 1

Room Name™ yihaolou1F101

Room Type* shuangren

Check-In Time™ 2023-08-17 11:00:16

Check-Out Time™ 2023-08-17 12:00:00

Check in without card

Certificate Type™

1D Number* 112233

First Name™ test

Last Name bug

Phone Number Bl - 4001053868 Q

E-mail jiakai.zh@zkteco.com Q

Access Level(s)

Elevator Control

Hotel Facility

|  Number of Cards Issued: 0  Number of Available Guests: 1
First Name 1D Type ID Number Card No.

Figure 1.3-47

Room Name: The room number to be checked in will be displayed here after the previous

reservation is selected and cannot be modified.

Room Type: The Room Type will be automatically displayed according to the selected

guest room and cannot be modified.

Check-in Time: The system automatically fills in the current time by default, and it cannot
be modified.

Check-out Time: The system automatically fills in the check-out time, and it cannot be

modified.

Check in without card: The first guest must be issued a room card. Only subsequent

guests can check in without a room card during group check-in.

Certificate Type: The information of the first guest will be automatically filled in
according to the previous order . Additional guests must enter their registration

information manually.

ID Number: The information of the first guest will be automatically filled in according to
the previous reservation list from the previous reservation. Additional guests must enter

this information manually.

First Name: The first guest’ s last name will be filled in automatically from the previous

reservation. Additional guests must enter this information manually.
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Last Name: The information of the first guest will be automatically filled in according to
the previous reservation list without manual input. But the second guest needs to enter

the registration manually.

Phone Number: The information of the first guest will be automatically filled in according
to the previous reservation list without manual input. But the second guest needs to enter

the registration manually.

Access Level(s): Click to add the room card to the Access Level that can be accessed, such
as hotel lobby access control, swimming pool access control, chess room access control,
etc. After selecting the corresponding access level here, the room card has both the

guestroom unlock access and these access control rights.

Elevator Control: Click to assign elevator control access to the room card. For example, if

the guest room is on the 3rd floor, selecting elevator control for the 3rd floor.

Hotel Facility: Click to add special room areas, such as VIP entertainment rooms or
private hot springs, to the room card. After selection, the room card will have access to
both the guestroom and the specified special room(s).

Number of Cards Issued: Displays the current number of room cards issued. The list

includes the cardholder's name, ID card number, and room card number.

Number of Available Guests: Indicates the number of fellow guests who can still check

in, depending on the maximum number of occupants of the room settings.

Place the card on the card reader, click Write Card, complete the card issuance. Click
Complete, the pop-up window will close, and the check-in information can be viewed in the
room information on the right side, as shown in Figure 1.3-48.

Room No.:yihaolou1F101
Status:Check-in

Lock Name: 00-0D-6F-00-17-60-57-91

Reservation Room

First Name: test

Last Name: bug

Phone Number: +86 4001053868

E-mail: jiakai zh@zkteco.com

Card No.: 3700054240 Report Card Loss
Check-In Time: 08-17 11:00

Check-Out Time: 08-17 12:00

Days/Hours to Stay: 1Day(s)

Guest Count: 1

Figure 1.3-48
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1.3.1.10.3 Overstay

1. Right-click the room in the Room Monitor interface and select Individual > Overstay in the

pop-up window, as shown in Figure 1.3-49.

Individual

= m

yihaolg Room Status - Change Room
Check-Out ‘
Figure 1.3-49

2. In the pop-up window of overstay registration, users can view the name of the person staying

in the current room, registration certificate and card number, as shown in Figure 1.3-50.

Overstay Registration x
Room Name yihaolou1F101
First Name ID Type ID Number Card No.
test 1D 2233 3700054240
Overstay Days™ 1 Days to Stay 1
Check-In Time 2023-08-17 11:42:46 Check-Out Time 2023-08-19 12:00:00
Discount(%) 0 Overstay Charge 200.00

Figure 1.3-50

« Overstay Days: The default value is displayed according to the hotel parameter settings,

which can be changed, and the maximum value is 99 days.

« Days of Stay: The default value is displayed according to the hotel parameter settings,

which cannot be changed.
¢ Check-in Time: Automatically fills according to the actual check-in time.

o  Check-out Time: The date is automatically calculated according to the estimated number
of days of stay, and the check-out time is automatically filled according to the default

check-out time set on the hotel parameters.
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Discount (%): Select the discount percentage as per the norms and the range is 0%
t0100%.

Overstay Charge: Automatically calculated according to the daily rate multiplied by the

number of days of overstay.

Click Overstay and pup up the issued for Overstay interface. Remote card writing and card
reader can be used to issue cards, as shown in Figure 1.3-51

Issued for Overstay ®

Room Name' yihaolou1F101
Room Type”* shuangren

Check-In Time* 2023-08-17 11:42:46
Check-Qut Time™ 2023-08-19 12:00:00
Write Card Remotely O

Number of Cards Issued: 1Number of Available Guests:0

First Name 1D Type ID Number Card No. Issuing Status

test 1D 2233 3700054240 @

Figure 1.3- 51

Room Name: The room number to be checked in, after the previous reservation is

selected, will only be displayed here, and cannot be modified.

Room Type: The Room Type will be automatically displayed according to the selected

guest room and cannot be modified.
Check-in Time: The system fills the current time by default and cannot be modified.
Check-out Time: The time will be filled automatically and cannot be modified.

Write Card Remotely: After Write Card Remotely is checked, the Write Card button is
set to ashes. After completion, the customer needs to use the room card to swipe the card
directly in the hotel lock. The first swipe will give the warning tone of card failure, and the
second swipe can open the door normally. If Write Card Remotely is not checked, users
need to place the card on the card reader, click Write Card, and issuing status will be

displayed & after writing the card successfully.

Number of Cards Issued: Indicates the current number of room cards issued, and the
room card information will be displayed in the list. It includes the guest’s name of the

cardholder, ID card number, and room card number.

Copyright © 2025 ZKTECO CO., LTD. All rights reserved.



ZKBio CVSecurity Smart Lock User Manual

¢ Number of Available Guests: Indicates the number of fellow guests who can still check

in, depending on the maximum number of occupants of the room settings.

4. After the overstay, close the overstay interface and the check-out date in the room information

will update automatedly, as shown in Figure 1.3-52.

Room No.:yihaolou1F101
Status:Check-in

Lock Name: 00-0D-6F-00-17-60-
57-91

Check-in Reservation Room

First Name: test
Last Name: bug
Phone Number: +86 4001053868
E-mail: jiakai zh@zkteco.com
Card No.: 3700054240 Report Card Loss
Check-In Time: 08-17 11:42
| check-Out Time: 08-13 12:00 |
Days/Hours to Stay: 2Day(s)

Guest Count: 1
Figure 1.3-52
1.3.1.10.4 Change Room

1. Right-click the room in the Room Monitor interface and select Individual > Change Room in

the pop-up window, as shown in Figure 1.3-53.

Individual >

=

yihaolou1F101

Room Status > Change Room

Check-Out ‘

Figure 1.3-53

2. In the pop-up window of change registration, users can view the room information of the

current staff and the room information after changing rooms, as shown in Figure 1.3-54.
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Change Reom x

Current Room yihaolou1F101 New Room yihaolou1F 104
Room Type shuangren Room Type shuangren
Guest Count 1 Guest Count 1
Days Left 2 Days to Stay 2
Discount(%) 0 Discount(%) 0
Daily Rate 200 Daily Rate 200
Deposit Amaunt 100 Additional Deposit Amount 0.00
Frepaid Room 400 Pay Balance 0.00

Building Name - Floor Name - Room Name e <

Room Capa. Number of B Daily Rate Hourly Rate Deposit Amo...  Building Name Floor Name Room Type Room Na

3 2 200 20 100 yihaolou 1F shuangren yihaolou1F1(

11 50 rows per page Jump To 1 /1 Page  Total of 1 records

First Name ID Type 1D Number Card No

test 1D 2233 3700054240
Check-In Time 2023-08-17 11:42:46 Check-Out Time 2023-08-19 12.00:00

Current Room: The current room name will only be displayed here and cannot be

modified.

Room Type: The current room type will be automatically displayed according to the

selected guest room and cannot be modified.

Guest Count: The current total number of guests. The guest count must be within the

limits of room regulations.

Days Left: Remaining stay days for current occupant. The default value is displayed
according to the hotel parameter settings, which can be changed, and the maximum

value is 99 days.

Discount (%): Discount for current occupancy. Select the discount percentage as per the

norms and the range is 0% to100%.

Daily Rate: Current room rate per day. Automatically calculates the rate according to the

estimated number of days and the room fee set on room type.

Deposit Amount: Deposit fee for the current room. Automatically fills according to the

rental deposit set on room type.

Prepaid Room: Automatically calculated according to the daily rate multiplied by the

number of days of checked in.

New Room: The new room name is displayed after the room is selected, and it is empty if

itis not selected.
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Room Type: The new room type is displayed after the room is selected, and it is empty if

it is not selected.

Guest Count: The number of guests shown is consistent with the data on the left.
Days of Stay: The number of days shown is consistent with the data on the left.
Discount (%): The discount shown is consistent with the data on the left.

Daily Rate: New room rate per day. Automatically calculates the rate according to the

estimated number of days and the room fee set on room type.

Additional Deposit Amount: Automatically calculated the difference of deposit
according to different rooms, more refund less makes up, and it is empty if it is not

selected new room.

Pay Balance: Automatically calculated the difference of rate according to different rooms,

more refund less makes up, and it is empty if it is not selected new room.
Note:

Users can query by building and floor and need to select the building in turn before you

can select the floor.
Users can search by room name.
Users can select a room directly with the left mouse button in the result list.

Click OK and pup up the issued for Room Change interface. Remote card writing and card
reader can be used to issue cards, as shown in Figure 1.3-55.

Issued for Room Change ®
Room Name”™ yihaolou1F104
Room Type* shuangren
Check-In Time® 2023-08-17 15:53:57
Check-Out Time* 2023-08-19 12:00:00
Access Level(s)
Elevator Control
Hotel Facility
‘Write Card Remotely O
Number of Cards Issued: 1Number of Available Guests:0
First Name 1D Type ID Number Card No Issuing Status
test 1D 2233 3700054240 (]

Figure 1.3-55
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« Room Name: The room number to be checked in, after the previous reservation is

selected, will only be displayed here, and cannot be modified.

* Room Type: The Room Type will be automatically displayed according to the selected

guest room and cannot be modified.
¢ Check-in Time: The system fills the current time by default and cannot be modified.
¢ Check-out Time: The time will be filled automatically and cannot be modified.

»  Write Card Remotely: After Write Card Remotely is checked, the Write Card button is
set to ashes. After completion, the customer needs to use the room card to swipe the card
directly in the hotel lock. The first swipe will give the warning tone of card failure, and the
second swipe can open the door normally. If Write Card Remotely is not checked, users
need to place the card on the card reader, click Write Card, and issuing status will be

displayed ¥ after writing the card successfully.

e Number of Cards Issued: Indicates the current number of room cards issued, and the
room card information will be displayed in the list. It includes the guest’'s name of the

cardholder, ID card number, and room card number.

¢ Number of Available Guests: Indicates the number of fellow guests who can still check

in, depending on the maximum number of occupants of the room settings.

After the room change is completed, close the room change interface, and the old room
becomes “Cleaning” and the target room becomes “check-in”, as shown in Figure 1.3-56. The

check-in information is the same as before the room change.

P

yihaolou1F102

]

yihaolou1F103

yihaolou1F11 yihaolou1F104

Figure 1.3-56
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1.3.1.10.5 Check-out

1. Right-click the room in the Room Monitor interface and select Individual > Check-Out in the

pop-up window, as shown in Figure 1.3-57.

Individual

= Overstay ‘

ihaoloulF
g Room Status = Change Room ‘
Check-Out |
Figure 1.3-57

2. Inthe pop-up window of check-out, users can view the information of current room, after card

cleaned, check-out can be completed, as shown in Figure 1.3-58.

Check-Out x

Room Name yihaolou1F104
Building Name yihaolou Floor Name 1F
Room Type shuangren Guest Count 1
Days to Stay 2 Number of Days 1
Check-In Time 2023-08-17 11:42:46 Check-Out Time 2023-08-17 16:02:43

First Name ID Type ID Number Card No Issuing Status

test D 2233 3700054240

Figure 1.3-58
¢ Room Name: The current room name will only be displayed here and cannot be modified.

o Building Name: The building will be automatically displayed according to the selected
guest room and cannot be modified.

¢ Floor Name: The floor will be automatically displayed according to the selected guest

room and cannot be modified.

* Room Type: The room type will be automatically displayed according to the selected

guest room and cannot be modified.

e Guest Count: The current total number of guests. The guest count must be within the

limits of room regulations.
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Days of Stay: Total number of days of stay booked. The default value is displayed

according to the hotel parameter settings.

Number of Days: Number of days already stayed. The default value is displayed

according to the hotel parameter settings.

Check-in Time: Automatically fills according to the actual check-in time.

Check-out Time: The date is automatically calculated according to the estimated number

of days of stay, and the check-out time is automatically filled according to the default

check-out time set on the hotel parameters.

Note: If users check-out directly without cancelling the card, the room card will be added to

the blocklist.

After the card is cancelled, the bill interface pops up, under which users can print invoices or

bills, as shown in Figure 1.3-59.

Bill at Check-Out

Invoice Preview Guest Information
test hotel Booking mumber: 16922437737207130 CheckinType:  Daily Rent
Telephone: First Name: test bug First Name: fest bug
Fax: Check-Tn Time: 2023-08-17 11:42:46 Checkdn Time:  2023.08.47 11:42-46
Website: Check-Out Time: 2023-08-17 16:02:43 Check-Out Time:  2023-08-17 16:02-43
Hotel Address: Cashier: admin
o " Room list

Room Name Days/Hours Extended days/hours Unit Price Discount Subtotal
vihaoloul F104( Daily R 100 0.00 USD 200.00 0 USD 200.00 yihaolou1F104 USD 200.00
ent) yihaolou1F101 usD 0.00
vihaoloulF101( Daily R 0.00 0.00 USD 200.00 L USD 0.00
ent) Payment Information

Total Charge: USD 200.00 Total Charge USD 200.00
Subtotal: Deaily rent = > days*unit price™(100-discount)'100-+extended rent (half of one day/day/N days) By hour= >hours®unit price™(100 -discount)/ 100 Tax Rate (%): USD 0.00
+extended rent*(hours*extended rent) Other Charge Rate (%): USD 0.00
Total Charge: USD200.00 | payanie Amount: USD 200.00
Tax Rate (%4): USDOO0 | amount Paid: USD 500.00
Other Charge Rate (%): UsD0.00 Balance: USD 300.00
Total Amount(Including Tax): USD 200.00

Thank you for visiting!

Figure 1.3-59

Note: The hotel information section is filled out in Hotel Setting, including tax rates.

Group Business
Check-in

Right-click the available rooms and select Group Management > Group check-in function

from the pop-up menu to check-in as shown in Figure 1.3-60.
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test

Individual

yinaolou1F101 Group Management- Group Check-In yihs

Room Status =

‘

Figure 1.3- 60

The individual check-in window will be displayed, after filling in the Check-In information, as

shown in Figure 1.3-61.

Checkeln Registration x
Certiicate Type™ Passport - Building Name + | Floor Name - More~ Q &
1D Number* 223344
Fitst Name. (foc primaty = Room Capacity Number of B.. Daily Rate Hourly Rate  Deposit Amo...  Building Name ~ Floor Name Room Type Room Na
contact)*
e T 3 2 200 20 100 yinaolou 1F shuangren yinaolou1F1
Group Name* ZKTeco
Gencer Male =
E-mail jiakai zh@zkteco.com @
Home Address zideco
Phone Number B - 4001053868 @
Discount(%) i
Guest Count® 1 11 50 rows per page - JumpTo 1 11 Page  Total of 1 records
Days to Stay* (4 |
. e Room Capacity Number of B.. Daily Rate Hourly Rate  DepositAmo._.  Building Name FloorName  Room Type Room Na
Checkn Time 20230817 16:53:06
Check-Qut Time™ 2023-08-21 12:00:00 3 z 200 20 100 yihaolou ¥ shuangren yihaolou1F1
List of Room Conflicts
Room Name Booking Time
yinaolou1F101 2023-08-20 12:01
-1 50 rows per page - JumpTo 1 M Page Total of 1 records
Total Number of Rooms* 1 Deposit Amount* 100
The selected room has been booked Sital Gharg® =
oo |

Figure 1.3-61

Certificate Type: The Certificate Type can be selected from the drop-down list such as ID,
Passport, Driver's License, Others.

ID Number: The system will obtain the information of the guests who have checked in.
When the same ID number is entered for the next time, the other information of the

guests will be automatically filled in.

First Name (for primary contact): Enter the first name of the primary contact guest,

required fields.
Group Name: Enter the name of the group, non-required fields.
Gender: Select the gender from the drop-down list.

E-Mail: The email address of guests is not required but can be used to send consumption
bills.

Home Address: Not required.
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Phone Number: To use the HTML5 mobile function, enter a mobile number that can
receive check-in SMS and the HTMLS5 link. Select the country code before entering the

phone number. The system will save it as the default contact number.

Discount (%): Select the discount percentage as per the norms and the range is 0%
t0100%.

Guest Count: The Guest count must be within the limits of room regulations.

Days of Stay: The default value is based on hotel settings and can be changed; the

maximum is 99 days.
Check-in Time: Automatically fills according to the actual check-in time.

Check-out Time: The date is automatically calculated according to the estimated number
of days of stay, and the check-out time is automatically filled according to the default

check-out time set on the hotel parameters.
Total Number of Rooms: The total number of rooms the group stays in.
Deposit Amount: Automatically fills according to the rental deposit set on room type.

Total Charge: Automatically calculates the rate according to the estimated number of

days and the room fee set on room type.

List of Room Conflicts: When the reservation room time conflicts with the group check-

in time of the day, the conflicting room is indicated on this interface.

After filling in the required information above, click the Check-in button to enter Register or
Issue a Card interface, set the elevator control (optional), access control (optional), and hotel

facility, as shown in Figure 1.3-62.

Register or Issue a Card ®

Room Name yihaoloutF101 Type Name® shuangren
Building Name™ yihaolou Floor Name 1F E
Check-In Time* 2023-08-17 17:11:52 Check-Out Time™ 2023-08-18 12:00:00
Guest Count® 1 - Number of Beds® 2
Card Information

Check in without card Cerfificate Type®™ | ——— -

First Name” ID Number*

Last Name Access Level(s)

Phone Number = Q Elevator Control

E-mail Q Hotel Facility

First Mame ID Type ID Number Card No.
Figure 1.3-62
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Room Name: The room number to be checked in, after the previous reservation is

selected, will only be displayed here, and cannot be modified.

Type Name: The room type will be automatically displayed according to the selected

guest room and cannot be modified.

Building Name: The building will be automatically displayed according to the selected
guest room and cannot be modified.

Floor Name: The floor will be automatically displayed according to the selected guest

room and cannot be modified.
Check-in Time: The system fills the current time by default and cannot be modified.
Check-out Time: The time will be filled automatically and cannot be modified.

Guest Count: Set the total number of guests staying in the current room The guest count

must be within the limits of room regulations.

Number of Beds: The number will be automatically displayed according to the selected
guest room and cannot be modified.
2] : The room can be switched to facilitate the arrangement of group members.

Check in without card: The first guest must be issued a room card, and the second guest

can only check-in without a room card during group check-in.

Certificate Type: The information of the first guest will be automatically filled in
according to the previous order without manual input. But the second guest needs to

enter the registration manually.

ID Number: The information of the first guest will be automatically filled in according to
the previous reservation list without manual input. But the second guest needs to enter

the registration manually.

First Name: The information of the first guest will be automatically filled in according to
the previous reservation list without manual input. But the second guest needs to enter

the registration manually.

Last Name: The information of the first guest will be automatically filled in according to
the previous reservation list without manual input. But the second guest needs to enter

the registration manually.

Phone Number: The information of the first guest will be automatically filled in according
to the previous reservation list without manual input. But the second guest needs to enter

the registration manually.

E-Mail: The email address of guests is not required but can be used to send consumption

bills. The information of the first guest will be automatically filled in according to the
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previous reservation list without manual input. But the second guest needs to enter the

registration manually.

Access Level(s): Click to add the room card to the Access Level that can be accessed, such
as hotel lobby access control, swimming pool access control, chess room access control,
etc. After selecting the corresponding access level here, the room card has both the

guestroom unlock access and these access control rights.

Elevator Control: Click to add the room card to the Elevator Control. For example, the
guest room is on the 3rd floor, after selecting the elevator control on the 3rd floor, the

room card has both the guestroom unlock and the elevator rights on the 3rd floor.

Hotel Facility: Click to add the room card to the room area, such as VIP entertainment
room, private hot spring, etc. After selecting the corresponding room area, the room card

has both the unlocking guestroom and the unlocking the special room permissions.

Place the card on the card reader, click Write Card, complete the card issuance. Click
Complete, the pop-up window will close, and the check-in information can be viewed in the
room information on the right side, as shown in Figure 1.3-63.

Room No.:yihaolou1F104
Status:Check-in

Lock Name: 00-OD-6F-00-15-62-47-60

Reservation Room

First Name: testH

Last Name: bugL

Phone Number: +1 4001053868

E-mail: jiakai.zh@zkteco.com

Card No.: 3700054240 Report Card Loss
Check-In Time: 08-17 17:42

Check-Cut Time: 08-18 12:00

Days/Hours to Stay: 1Day(s)

Guest Count: 1

Figure 1.3-63

Reservation Check-in

In the Reservation List, locate the person who is checking in today, and click Check-In
Registration after the earliest check-in time is met, as shown in Figure 1.3-64. Or right-click
the reservation room in the Room Monitor interface and click the Group Management
button.

Hotel / Hotel Management / Reservation List

First Name | | Mobile Number E-mail Morer Q &

G Refresh T Delete

mber  E-mail Check-inType  Booking Method  Booking Time Scheduled Check-in Time  Scheduled Check-out Ti... Reservat tio..  Booking Type Reservation Room Num.. Reservation Type  Reservation Status  Company Name  Operations

.

68 jiakal.zh@zkteco. Dally Rent Booking by Phon¢ 2023-08-16 17:06:49  2023-08-20 12:00:00 2023-08-31 12:00:00 1 Person yihaolou1F101,yihaoloutF1 shuangren,shuangren Valid ZKTeco

68 jiakai.zh@zkteco. Daily Rent Booking by Phone 2023-08-18 11:12:27  2023-08-18 12:00:00 2023-08-19 12:00:00 1 Group yihaoloutF101,yihaoloutF1 shuans

IS

Figure 1.3- 64
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In the Check-In pop-up window, the corresponding information will be automatically filled in

according to the reservation information, as shown in Figure 1.3-65.

Certificate Type®
1D Number*
First Name (for primary

contact)”

Gender

E-mail

Check-in Registration E3

D - Building Name | ———— i Floor Name

|2233

test

- More Q ¢

Room Capacity Number of B Daily Rate Hourly Rate Deposit Amo. Building Name ~ Floor Name Room Type Room Na.

3 2 200 20 100 vihaolou 1F shuangren yinaoloutF1
Last Name bug
Group Name® ZKTecol 3 2 200 20 100 yihaolou 1F shuangren yihaoloutF1
Jiakai Zh@zkteco.com Q
Home Address.
Phone Number Bl - 4001053868 Q
Dcanite] 12 50 rows per page Jump To 1 M Page Total of 2 records
Guest Count™
Days to Stay* 1 Room Capacity Number of B.. Daily Rate Hourly Rate Deposit Amo._  Building Name ~ Floor Name Room Type Room Na.
Check-In Time* 2023-08-18 14:21:06
3 2 200 20 100 yihaolou 1F shuangren yihaolou1F1
Check-Out Time" 2023-08-19 12:00:00
List of Room Conflicts 3 2 200 20 100 yihaolou 1F shuangren yihaoloutF1
Room Name Booking Time
No data 12 50 rows per page Jump To 1 M Page Total of 2 records
Total Number of Rooms 2 Deposit Amount" 200
Total Charge* 600

Certificate Type: The Certificate Type can be selected from the drop-down list such as ID,

Passport, Driver's License, Others.

ID Number: The system will obtain the information of the guests who have checked in.
When the same ID number is entered for the next time, the other information of the

guests will be automatically filled in.

First Name (for primary contact): Enter the first name of the primary contact guest,

required fields.
Group Name: Enter the name of the group, non-required fields.
Gender: Select the gender from the drop-down list.

E-Mail: The email address of guests is not required but can be used to send consumption
bills.

Home Address: Not required.

Phone Number: If the customer needs to use the mobile phone HTML5 function, he/she
must fill in the mobile phone number which can receive the successful check-in SMS and
the mobile phone HTML5 link. Remember to select the country before entering the

guest’s phone number. It will be automatically saved as the default number.

Discount (%): Select the discount percentage as per the norms and the range is 0%
t0100%.

Guest Count: The Guest count must be within the limits of room regulations.
Days of Stay: The default value is displayed according to the hotel parameter settings,

which can be changed, and the maximum value is 99 days.
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Check-in Time: Automatically fills according to the actual check-in time.

Check-out Time: The date is automatically calculated according to the estimated number
of days of stay, and the check-out time is automatically filled according to the default

check-out time set on the hotel parameters.
Total Number of Rooms: The total number of rooms the group stays in.
Deposit Amount: Automatically fills according to the rental deposit set on room type.

Total Charge: Automatically calculates the rate according to the estimated number of

days and the room fee set on room type.

List of Room Conflicts: When the reservation room time conflicts with the group check-

in time of the day, the conflicting room is indicated on this interface.

After filling in the required information above, click the Check-in Registration button to enter
Register or Issue a Card interface, set the elevator control (optional), access control (optional),

and hotel facility, as shown in Figure 1.3-66.

Register or Issue a Card x

Room Name yihaolou1F101 Type Name* shuangren [~]
Building Name™ yihaolou Floor Name 1F E
Check-In Time* 2023-02-18 11:21:06 Check-Out Time* 2023-08-19 12:00:00
Guest Count™ 1 - Number of Beds™ 2
Card Information

Check in without card Certificate Type® | ——r -

First Name™ ID Number*

Last Name Access Level(s)

Phone Number = Q Elevator Control

E-mail Q Hotel Facility

First Name ID Type ID Number Card No.
Figure 1.3-66

Room Name: The room number to be checked in, after the previous reservation is

selected, will only be displayed here, and cannot be modified.

Type Name: The room type will be automatically displayed according to the selected

guest room and cannot be modified.

Building Name: The building will be automatically displayed according to the selected

guest room and cannot be modified.
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Floor Name: The floor will be automatically displayed according to the selected guest

room and cannot be modified.
Check-in Time: The system fills the current time by default and cannot be modified.
Check-out Time: The time will be filled automatically and cannot be modified.

Guest Count: Set the total number of guests staying in the current room The guest count

must be within the limits of room regulations.

Number of Beds: The number will be automatically displayed according to the selected
guest room and cannot be modified.
2~ : The room can be switched to facilitate the arrangement of group members.

Check in without card: The first guest must be issued a room card, and the second guest

can only check-in without a room card during group check-in.

Certificate Type: The information of the first guest will be automatically filled in
according to the previous order without manual input. But the second guest needs to

enter the registration manually.

ID Number: The information of the first guest will be automatically filled in according to
the previous reservation list without manual input. But the second guest needs to enter

the registration manually.

First Name: The information of the first guest will be automatically filled in according to
the previous reservation list without manual input. But the second guest needs to enter

the registration manually.

Last Name: The information of the first guest will be automatically filled in according to
the previous reservation list without manual input. But the second guest needs to enter

the registration manually.

Phone Number: The information of the first guest will be automatically filled in according
to the previous reservation list without manual input. But the second guest needs to enter

the registration manually.

E-Mail: The email address of guests is not required, but it can be used to send
consumption bills. The information of the first guest will be automatically filled in
according to the previous reservation list without manual input. But the second guest

needs to enter the registration manually.

Access Level(s): Click to add the room card to the Access Level that can be accessed, such
as hotel lobby access control, swimming pool access control, chess room access control,
etc. After selecting the corresponding access level here, the room card has both the

guestroom unlock access and these access control rights.
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e Elevator Control: Click to add the room card to the Elevator Control. For example, the
guest room is on the 3rd floor; after selecting the elevator control on the 3rd floor, the

room card has both the guestroom unlock and the elevator rights on the 3rd floor.

e Hotel Facility: Click to add the room card to the room area, such as VIP entertainment
room, private hot spring, etc. After selecting the corresponding room area, the room card

has both the unlocking guestroom and the unlocking the special room permissions.

6. Place the card on the card reader, click Write Card, complete the card issuance. Click
Complete, the pop-up window will close, and the check-in information can be viewed in the
room information on the right side, as shown in Figure 1.3-67.

Room No.:yihaolou1F102
Status:Check-in

Lock Name: 00-0D-6F-00-17-60-49-B7

Check-in Reservation Room

First Name: testH

Last Name: bugL

Phone Number: +1 4001053868

E-mail: jiakai.zh@zkieco.com

Card No.: 3700054240 Report Card Loss
Check-In Time: 08-18 11:21

Check-Out Time: 08-19 12:00

Days/Hours to Stay: 1Day(s)

Guest Count: 1

Figure 1.3-67
1.3.1.11.3 Overstay

1. Right-click the room in the Room Monitor interface and select Group Management > Group

Overstay in the pop-up window, as shown in Figure 1.3-68.

= ‘

yihs

Group Management=

Room Status = Group Overstay

Group Room Change

Group Check-Out

Figure 1.3-68

2. In the pop-up window of overstay registration, users can check the check-in information of all

the group members and overstay the room together, as shown in Figure 1.3-69.
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Group Overstay x

First Name (for primary contact) test Phone Number 4001053868
Group Name ZKTeco Guest Count 2
Total Count of Rooms 2 Total Number of Cards 2

Room Name Guest Count Issued Quantity  Building Name  Floor Name Room Type Daily Rate

yihaolou1F104 1 1 yinaolou 1F shuangren 200

yihaolou1F101 1 1 yihaolou 1F shuangren 200

1-2 50 rows per page Jump To 1 /1 Page  Total of 2 records

Overstay Days” 0 Days fo Stay 2
Checkdn Time 20230817 17 Please enter a value greater than or equal to 2023-08-19 12:00:00
Discount(%) 10 - Uverstay Charge 0.0

Overstay Days: The default value is displayed according to the hotel parameter settings,

which can be changed, and the maximum value is 99 days.

Days of Stay: The default value is displayed according to the hotel parameter settings,

which cannot be changed.
Check-in Time: Automatically fills according to the actual check-in time.

Check-out Time: The date is automatically calculated according to the estimated number
of days of stay, and the check-out time is automatically filled according to the default

check-out time set on the hotel parameters.

Discount (%): Select the discount percentage as per the norms and the range is 0%
t0100%.

Overstay Charge: Automatically calculated according to the daily rate multiplied by the

number of days of overstay.

Click Overstay and pup up the issued for Overstay interface. Remote card writing and card

reader can be used to issue cards, as shown in Figure 1.3-70.
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Issued for Overstay *
Room Name yihaolou1F101
Type Name™ shuangren [~]
Building Name* yihaolou
Floor Name 1F
Check-In Time® 2023-08-17 17:48:35
Check-Out Time® 2023-08-20 12:00:00
Guest Count™ 1
- Number of Beds* 2
Wiite Card Remotely (]
First Name 1D Type 1D Number Card No Status
testH 1D 3344 3700054240
Figure 1.3-70

Room Name: The room number to be checked in, after the previous reservation is

selected, will only be displayed here, and cannot be modified.

Building Name: The building will be automatically displayed according to the selected

guest room and cannot be modified.

Floor Name: The floor will be automatically displayed according to the selected guest

room and cannot be modified.

Type Name: The room type will be automatically displayed according to the selected

guest room and cannot be modified.
Check-in Time: The system fills the current time by default and cannot be modified.
Check-out Time: The time will be filled automatically and cannot be modified.

Guest Count: Set the total number of guests staying in the current room. The guest count

must be within the limits of room regulations.

Number of Beds: The number will be automatically displayed according to the selected

guest room and cannot be modified.

Write Card Remotely: After Write Card Remotely is checked, the Write Card button is
set to ashes. After completion, the customer needs to use the room card to swipe the card
directly in the hotel lock. The first swipe will give the warning tone of card failure, and the
second swipe can open the door normally. If Write Card Remotely is not checked, users
need to place the card on the card reader, click Write Card, and issuing status will be

displayed ¥ after writing the card successfully.

After the overstay, close the overstay interface and the check-out date in the room information

will update automatedly, as shown in Figure 1.3-71.
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Room No.:yihaolou1F101
Status:Check-in

Lock Name: 00-0D-6F-00-17-60-57-91

Check-in Reservation Room

First Name: testH

Last Name: bugL

Phone Number: +1 4001053868

E-mail: jiakai.zh@zkteco.com

Card No.: 3700054240 Report Card Loss
Check-In Time: 08-17 17:48

Check-Out Time: 08-20 12:00
Days/Hours to Stay: 3Day(s)

Guest Count: 1

Figure 1.3-71
1.3.1.11.4 Change Room

1. Right-click the room in the Room Monitor interface and select Group Management > Group

Change Room in the pop-up window, as shown in Figure 1.3-72.

=

yihaolouiF ~ G'0UP Management> |

Group Overstay

Room Status =

Group Room Change

Group Check-Out

Figure 1.3-72

2. In the pop-up window of change registration, users can view the room information of the

current staff and the room information after changing rooms, as shown in Figure 1.3-73.
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Group Room Change x
Current Room yihaolou1F101 New Room yihaolou1F102
Room Type shuangren Room Type shuangren
Guest Count 2 Guest Count 2
Days Left 3 Days to Stay 3
Discount(%) 10 Discount{%) 10
Daily Rate 200 Daily Rate 200
Building Name - Floor Name - Room Name Q <&
Room Capa.. Number of Daily Rate Hourly Rale  Deposit Am Building Na Floor Name Room Type Room N
3 2 200 20 100 yihaolou 1F shuangren yihaoloutF1
3 2 200 20 100 yihaolou 1F shuangren yihaolou1F1
1-2 50 rows per page Jump Ta 1 i1Page Total of 2 records
First Name 1D Type ID Number Card No
testH 1D 3344 3700054240
Check-In Time 2023-08-17 17:48:35 Check-Out Time 2023-08-20 12:00:00

Current Room: The current room name will only be displayed here and cannot be

modified.

Room Type: The current room type will be automatically displayed according to the

selected guest room and cannot be modified.

Guest Count: The current total number of guests. The guest count must be within the

limits of room regulations.

Days Left: Remaining stay days for current occupant. The default value is displayed
according to the hotel parameter settings, which can be changed, and the maximum

value is 99 days.

Discount (%): Discount for current occupancy. Select the discount percentage as per the

norms and the range is 0% to100%.

Daily Rate: Current room rate per day. Automatically calculates the rate according to the

estimated number of days and the room fee set on room type.

New Room: The new room name is displayed after the room is selected, and it is empty if

itis not selected.

Room Type: The new room type is displayed after the room is selected, and it is empty if

itis not selected.
Guest Count: The number of guests shown is consistent with the data on the left.
Days of Stay: The number of days shown is consistent with the data on the left.

Discount (%): The discount shown is consistent with the data on the left.
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Daily Rate: New room rate per day. Automatically calculates the rate according to the

estimated number of days and the room fee set on room type.

Note:

Users can query by building and floor and need to select the building in turn before you

can select the floor.
Users can search by room name.
Users can select a room directly with the left mouse button in the result list.

Group room change, only the same type of room can be replaced.

Click OK and pup up the issued for Room Change interface. Remote card writing and card
reader can be used to issue cards, as shown in Figure 1.3-74.

Issued for Room Change *®

Room Name® yihaolou1F102
Room Type* shuangren

Check-In Time” 2023-08-18 10:40:04
Check-Out Time* 2023-08-20 12:00:00
Write Card Remotely O

Hotel Facility

Access Level(s)

Elevator Control

Number of Cards Issued:0  Number of Available Guests:1

First Name ID Type ID Number Card No. Status

testH 1D 3344 3700054240

Figure 1.3-74

Room Name: The room number to be checked in, after the previous reservation is

selected, will only be displayed here, and cannot be modified.

Room Type: The Room Type will be automatically displayed according to the selected
guest room and cannot be modified.

Check-in Time: The system fills the current time by default and cannot be modified.
Check-out Time: The time will be filled automatically and cannot be modified.

Write Card Remotely: After Write Card Remotely is checked, the Write Card button is
set to ashes. After completion, the customer needs to use the room card to swipe the card
directly in the hotel lock. The first swipe will give the warning tone of card failure, and the

second swipe can open the door normally. If Write Card Remotely is not checked, users
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need to place the card on the card reader, click Write Card, and issuing status will be

displayed = after writing the card successfully.

e Hotel Facility: Click to add the room card to the room area, such as VIP entertainment
room, private hot spring, etc. After selecting the corresponding room area, the room card

has both the unlocking guestroom and the unlocking the special room permissions.

o Access Level(s): Click to add the room card to the Access Level that can be accessed, such
as hotel lobby access control, swimming pool access control, chess room access control,
etc. After selecting the corresponding access level here, the room card has both the

guestroom unlock access and these access control rights.

¢  Elevator Control: Click to add the room card to the Elevator Control. For example, the
guest room is on the 3rd floor; after selecting the elevator control on the 3rd floor, the

room card has both the guestroom unlock and the elevator rights on the 3rd floor.

e Number of Cards Issued: Indicates the current number of room cards issued, and the
room card information will be displayed in the list. It includes the guest's name of the

cardholder, ID card number, and room card number.

¢ Number of Available Guests: Indicates the number of fellow guests who can still check

in, depending on the maximum number of occupants of the room settings.

After the room change is completed, close the room change interface, and the old room
becomes “Cleaning” and the target room becomes “check-in”, as shown in Figure 1.3-75. The

check-in information is the same as before the room change.

yinaclou1F101 yihaclou1F102

Figure 1.3-75

1.3.1.11.5 Check-out

1.

Page |63

Right-click the room in the Room Monitor interface and select Group Management > Group

Check-Out in the pop-up window, as shown in Figure 1.3-76.
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=

yihaolou1F102 Group Management=

Room Status = Group Overstay

Group Room Change

Group Check-Out |

Figure 1.3-76

In the pop-up window of check-out, users can view all rooms information of group, after card

cleaned, check-out can be completed, as shown in Figure 1.3-77.

Group Check-Out X

Group Mame ZKTeco First MName (for primary contact) fest
Guest Count 2 Total Number of Cards 2
Days fo Stay 3 Number of Days 1
Check-In Time 2023-08-18 10:40:04 Check-Out Time 2023-08-18 10:52:39

Room Name Guest Count Issued Quantity  Building Name Floor Name Room Type Daily Rate

yihaolou1F102 1 1 yihaolou 1F shuangren 200

yihaolou1F104 1 1 yihaolou 1F shuangren 200

1-2 3 50 rows per page ~ JumpTo 1 /1 Page  Total of 2 records

Figure 1.3-77
Group Name: Enter the name of the group, non-required fields.

First Name (for primary contact): Enter the first name of the primary contact guest,

required fields.

Guest Count: The current total number of guests. The guest count must be within the

limits of room regulations.
Total Number of Cards: The total number of cards registered by the group at check-in.

Days of Stay: Total number of days of stay booked. The default value is displayed

according to the hotel parameter settings.

Number of Days: Number of days already stayed. The default value is displayed
according to the hotel parameter settings.

Check-in Time: Automatically fills according to the actual check-in time.
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Check-out Time: The date is automatically calculated according to the estimated number
of days of stay, and the check-out time is automatically filled according to the default

check-out time set on the hotel parameters.
Note:

If check-out directly without cancelling the card, the room card will be added to the
blocklist.

Group check-out is all check-out, no single room will be checked out.

After the card is cancelled, the bill interface pops up, under which users can print invoices or

bills, as shown in Figure 1.3-78.

Print Group Check-Out Invoice x
Tnvoice Preview Guest Information

test hotel Booking number: 16922657353984825 First Name (for primary  test bug
Telephone: First Name (for primary contact): test bug contact):
Fax: Check-In Time: 2023-08-17 17:48:35 Group Name: ZKTeco
Website: Check-Out Time: 2023-08-18 10:52:39 Check-In Time: 2023-08-17 17:48:35
Hotel Address: Cashier: admin Check-Out Time: 2023-08-18 10:52:39
Room Name Days/Hours Estended days/hours Unit Price Discount Subtotal

Room list
yihaoloul F102(Daily 1.00 0.00 USD 20000 10 USD 180.00 i
Rext) yinaolou1F102 USD 180.00
vihaoloul F104(Daily 1.00 0.00 USD 20000 10 USD180.00 | yihaolou1F104 USD 180.00
Rent) yihaolou1F101 USD 0.00
vihaoloul F101(Daily 0.00 0.00 USD 20000 10 USD 0.00
Rent) Payment Information
Total Charge: UsD 360.00 Total Charge USD 360.00
Subtotal: Daily rent = = days*unit price*(100-discount)/1 00+extended rent (half of one day/day/N days) By hour= >hours*unit pric*(100 -4 Tax Rate (%): USD 0.00
iscount)/100+extended rent*(hours*extended remt) Other Charge Rate (%): USD 0.00
Total Charge: USD360.00 | payable Amount: USD 360.00
Tax Rate (%): USDOO | Amount Paid: USD 1280.00
Other Charge Rate (%): USDO00 | Bajance: USD 820.00
Total Amount(Including Tax): TSD 360.00
Figure 1.3-78
Note:
.

The hotel information section is filled out in Hotel Management, including tax rates.

After group check-out, the bill shows all room charges for the group.
Reservation List

All reservation records are displayed in the Reservation List, and the missed reservation records
can be modified according to needs. After arriving at the check-in time, users can directly check in
through the reservation record, and invalid reservation records can be deleted, as shown in Figure
1.3.2-1.
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(JZKBio CVSecurity 3 @ admin ~
,& Hotel / Hotel Management / Reservation List

B Feineme Wobile Number Emai Moer Q@

B CRefresh @ Delete

= Booking number  FirstName  LsstName  Wobile Number  E-mail Checkin Type  Booking Method  Booking Time Scheduled Check-in Time  Scheduled Check-out Ti.. Reservatio.. Booking Type Reservation Room Num... Reserve
- 16923283472937580  test bug 4001053868 jiakai.zh@zkteco. Daily Rent Booking by Phone 2023-08-18 11:12:27  2023-08-18 12:00:00 2023-08-19 12:00:00 1 Group yihaolou1F101,yihaoloutF1 shuangr
B 16921768098145540  test bug 4001053868 jiakai.zh@zkteco. Daily Rent Booking by Phone 2023-08-16 17:06:49  2023-08-20 12:00:00 2023-08-31 12:00:00 1 Person yihaolou1F101,yihaoloutF1 shuangr
8

12 50 rows per page ~  JumpTo 1 /1 Page  Total of 2 records

Figure 1.3.2-1

Search

The basic search criteria include guest name, mobile number, and email, as shown in Figure 3.2-2.

First Name Mobile Number E-mail More~ Q &

Figure 1.3.2-2

Booking Method is displayed in the configured booking method. By default, three booking

methods are displayed, as shown in Figure 3.2-3.

Booking Method | ———— -

Booking by Phone
Booking by receptionist
Cnline Booking

B ER ) 2N A0 40 4% 0f-mo g i o e N 3 1

Figure 1.3.2-3

Reservation Status includes Valid, Invalid, and Checked-In, as shown in Figure 3.2-4.

Reservation Status | —— w

3 Valid
" Invalid
Checked-In

Figure 1.3.2-4
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Edit, Check-in and Delete

Edit

The editing function can only edit records whose Reservation Status is Valid, as shown in Figure

1.3.2-5.

moer  E-mail

Check-in Type

62 fiakai.zh@zkteco. Daily Rent
68 fiakai.zh@zkteco. Hourly
68 jiakai. zh@zkteco. Daily Rent

Booking Method  Booking Time

Booking by Phone 2023-08-16 17:06:49

Booking by Phone 2023-08-18 14:18:35

Booking by Phone 2023-08-18 11:12:27

Scheduled Check-in Time

2023-08-20 12:00:00

2023-08-18 15:00:00

2023-08-18 12:00:00

Scheduled Check-out Ti

Reservatio

Booking Type Reservation Room Num

Figure 1.3.2-5

2023-08-31 12:00:00 1 Person
2023-08-18 18:00:00 3 Person yinaolou1F101
2023-08-19 12:00:00 1 Group

Reservation Type

yinaolou1F101 yihaoloutF1 shuangren shuangren

shuangren

Reservation Status
Valid

Invalia

yinaolou1F101 yinaolou1F1 shuangren shuangren Checked-in

Z

Click

ZKTeco

icon to enter the Reservation interface, and the contents of the reservation will be

automatically filled in, as shown in Figure 1.3.2-6.

Please enter the search criteria:

Building Name

Checlein Type* (@Daily Rent By Hour Building Name
Start time * 2023-08-20 Thesi
Endtime * 2023-08-31
yihaolou
First Name* test
Last Name bug
Certficate Type* D -
1D Number* 333444555
Phone Number* Bl - 4001053868 B

E-mail

Booking Method™

Jiakal 2h@2kteco com

Booking by Phene

]

Building Name
Booking Type* Person -
Company Name ZKTeco yihaolou
Days to Stay * 1 i
ChecleIn Time* 2023-08-20 12:00:00
Check-Out Time" 2023-08-31 12:00:00
Total Number of 2
Rooms*
Deposit Amount” 200
Total Charge” 600 45

Check-in Registration

~  Floor Name
Floor Name Room Name
1F yihaolou1F102
1F yihaolou1F103
50 rows per page
Floor Name Room Name
1F yihaolou1F101
F yihaolou1F104

50 rows per page

Reservation

Room Type

shuangren

shuangren

Jump To 1

Room Type

shuangren

shuangren

JumpTo 1

z Room Type

Type

Room 3

Room 3
/1Page  Total of 2 records

Type Room Capacity
Room 3
Room 3

/1 Page  Total of 2 records

Figure 1.3.2-6

2

2

Room Name

Room Capacity  Number of Be_

Number of Be..

2

2

Daily Rate

200

200

Daily Rate

200

200

Q ¢
Hourly Rate Deposit A
20 100
20 100
Hourly Rate Deposit A...
20 100
20 100

The check-in time cannot be earlier than the earliest check-in time set by the hotel, otherwise the

prompt "It's too early to check-in, please try later." will be displayed, as shown in Figure 1.3.2-7.

Prompt

It's too early to check-in, please try later.

Figure 1.3.2-7

After the check-in time meets the hotel requirements, click Check-in Registration to check-in, as

shown in Figure 1.3.2-8.
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Room Name*
Certificate Type”
1D Number*
First Name®
Last Name
Gender

Home Address
Days to Stay”
Discount{%])

Deposit Amount”

2023-08-20 12:00:00The room has been booked

Delete

Check-In Registration

yihaolou1F101 A
D -
2233

test

bug

Male hd

zkieco

100.00

Phone Number

E-mail

Emergency Contact Phone
Check-in Type®

Guest Count*

Check-In Time*

Check-Out Time*

Daily Rate™

Payable Amount™

Figure 1.3.2- 8

Bl - 4001053868 ()
jiakai zh@zkteco com Q
| 4001053864 |
(@Daily Rent By Hour

1 -
2023-08-17 10:26:56
2023-08-17 12:00:00

200.00

298.00

Select the reservation record to be deleted and click Delete, no matter whether the record is valid

or not, as shown in Figure 1.3.2-9.

ORefresh @ Delete

Booking number First Name  Last Name
16923304521091320  test bug
16923283472937580 test bug
16921768098145540  test bug

Scheduled Task

Mobile Number  E-mail

4001053868

4001053868

4001053868

Jiakai.zh@zkteco.

Jiakai zh@zkteco.

Jiakal.zh@zkteco.

Check-in Type  Booking Method  Booking Time Scheduled Check-in Time ~ Scheduled Check-out Ti..  Reservatio.. Booking Type Reservation Room Num..  Reserve
Hourly Booking by Phone 2023-08-18 14:18:35  2023-08-18 15:00:00 2023-08-18 18:00:00 3 Person yihaolou1F101 shuangr
Daily Rent Booking by Phon¢ 2023-08-18 11:12:27  2023-08-18 12:00:00 2023-08-19 12:00:00 1 Group yihaolou1F101,yihaoloutF1 shuangr
Daily Rent Booking by Phone 2023-08-16 17:06:49  2023-08-20 12:00:00 2023-08-31 12:00:00 gt Person yihaolou1F101,yihaoloutF1 shuangt

Prompt

Are you sure you want to perform the delete
gl

Cancel

Figure 1.3.2-9

The scheduled task is executed once every minute. The scheduled task changes the status of

expired reservations to invalid.

Note: When the reservation status is invalid, this reservation record cannot be edited and checked

in.
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Card Management

Card Management Interface

Card Management is the management center of Emergency Card, Housekeeper Card,
Maintenance Card, Room Area Card, users can make card printing for the above 4 cards on this

interface, as shown in Figure 1.4.1-1.

iJZKBio CVSecurity @
@ Statistic > Hotel / Card Management / Card Management
~ Read Card @ Cancel Card Reader Driver:Installed, Version1.0.13
Eé Device Management >
Setting Card
j Hotel Management >
Card Management v

Figure 1.4.1-1

Read Card and Cancel Card

Read Card

Place the card on the card reader and click Read Card to read the card information, as shown in

Figure 1.4.2-1.

Read Card x
Physical Card Number | 3320407305 Card No 320407305
Issued Date 2023-08-18 19:17:47 Card Expiration Time  2023-08-19 19:17:08
Cardholder Name Head Card Type Emergency Card
Hotel Name test hotel Building Name
Floor Name Room Name
Facility 1 Facility 2
Facility 3 Facility 4
Facility 5 Facility 6
Facility 7 Facility 8
Facility 9 Facility 10
Facility 11 Facility 12

Figure 1.4.2-1
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Cancel Card

Place the card on the card reader, click Cancel Card, and the card information will be cleared after

the second confirmation, as shown in Figure 1.4.2.-2.

Prompt

Are you sure to cancel this card?

Cancel

Figure 1.4.2-2

Setting Card
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Emergency Card

Emergency Card has the highest authority and can open all the hotel locks of the hotel,

including manual locks and always closed locks.
Emergency Card needs to be associated with personnel.

Emergency Card can be set a validity period. During the validity period, all hotel locks of the
hotel can be opened. After the expiration, the locks cannot be opened, as shown in Figure
1.4.3-1.

After the hotel opens the access control and elevator control parameters, the emergency card

can be added the access control and elevator control area rights.

Emergency Card *x
Cardholder Name® Head
Last Name Master
Card Expiration Time* 2023-08-19 19:22:28
Access Level(s) General
Elevator Control 1
Figure 1.4.3-1

Housekeeper Card

Housekeeper Card assigns permissions to buildings and floors based on the settings and

allowing access to all hotel locks on the corresponding buildings and floors.
The Housekeeper Card cannot open internal locked and often-closed rooms.

The validity period of the Housekeeper Card can be set. During the validity period, all hotel
locks in the corresponding building or floor can be opened. After the expiration, the locks

cannot be opened, as shown in Figure 1.4.3-2.
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After the hotel opens access control and elevator control parameters, the Housekeeper Card

can be added as access control elevator control area rights.

Housekeeper Card X
Cardholder Name™ Head
Last Name Master
Card Expiration Time™ 2023-08-19 15:42:57
Building Mame* yihaolou -
Floor Name 2F A
Access Level(s) General
Elevator Control 1
Figure 1.4.3-2

Maintenance Card

The maintenance Card assigns permissions to buildings and floors according to the settings

and can open all hotel locks on the corresponding buildings and floors.
Maintenance Card cannot open internal locked and often-closed rooms.

The validity period of the Maintenance Card can be set. During the validity period, all hotel
locks in the corresponding building or floor can be opened. After the expiration, the locks

cannot be opened, as shown in Figure 1.4.3-3.

After the hotel opens access control and elevator control parameters, the Maintenance Card

can be added access control elevator control area rights.

Maintenance Card x
Cardholder Name™ Head
Last Name Master
Card Expiration Time* 2023-08-19 15:48:58
Building Name™® yihaolou -
Floor Name 1F -
Access Level(s) General
Elevator Control 1
Figure 1.4.3-3

Room Area Card

The Room Area Card assigns permissions to buildings and floors according to the settings and

can open all hotel locks on the corresponding buildings and floors.

The Room Area Card cannot open internal locked and often-closed rooms.
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The validity period of the Room Area Card can be set. During the validity period, all hotel locks
in the corresponding building or floor can be opened. After the expiration, the locks cannot be

opened, as shown in Figure 1.4.3-4.

After the hotel opens access control and elevator control parameters, the Room Area Card can

be added access control elevator control area rights.

A maximum of 12 room areas are allocated to one card.

Room Area Card x
Cardholder Name™ Head
Last Name Master
Card Expiration Time” 2023-08-19 15:55:11
Hotel Facility* Public Room 1,Public Root
Access Level(s) General
Elevator Control 1
Figure 1.4.3-4
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Room Management

Hotel Settings

Hotel Information
The name of the hotel is mandatory. Other information is optional, as shown in Figure 5.1-1.

The hotel's name, telephone, fax, website, address, and zip code will be displayed on the
check-out bill.

The hotel's name, phone number and website address will be used for email and SMS

notifications.

Hotel Information

Hokel Name' Eest hotelt

Telephone 40010538681
Fax 888-66868583
Zip/Post Code 116021

Wabsite www.zkleco.com|
E-mai jiakal.zh@zktaco1.com
Hotel Address Zkteco

Hotel Logo

Figure 1.5.1-1

Hotel Option Settings

Check-in Time

Check-in Time is divided into 3 categories. Earliest Check-in Time, Default Check-in Time, and Latest

Check-in Time, as shown in Figure 1.5.1-2.

Earliest check-in time”* 06 [ 00 s (hh:mm)

Default Check-In Time* 12~ 00 » (hh:mm)

Latest check-in time™ 23 w00 w/|{hh:mm)
Figure 1.5.1-2

Check-in Time is only used for reservation check-in and does not apply to direct check-in.

Check-out Time

Check-out Time is divided into 3 categories. Default Check-out Time, Half-day Overstay Check-out
Time, Full-day Overstay Check-out Time, as shown in Figure 1.5.1-3.
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Default Check-Out Time* 12 w00 ~ (hh:mm)
Half-day Overstay Check-Out Time |14 |00 | {hh:mm ) (Hali-da

Full-day Qverstay Check-Out Time |18 s 00 s (hh:mm )(Cversia

Figure 1.5.1-3

The default check-out time cannot be modified.

If the guest does not check out beyond the default check-out time and date, it will be counted

as an overstay check-out, and the system will mark the overstay check-out room on the

interface.

In case of overstay check-out, an additional room fee will be charged according to the rules set

by the room type.

Overstay check-out for guests who exceed the half-day check-out period will be charged

according to the half-day overstay fee set by room type.

An overstay check-out for guests who exceed the full day check-out period will be charged

according to the full day rate set by room type.

Maximum Booking Days

The maximum booking days of the same guest in the same reservation and the same room cannot

exceed the maximum booking days, as shown in Figure 1.5.1-4.
Maximum Booking Days™ |1

Figure 1.5.1-4

The maximum value is 99 days, minimum value is 1 day.

Days to Stay by Default

(Day)

Days to Stay by Default only affects express check-in room (daily rental). The default number of

days can be modified during the check-in process according to the situation, as shown in Figure

1.5.1-5.

Check-In Registration

Room Name™ yihaolou1F101 -

Certificate Type® 1D - Phone Number

1D Number® 2233 E-mail

First Name™ test Emergency Contact Phone

Last Name bug Check-in Type”®

Gender Male - Guest Count”

Home Address Zkieco Check-In Time™

Days to Stay” %4 Check-Out Time*

Discount(%) 1 Daily Rate”

Deposit Amount™ 100.00 Payable Amount®
2023-08-20 12:00:00The room has baen booked

Figure 1.5.1-5

Bl - 400105368 (O
jiakai.zh@zkteco.com Q

| 4001053864
(@ Daily Rent By Hour

1 -
2023-08-17 10:26:56
2023-08-17 12:00:00
200.00

29800
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Housekeeping Window Hours

Housekeeping Window Hours are blank by default, as shown in Figure 1.5.1-6.
Housekeeping Window Hours (minutes)

Figure 1.5.1-6

When this time is set, rooms with the “Cleaning” status room will become “vacant” after the

setting time. If it is empty, the “Cleaning” status will not change except manual change.

Room cleaning time can be set from 1 to 59 minutes.

Currency Type and Unit of Room Acreage

The default currency type is US dollars, and the default unit of room acreage is inches, as shown in
Figure 1.5.1-7.

Currency Type™ UsD ]

Unit of Room Acreage i -

Figure 1.5.1-7

The Currency type is used to settle the room rate, and the unit of room area is used for room
dimensions in Room Type.
Tax Type and Tax Rate

The Tax Type, Tax Rate, Other Charge Type, and Other Charge Rate are blank by default, as shown
in Figure 1.5.1-8.

Tax Type Tax Rate %
Other Charge Type Other Charge Rate %
Figure 1.5.1-8

After setting the content of this field, guests will pay the corresponding percentage of taxes
when they settle the room rate.

Hidden the Search Criteria

The Hidden search criteria are not selected by default and can be used to hide search criteria in

Room Monitor, as shown in Figure 1.5.1-9.

Hidden the search criteria [

Figure 1.5.1-9

After this function is selected, the search criteria are hidden by default in Room Monitor, and

user need to click > icon to expand the display. If this function is not checked, the search

criteria will be displayed by default.
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Elevator and Access Control
Elevator/Access Control is not selected by default and is used to determine whether to display

elevator and access control options, as shown in Figure 1.5.1-10.

Elevator/Access Control [ (If checked, guest has access to the specified Elevator/Access Control facilities. )

Figure 1.5.1-10

After this function is selected, the elevator and access control options are displayed on all card

issuing interfaces.

Hotel Card Setting

Card Password: Set the sector password for the dedicated sector of the hotel room card. The

default password is ciphertext 123456.

Repeat Password: Repeat input the above card sector password for a second confirmation, in case

of input errors.

Card Sector: Set the dedicated sector of the hotel's room card. The default is 3 sectors. User can

select sectors 1 to 15, as shown in Figure 1.5.1-11.

Card Password®
Repeat Password™ | =es== Card sector and password cannot be changed after issued.

Card Sector: Sector 3 i

Figure 1.5.1- 11
Note:

Once the card issuing function is used in the hotel system, the system will lock the card sector

and the sector password, which cannot be modified.

When setting the card sector, pay attention to distinguishing it from the card issuing sector of
other modules, such as access control, elevator control, consumption, and so on, to avoid
repetition.

Default Net Card

Default Net Card function is only used for issuing default net cards. Room cards or other type

of card cannot be written after issuing default net card.
Click Default Net Card to issue default net card.

Click Cancel Card to cancel the default net card. This function can only be used to cancel the

default net card, as shown in Figure 1.5.1-12.

Default Net Card

Figure 1.5.1-12
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Once everything is set, click OK to save the parameter settings.

Room Type

Add Room Type

Add a room type, enter the details in required fields and save. Room type is used to bind rooms and

provide different room types for guests. The parameter description is referred to as follows.

Room Type: Customize the room type for subsequent binding.

Room Size: Customize the room size, and the units are displayed according to Unit of Room

Acreage, which is convenient for subsequent binding use.
Number of Beds: The total number of beds in room, can be displayed upon check-in.

Maximum Number of Guest: The maximum number of guests in a room, which is limited to

the number of guests at check-in.
Daily Rate: Customize the daily room rate for a room to be settled at check-out.
Hourly Rate: Customize the hourly room rate for a room to be settled at check-out.

Overstay Hourly Rate: Customize the overstay hourly room rate for a room to be settled at

check-out.

Deposit Amount: Customize the security amount for a room to be settled at check-in and

check-out.

Overstay Rate (Half Day): Customize the overstay half-day room rate for a room to be settled

at check-out.

Overstay Rate (Full Day): Customize the overstay full day room rate for a room to be settled

at check-out.

Amenities: Includes Air Conditioner, Bath and Shower, TV, Wireless Internet, Refrigerator,
Telephone, and Safe Box and Shower are optional and can be displayed in the room

information after being selected.

Click New to add a room type, enter the details in the required items. Click Save and New to

continue adding, click OK to save and close, click Cancel to not save and close, as shown in Figure
1.5.2-1.
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Room Type®

Number of Beds®

Daily Rate”

Overstay Hourly Rate™
Overtstay Rate (half day)”

New

Room Size(?)"*
Maximum Number of Guests™
Hourly Rate®

Deposit Amount”™

Overstay Rate (full day)”

Notes

Amenities

[T Air Conditioner ["] Bath and Shower O Tv [T Wireless Internet
"] Refrigerator [C] Telephone [[] Safe Box [C] Shower
Cancel
Figure 1.5.2-1
Edit Room Type

Click the room type name or icon 2 in the action list to enter the editing interface.
The edit interface content is the latest edited interface content.
All content can be edited normally.

When the room type is in use, it cannot be saved after editing. Click the save page will give a

prompt, as shown in Figure 1.5.2-2.

Edit ®
Room Type® shuangren Room Size(ft*)" 10
Number of Beds® 2 Maximum Number of Guests™ 3
Daily Rate” 200 Hourly Rate® 20
Overstay Hourly Rate™ 40
Overistay Rate (half day)” 400 =3
Notes test notes o)
Room type cannot be changed once it is checked -in.
Amenities

[C] Air Conditioner [C] Bath and Shower ™v ] wireless Internet
[ Refrigerator [C] Telephone Safe Box ] Shower
Cancel
Figure 1.5.2-2
Delete Room Type

Select the room type needs to be deleted and click the W icon in the Operations list or the Delete
button to delete it.

When the room type is in use, it cannot be deleted. Clicking Delete will give a prompt, as shown in
Figure 1.5.2-3.
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—\

=

Initialization data cannot be deleted!

Figure 1.5.2-3

Room

Add Room

Add a room, fill in the required fields, and save. Then users can create a building, floor, and room.

The parameter description is referred to as follows.

Building Name: Customize the building name, which will be displayed in the Room Monitor,

used to splice room name.

Floor Name: Customize the floor name, which will be displayed in the Room Monitor, used to

splice room name.

Room Type: Bind the room type in 1.5.2 Room Type to the room.

Room Count: The total number of rooms to be created.
Remarks: Remark notes.

After selecting the building and floor in the New node, the name of the building and floor will be

automatically filled in, as shown in Figure 1.5.3-1. If in the hotel node, it will be empty by default.

MNew x
Building Name® yi -
Floor Name™ 2F -
Room Type® s -
Starting Room Mumber™
Room Count™ 0

Remarks

Room name Cration rule: Building No. + Floor No. + Room No.

Cancel

Figure 1.5.3-1
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Edit Room

To edit the name of the building and floor, select the corresponding node and click Edit

button, as shown in Figure 1.5.3-2.

O Refresh  ENew £ Edit [ Delete Building and Floor ‘0 Refresh =+ New £ Edit W Delete Building and Floor

Y
FL i i 2 C Refresh [ Delete

B x 4 testhotsl E *
! test hotel = : Bu adyt =
- . | Floor Name” 2F

‘ ﬂ i Building Name’ 5_41 ! ’ o i 5
¥

i FF |

FF
: 1
Cancel E cante
[T yY1E102 yi
Figure 1.5.3-2

To edit the room name, select the corresponding room and click the room name. The remarks
in the current field are the remarks of the room information in the Room Monitor interface, as

shown in Figure 1.5.3-3.

Edit x
Building Name™
Floor Name®
Room Type* shuangren -
Room No.* 200
Remarks
Cancel
Figure 1.5.3-3

If the room is in use, it cannot be edited. Click Edit will trigger a failure pop-up.

Delete Room

Select the room to be deleted and click & icon in the Operations list or Delete button, as

shown in Figure 1.5.3-2.

If the room is in use, it cannot be deleted. Click Delete will trigger a failure pop-up, as shown in
Figure 1.5.3-4.

"0
o

Please unbind all locks from selected roomy11F102

Figure 1.5.3-4
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Delete buildings and floors use the Delete Building and Floor button.

If users want to delete the floor, they need to delete the room under the floor first, otherwise it
will fail and give a failure pop-up. Similarly, users need to delete the floor before deleting the

building, as shown in Figure 1.5.3-5.

Prompt

Please delete the room firstl

Figure 1.5.3-5

Hotel Facility

The room area is divided into two parts, and the left side provides editing for a preset 50

public areas.

Click Public Room on the left or cIickﬁ icon to edit the name and remarks.

Click =+ icon on the left to add a public room, as shown in Figure 1.5.4-1.

New ( Public Room 1 ) Reom %

Building Name - Floor Name - More ay &
Atternative Selected(0)

Room Name  Building Name  Floor Name Room Type Room Name Building Name  Floor Name Room Type
y11F101 ¥1 1F shuangren
y11F103 ¥1 1F shuangren
y11F104 i 1F shuangren

>
y12F200 ¥1 2F shuangren

>
y12F201 y1 2F shuangren %

No data
1-5 50 rows per page
Cancel

Users can only view and delete the public rooms, as shown in Figure 1.5.4-2.

SelectedRoom:Public Room 1

~ | More e (1

- Floor Name

Building Name

G Refresh @ Delete Roem

Room Name Building Name Floor Name Room Type

y11F100 y1 1F shuangren

Figure 1.5.4-2
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Booking Method

By default, there are three options: Online Booking, Booking by receptionist, and Booking by
Phone, as shown in Figure 1.5.5-1.

Booking method Create Time Last Updated Time Operations

Online Booking 2023-08-14 09:31:44 2023-08-14 09:31:44 Z

Booking by receptionist 2023-08-14 09:31:44 2023-08-14 09:31:44 2

Booking by Phone 2023-08-14 09:31:44 2023-08-14 09:31:44 Z
Figure 1.5.5-1

The preset reservation method can only be edited and cannot be deleted.

The new reservation method can be edited and deleted normally, as shown in Figure 1.5.5-2.

Booking method Create Time Last Updated Time Operations
test 2023-08-19 17:45:47 2023-08-19 17:45:52 Z W
Figure 1.5.5-2

Email Template

Email template is used for sending emails, including check-in, check-out, reservation success,

and reservation cancellation templates, as shown in Figure 1.5.6-1.

Name Code Text Enable Operations

check-Out EmailCheckOut No yd

Check-ln EmailCheckin No z

Ccancel EmailBookingCancel No z

Success EmailBookingSuccess No 2
Figure 1.5.6- 1

The default template can only be edited and cannot be deleted.

Table 1.5.6-1 lists the key fields of an email template.

Parameters Clarification

##name#i Occupant or reservation name to get self-entry data.

##lastName## Occupant or Reservationist Last Name, Get Self-Entry Data,
or Null to display null.

##order## The order number generated by the hotel

##checkinTime## Check-in time to get self-entry data.

##roomNamet# Room name, get self-entry data.

##checkOutTimett# Check-out time to get self-entry data.

##roomTypeit# Room type to get self-entry data.

##roomNumberi## Reservation Room Number

##h5Url## H5 mobile Application address
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##checkinld## CheckinID

##verifyCodet# H5 verify code

##roomld## room ID

##address#i# Hotel address

##hotelName## Hotel name, obtained from the hotel settings.
##officePhoneit# Hotel phone number, get from hotel settings.
#H#website## Hotel website.

Table 1.5.6- 1
1.5.6.1 Send Email Template

1. To send emails, set the email server in System Management, as shown in Figure 1.5.6-2.

Outgoing Mail Server Seftings

|Outgoing Mail Server Settings|
Email Sending Server’

Port” 25
Email Account®

Password’ |

‘Sender Name ‘

Test Connectlion

A Please compleie the email verification.

Figure 1.5.6-2

2. After the configuration is complete, enable the template, configure related fields, and text
content, as shown in Figure 1.5.6-3.
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Hame Chek-in
Code’ EmaiiCheckin
Enable’ s -

Dear {name} {lastName} :
order: {order},
checkInTime: {checkinTime},
roomName:; {roomName},
checkOutTime: {checkOutTime},
roomType:{address},
address: Hotel Address .,

phone: {phone},

{hoteiName},
{officePhone},

{website}

Cancel

Figure 1.5.6-3

Then complete the corresponding operations and receive the corresponding template email,

as shown in Figure 1.5.6-4.

Dear duosuan yitian:
order: 16757116438747379,
checkinTime: 2023-02-07 03:25:56.0,
roomName: 1112,
checkOutTime: 2023-02-07 12:00:00.0,
roomType: danren,
address: Hotel Address,
phone: 15944444444,
test-hotel
123456789

http://www.baidu.com

Figure 1.5.6-4

SMS Template
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SMS template is used for sending emails, including check-in, check-in, check-out, reservation

success, and reservation cancellation templates, as shown in Figure 1.5.7-1.

Name Code Text Type
check-out SmsCheckout

Check-In SmsCheckin Dear {name} {lastName} : order: {order}, checkinTime: {checkinTime}, roomName: {roomName
Cancel SmsBookingCancel

Success SmsBookingSuccess

Figure 1.5.7-1
The default template can only be edited and cannot be deleted.

Table 1.5.7-1 lists the key fields of an SMS template.

Enable

No

Yes

No

No

Operations

2

(L %

I
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Parameters Clarification
#H#namet# Occupant or reservation name to get self-entry data.
##lastName## Occupant or Reservationist Last Name, Get Self-Entry Data, or
Null to display null.
##order#i# The order number generated by the hotel
##checkinTime## Check-in time to get self-entry data.
##roomNamefd# Room name, get self-entry data.
##checkOutTimet## Check-out time to get self-entry data.
##roomTypeiti Room type to get self-entry data.
##roomNumberi#i# Reservation Room Number
##h5Url## H5 mobile Application address
##checkinld## Checkin ID
##verifyCode## H5 verify code
##roomld## room ID
##addressiti# Hotel address
##hotelName## Hotel name, obtained from the hotel settings.
##officePhone## Hotel phone number, get from hotel settings.
##website## Hotel website.
Table 1.5.7-1
Send WhatsApp Template

Select third-party integration in the system, and fill in the corresponding parameters of

WhatsApp, as shown in Figure 1.5.7-2.
System / Third Party Integration / WhatsApp

Connection Parameter Setting
Solution Provider
) RAPIWHA (&) Twilio

SID

ACdeb80c26e40e51265e60 12622669300

Token

1acbbch8bB8adc999372724f525e 1caby

From

Please click here to set up your webhook

Figure 1.5.7-2

After the configuration is complete, enable the template, configure related fields, and text content

Then complete the corresponding operations and receive the corresponding template

message, as shown in Figure 1.5.7-4.
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Success test

First Name,Last Name,
16782397850763554,

Wed Mar 08 12:00:00 CST 2023,
Test Hotel2th201,

Thu Mar 09 12:00:00 CST 2023,

shuangren,

in China,

Test Hotel 3rd ,

Figure 1.5.7-4

Send AWS Template

Select third-party integration in the system, and fill in the corresponding parameters of SMS, as

shown in Figure 1.5.7-5.

SMS Parameter Settings *
Modem-SMS AWS-SMS
SMS Parameter Settings
Accesskey” KISAWGFSOJRMHPIYPFB
Secretkey* 1ydMXIBIKIEh8yOUpSaf2A]
Enable

Test Send

Receiver +8615042628560

Content test code 123456

Successful
Cancel

After the configuration is complete, enable the template, configure related fields, and text content,
and select AWS

Then complete the corresponding operations and receive the corresponding template

message, as shown in Figure 1.5.7-6.
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check-in test time

Ftest,Ltest,
16786702670432444,

Mon Mar 13 09:17:12 CST 2023,
Test Hotel2th201,

Tue Mar 14 12:00:00 CST 2023,

shuangren,

in China,
Test Hotel 3rd 1,

Figure 1.5.7-6

Page | 87 Copyright © 2025 ZKTECO CO., LTD. All rights reserved.



ZKBio CVSecurity Smart Lock

User Manual

Report Management

Guest Check-in Report

In the search bar, users can choose the order number, mobile phone number, guest name, or other

criteria to perform a quick search for guest check-in records, as shown in Figure 1.6.1-1.

Hotel / Report Management / Guest Check-in Report

Booking number

G Refresh

status

Valid

Invalid

Invalid

Invalid

Invalid

Invalid

Invalid

Invalid

Invalid

Invalid

Invalid

Invalid

Invalid

Invalid

Invalid

Invalid

2 Export
Booking number

16923686919512:

16923529323507:

16923444280916

16923283472937

16923283472937

169226573539841

16022657353984¢

16922653940215¢

16922437737207

1692241258065

16922406149258¢

16920853725595

16920853725595

16920853725595

1692084360437

16920838705237

Mobile Number

Check-in T.

Daily Rent

Daily Rent

Daily Rent

Daily Rent

Daily Rent

Daily Rent

Daily Rent

Daily Rent

Daily Rent

Daily Rent

Daily Rent

By Hour

By Hour

By Hour

Daily Rent

By Hour

Room Type

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

Room Name

y11F102

y11F103

y11F102

y11F102

y11F101

y11F104

y11F102

Y1F104

y11F104

y11F101

y11F101

y11F102

y11F102

y11F102

y11F101

y11F102

First Name

First Name

test

test

test

testH

test

testH

testH

testH

test

test

test

test

test

test

test

test

Reports can be exported.

Last Name

bugL.

bugl

bugl.

Morer Q &

Card No. Check-In Time

4004238539 2023-08-18 22:24:45
3700054240  2023-08-18 22:24:10
3700054240 2023-08-18 15:40:20
3700054240  2023-08-18 11:21:06
3320407305 2023-08-18 11:21:06
3320407305 2023-08-17 17:48:35
3700054240 2023-08-12 10:40:04
3700054240 2023-08-17 17:42:57
3700054240 2023-08-17 15:53:57
3700054240 2023-08-17 11:00:16
3700054240 2023-08-17 10:50:02
4004238539 2023-08-15 15:42:32
1104696834 2023-08-15 15:42:32
1104696834 2023-08-15 15:42:32
3320407305 2023-08-15 15:25:27
1104696834 2023-08-15 15:17:05

Check-Out Time

2023-08-19 12:00:00

2023-08-19 13:52:53

2023-08-18 15:40:56

2023-08-18 11:39:42

2023-08-18 11:39:42

2023-08-18 10:52:30

2023-08-18 10:52:30

2023-08-17 17:45:22

2023-08-17 16:02:43

2023-08-17 11:42:39

2023-08-17 10:54:38

2023-08-17 17:49:57

2023-08-17 17:49:57

2023-08-17 17:49:57

2023-08-16 17:52:18

2023-08-15 15:42:08

Figure 1.6.1- 1

Country code  Mobile Nu
86 4001053868
86 4001053868
86 4001053868
1 4001053868
1 4001053868
1 4001053867
1 4001053868
1 4001053868
86 4001053868
86 4001053868
86 4001053868
86 4001053868
86 4001053868
86 4001053868
86 18800001111
86 18800001111

1D Type 1D Number
D 333

D 1
Passport 11

D 333

D 3322
D 44555
D 3344
D 22333
D 2233
D 112233
D 112233
Passport 122
D 1

D 2

D 2233
D 122

All the information in the report is derived from the guest who checked in.

Emergency

4001053868

4001053868

12321

18800001111

E-mail

jiakai.zh@zkte

Jiakai.zh@zkte

jiakai.zh@zkte

Jiakai.zh@zkte

jiakai.zh@zkte

Jiakai.zh@zkte

jiakai zh@zkte

Jiakal zh @zkte

jiakal zh @zkte

Jiakai zh@zkte

Jiakai.zh @zkte

jiakai zh @zkte

jiakai.zh@zkte

Jiakai.zh@zkte

jiakai.zha@zki

Jiakaizhan@z!

Home A

2eco

2deco

zideco

2keco

2eco

2deco

If the status is valid, the guest is still checking in. If the status is invalid, the guest has checked

out.

Room Occupancy Report

In the search bar, users can choose the building, floor, room name, check-in time, check-out time,

or other criteria to perform a quick search for guest check-in records, as shown in Figure 6.2-1.

Hotel / Report Management / Room Occupancy Report

Building Name

G Refresn
status
vaiid
invaiia
invaiia
invaiia
invaiia
invaiia
invaiia
invaiia
invaiia
invaiia
invaiia
invaiia

Invalid
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2 Export

Fioor Name

Check-in Type

Daily Rent

Daily

Daily

Daily

Daily

Daily

Daily

Daily

Daily

Daily

Daily

Rent

Rent

Rent

Rent

Rent

Rent

Rent

Rent

Rent

Rent

By Hour

By Hour

Room Type

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

shuangren

v | RoomMame

Room Name

y11F102

y11F103

y11F102

y11F102

y11F101

y11F102

y11F104

y11F104

y11F104

y11F101

y11F101

y11F102

y11F102

Morer  Q

Building Name

<

Floor Name

1F

1F

Check-In Time

2023-08-18 22:24:45

2023-08-18 22:24:10

2023-08-18 15:40:20

Check-Out Time

2023-08-19 12:00:00

First Name  Last Name
test bug
test bug
test bug
testH bugL
test bug
testh bugL
testh bugL
testh bugL
test bug
test bug
test bug
test bug
test bug

Figure 6.2-1

2023-08-18

2023-08-18

2023-08-18

2023-08-17

2023-08-17

2023-08-17

2023-08-17

2023-08-17

2023-08-15

2023-08-15

1:21

1:21

10:40

17:48

17:42

15:53

11:00:

10:50

15:42

15:42

06

06

04

35

57

57

16

02

32

32

2023-08-19

2023-08-18

2023-08-18

2023-08-18

2023-08-18

2023-08-18

2023-08-17

2023-08-17

2023-08-17

2023-08-17

2023-08-17

2023-08-17

13:52:53

15:40:56

11:39:42

11:30:42

10:52:39

10:52:39

17:45:22

16:02:43

11:42:39

10:54:38

17:49:57

17:49:57
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e Reports can be exported.
o Allthe information in the report is derived from the guest who checked in.

o If the status is valid, the guest is still checking in. If the status is invalid, the guest has checked

out.

1.6.3 Room Charges Report

In the search bar, user can select the time, guest name, room name, room type or other criteria to

search for room charge records, as shown in Figure 6.3-1.

Hotel / Report Management / Room Charges Report
Time From 20230519 000000 | To 2023-08-192359:59 |  FirstName | Morer Q ©
O Refresh T Export 2 Re-print Invoice
Booking number  Check-in Type  Room Type Room Name First Name Last Name CheckInTime  Check-Out Time Stay Time
16023520323507252 Daily Rent shuangren yinaoloutF103  test bug 2023-08-18 22:24 2023-08-19 13:52 2 3
| 16923444280916738 Daily Rent shuangren yihaoloutF102  test bug 2023-08-18 15:40 2023-08-18 15:40 1
16023283472937580 Daily Rent shuangren yihaoloutF102  test bug 2023-08-18 11:21 2023-08-18 11:39 1
| 16923283472937580 Daily Rent shuangren yihaoloutF101  test bug 2023-08-18 11:21 2023-08-18 11:39 1
16922657353984825 Daily Rent shuangren yihaoloutF104  test bug 2023-08-17 17:48 2023-08-18 10:52 1
| 16922657353984825 Daily Rent shuangren yihaoloutF102  test bug 2023-08-17 17:48 2023-08-18 10:52 1
16020853725595628 By Hour shuangren yihaoloutF102  test bug 2023-08-15 15:42 2023-08-17 17:49 51
| 16922653940215594 Daily Rent shuangren yihaoloutF104  test bug 2023-08-17 17:42 2023-08-17 17:45 1
16022437737207130 Daily Rent shuangren yihaolouF104  test bug 2023-08-17 11:42 2023-08-17 16:02 1
| 16922412258065670 Daily Rent shuangren yihaoloutF101  test bug 2023-08-17 11:00 2023-08-17 11:42 1
16022406149258673 Daily Rent shuangren yihaoloutF101  test bug 2023-08-17 10:50 2023-08-17 10:54 1
| 16920843504937693 Daily Rent shuangren yihaoloutF101  test bug 2023-08-15 15:25 2023-08-16 17:52 2
16920838705237401 By Hour shuangren yihaoloutF102  test bug 2023-08-15 15:17 2023-08-1515:42 3
| 16919914152379304 By Hour shuangren yihaoloutF100  test Bug 2023-08-14 13:36 2023-08-14 13:37 3

Figure 6.3-1
e Reports can be exported.
o Allthe information in the report is derived from the guest who checked in.

e Re-print Invoice is primarily used when a guest loses their invoice. Users can locate the record
for which they need to reprint the invoice, select it, and then click the Re-print Invoice option,

as shown in Figure 6.3-2.

Re-print Invoice:

Guest Information

CheckinType:  Daly Rent
11223344 testbug First Name: testbug
sss.sgssssss 20230818 2:24:10 CheckinTime:  2023-08-18 222410
wanczkteco.com 20230819 13:52:53 Check-OutTime:  2023-08-10 135253
2o
1 Room lst
DaysHours  Extended days/hours it Pri i a yHIF103 ONY 200.00

YUF103(Daily Rent) 100 000

Payment Information

y‘ Total Charge CNY 20000
extended rent(bours*extended ren) Tx Rate (%): CcNY 000
Total Charge: Other Charge Rate (%): CNY 0.00

TaxRate (%): Payable Amount: CNY 20000

Otter Clarge Rate (%) Amount Paid: CNY 300,00
Total Amount(lcluding Tax): Balance: CNY 100.00

Figure 6.3-2
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Issued Card Report

In the search bar, users can select the card issuance time, card number, effective start time or other

criteria to search for the card issuance record, as shown in Figure 6.4-1.

Hotel / Report Management / Issued Card Report

Issued Date  2023-05-1900:00:00  To 2023-08-19 23:50:59 More Q &

CRefresh 2 Export B2 Clear Card Loss Report B3 Report Card Loss

Card Status ~ Card Type Room Name Card No. Physical Card Num_.  Name Last Name 1D Type 1D Number Card Issued Date Card Expiration Date Issued Time
valid Room Card y11F102 4238539 4004238530 test bug D 333 2023-08-18 22:25:00 2023-08-20 12:00:00 2023-08-18 22:25:00
Invalid Room Card y11F103 700054240 3700054240 test bug D 1 2023-08-18 22:24:22 2023-08-19 13:53:10 2023-08-18 22:24:22
Invalid Emergency Card 320407305 3320407305 Head Master 2023-08-18 19:17:47 2023-08-18 19:20:15 2023-08-18 19:17:47
Invalid Room Card y11F102 700054240 3700054240 test bug Passport 1 2023-08-18 15:40:32 2023-08-18 15:40:58 2023-08-18 15:40:32
valid Emergency Card 320407305 3320407305 Head Master 2023-08-18 15:37:56 2023-08-31 15:37:00 2023-08-18 15:37:56
Invalid Room Card y11F102 700054240 3700054240 testH buglL D 333 2023-08-18 11:38:54 2023-08-18 11:39:44 2023-08-18 11:38:54
Invalid Room Card y11F101 320407305 3320407305 test bug D 3322 2023-08-18 11:38:37 2023-08-18 11:39:52 2023-08-18 11:38:37
Invalid Room Card y11F104 320407305 3320407305 testH buglL D 44555 2023-08-17 17:49:40 2023-08-18 11:10:21 2023-08-17 17:49:40
Invalid Room Card y11F102 700054240 3700054240 testH buglL ) 3344 2023-08-17 17:49:03 2023-08-18 11:09:59 2023-08-17 17:49:03
Invalid Room Card y11F104 700054240 3700054240 testH buglL D 22333 2023-08-17 17:43:23 2023-08-17 17:45:45 2023-08-17 17:43:23
Invalid Room Card y11F104 700054240 3700054240 test bug D 2233 2023-08-17 11:42:55 2023-08-17 16:42:47 2023-08-17 11:42:55
Invalid Room Card y11F101 700054240 3700054240 test bug D 112233 2023-08-17 11:10:58 2023-08-17 11:42:41 2023-08-17 11:10:58
Invalid Room Card y11F101 700054240 3700054240 test bug D 112233 2023-08-17 10:54:15 2023-08-17 10:54:40 2023-08-17 10:54:15
Invalid Room Card y11F102 4238539 4004238539 test bug Passport 122 2023-08-16 11:46:00 2023-08-17 17:50:36 2023-08-16 11:46:00

Figure 6.4- 1
e Reports can be exported.

e All data in the report derived from the card issuing operation of the hotel, including the

administrator, housekeeping card, maintenance card, and room area card.
e Thereport supports Report Card Loss or Clear Card Loss Report for all cards.

e  After the card is reported loss, the card information will be synchronized to the blocklist of all

locks, and the card will not be swiped to open any door.

e After the card loss report is cleared, the card information will be deleted from the blocklist of

all locks, and the registered room can be opened normally.

Write Card Record Remotely

In the search bar, users can select the time, card number, card validity period or other criteria to

search for remote card write records, as shown in Figure 6.5-1.
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Hotel / Report Management / Write Card Record Remotely

Issued Date | 2023-05-19 00:00:00

CRefresh T Export 2

Issued Date

2023-08-17 17:48:35

2023-08-17 17:48:35

2023-08-17 17:48:35

2023-08-17 17:48:35

2023-08-15 15:42:32

2023-08-14 10:24:46

2023-08-14 10:24:46

2023-08-14 10:22:34

2023-08-14 10:22:34

2023-08-14 10:05:42

2023-08-14 10:05:42

2023-08-14 09:55:31

To |2023-08-19 23:50.59

Rewrite Card

Expiration Date

2023-08-18 10:40:04

2023-08-18 10:52:30

2023-08-18 10:40:04

2023-08-18 10:52:30

2023-08-17 17:49:57

2023-08-14 10:26:17

2023-08-14 10:26:17

2023-08-14 10:23:00

2023-08-14 10:23:00

2023-08-14 10:06:21

2023-08-14 10:06:21

2023-08-14 09:56:55

Q ¢
Building Floor
¥ 1F
¥1 1F
¥ 1F
¥1 1F
¥ 1F
¥1 1F
¥ 1F
¥1 1F
¥ 1F
y1 1F
¥ 1F
¥1 1F

Room

y11F101

y11F104

y11F101

y11F104

y11F102

y11F103

y11F103

y11F101

y11F101

Yy11F101

y11F101

y11F101

Reports can be exported.

First Name

testH

testH

testH

testH

test

test

test

test

test

test

test

test

LastName  ID Type 1D Number
bugL D 3344

bugl D 44555
bugl D 3344

bugl D 44555

bug D 3

bug D 1

bug D 1

bug D 11223344
bug D 11223344
bug D 11223344
bug D 11223344
bug D 1122334455

Figure 6.5- 1

Co.

Mobile Nu

4001053868

4001053867

4001053868

4001053867

4001053868

Logical Card Number

320407305

320407305

104696834

Physical Card Number

3320407305

3320407305

1104696834

All data in the report is derived from the remote card writing operation of the hotel during

card issuance.

Rewrite Card function is used if the remote write card command fails to be delivered or is lost.

Unlock Log Report

In the search bar, users can select building name, floor name or other criteria to search for hotel

unlock records, as shown in Figure 6.6-1.

(JZKBio CVSecurity i 38

5 Hotel | Report Management / Unlock Log Report

Building Name
& ]

ORefresh 2 Export

Unlock Mode

Unlock by card

B

Unlock by card

Unlock by card

Unlock by card

Unlock by card

Unlock by card

Unlock by card

Unlock by card

Unlock by key

Unlock by key

Unlock by card

Unlock by card

Unlock by key

Unlock by card

Unlock Time

2023-08-18 15:42:30

2023-08-18 15:40:20

2023-08-15 16:31:49

2023-08-15 16:30:05

2023-08-15 16:27:22

2023-08-15 16:25:28

2023-08-15 16:25:07

2023-08-15 16:17:06

2023-08-15 16:11:07

2023-08-15 16:11:05

2023-08-15 16:08:14

2023-08-15 16:05:42

2023-08-15 15:19:02

2023-08-14 10:26:52

~ | Fioor Name

Card No

320407305

320407305

104696834

104696834

104696834

104696834

104696834

104696834

104696834

104696834

104696834

~ | RoomName

Physical Card Num

3320407305

3320407305

1104696834

1104696834

1104696834

1104696834

1104606834

1104696834

1104696834

1104696834

1104696834

Reports can be exported.

card Type

Emergency Carg

Emergency Card

Room Card

Room Card

Room Card

Room Card

Room Card

Room Card

Room Card

Room Card

Room Card

Morer Q &

Building Name  Fioor Name Room Name

yihaolou " yihaoloutF102
yinaolou 1F yihaoloutF102
yinaolou 1F yihaolou1F102
yihaolou 1F yihaoloutF102
yihaolou 1F yihaolou1F102
yihaolou 1F yihaolou1F102
yihaolou 1F yihaolou1F102
yihaolou 1F yihaolou1F102
yinaolou 1F yihaoloutF100
yinaolou 1F yihaoloutF100
yinaolou 1F yihaolou1F102
yihaolou 1F yihaolou1F102
yihaolou 1F yihaolou1F100
yihaolou 1F yihaolou1F103

Figure 6.6- 1

All data in the report is derived from opening door.

Device Command List

First Name

Head

Head

test

test

test

test

test

test

test

test

test

Last Name

Master

Master

1D Type

 aamn -

1D Number

In the search bar, users can select the lock MAC address, time, or other criteria to search for

communication logs of the Gateway or hotel lock, as shown in Figure 6.7-1.
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Hotel / Report Management / Device Command List

Lock Mac Address Time From  2023-07-19 000000 To 2023-08-19 235959 Q ¢

G Refresh B Clear All Commands

Sequential Number Lock Mac Address  Command Descripti.. Command Body Command Status Submission Time
00-0D-6F-00-17-60-49-B7:¢ 00-0D-6F-00-17-60-49  setLockStatus {"lockMac®:*00-0D-6F-00-17-60-49-B7", "command®:"5"} Command Issued Stati 2023-08-18 15:42:24 a
00-0D-6F-00-17-60-49-B7:¢ 00-0D-6F-00-17-60-49  setLockStatus {"lockMac®:*00-0D-6F-00-17-60-49-B7", "command®:"6"} Command Issued Stati 2023-08-18 15:42:06
00-0D-6F-00-17-60-62-EB:1 00-0D-6F-00-17-60-62  setLockStatus {"lockMac":*00-0D-6F-00-17-60-62-EB","command"."5"} Command Issued Stati 2023-08-18 15:39:37
00-0D-6F-00-17-60-62-EB:1 00-0D-6F-00-17-60-62  selLockStatus {"lockMac®:*00-0D-6F-00-17-60-62-EB","command".4"} Command Issued Stati 2023-08-18 15:38:32
00-0D-6F-00-15-62-47-60:7 00-0D-6F-00-15-62-47 syncTime {"sysTime":"1692304265",“lockMac":00-0D-6F-00-15-62-47-60"} Operation Successfull 2023-08-18 04:31:05
00-0D-6F-00-17-60-46-47:7 00-0D-6F-00-17-60-46 syncTime {"sysTime":*1692304263", lockMac":*00-0D-6F-00-17-60-46-47"} Operation Successfull 2023-08-18 04:31:03
00-0D-6F-00-17-60-49-87:7 00-0D-6F-00-17-60-49 syncTime {"sysTime":*1692304262", lockMac":*00-0D-6F-00-17-60-49-B7} Operation Successfull 2023-08-18 04:31:02
00-0D-6F-00-17-60-57-91:7 00-0D-6F-00-17-60-57 syncTime {"sysTime":*1692304261", lockMac":00-0D-6F-00-17-60-57-91°} Operation Successfull 2023-08-18 04:31:01
00-0D-6F-00-17-60-62-EB:1 00-0D-6F-00-17-60-62 syncTime {"sysTime":*1692304260", lockMac":"00-0D-6F-00-17-60-62-EB"} Operation Successfull 2023-08-18 04:31:00
syncTime {"sysTime":*1692302405","lockMac":00-0D-6F-00-15-62-47-60"} Operation Successfull 2023-08-18 04:00:05
00-0D-6F-00-17-60-46-47:7 00-0D-6F-00-17-60-46 syncTime ("sysTime":*1692302404" "lockMac":"00-0D-6F-00-17-60-46-47"} Operation Successfull 2023-08-18 04:00:04
00-0D-6F-00-17-60-49-87:7 00-0D-6F-00-17-60-49 syncTime {"sysTime":*1692302403", lockMac":"00-0D-6F-00-17-60-49-B7"} Operation Successfull 2023-08-18 04:00:03
00-0D-6F-00-17-60-57-01:6 00-0D-6F-00-17-60-57 syncTime ("sysTime":"1692302402", lockMac":"00-0D-6F-00-17-60-57-917} Operation Successfull 2023-08-18 04:00:02
00-0D-6F-00-17-60-62-EB:{ 00-0D-6F-00-17-60-62 syncTime {"sysTime":*1692302400", lockMac":"00-0D-6F-00-17-60-62-EB"} Operation Successfull 2023-08-18 04:00:00

Figure 6.7- 1
All data in the report is derived from communication between devices and software.

Technical personnel use communication log records to check the communication status

between the Gateway and hotel lock.
Clicking Clear All Commands can clear all communication commands.

The communication command automatically deletes data older than one month.

Lost Card List

In the search bar, users can select the card number, serial number, or other criteria to quickly search

for lost card information, as shown in Figure 6.8-1.

(JZKBio CVSecurity = 88 @ aomin ~
[ Hotel / Report Management / Lost Card List

B Card No. Sequential Number Q ¢

G Refresh [ Clear the record of loss card report

o, Seaentisl umoer Sequential Number card status card Type Name Last Name Room Name Physical Card Num... Issued Time Card Issued Date Card Expiration Date
- 16924441004595120 00-0D-6F-00-17-60-49-B7:¢ Emergency Card Head Master 3320407305 2023-08-18 15:37:56 2023-08-18 15:37:56 2023-08-31 15:37:00
16924441004595120  00-0D-6F-00-17-60-62-E8:¢ Emergency Card Head Master 3320407205 20230819 15:37:55 20230818 1537:56  2023-08-31 15:37:00
16924441004595120  00-0D-6F-00-15-62-47-60:% Emergency Carg Head Master 3320407205 2023.08-18 1537:55  2023-08-18 15:37:56  2023-08-31 15:37:00
16924441004595120  00-0D-6F-00-17-60-46-47:8 Emergency Card Head Master 3320407205 20230818 15:37:55 20230818 1537:56  2023-08-31 15:37:00
16924441004595120  00-0D-6F-00-17-60-57-91:% Emergency Carg Head Master 3320407205 2023.08-18 1537:55  2023-08-18 15:37:56  2023-08-31 15:37:00
16924440770878530  00-0D-6F-00-17-60-49-87:¢ Room Card test bug yitF102 4004238539 2020810222500 2023-08-182225:00  2023-08-22 1200:00

" 16924440571438210 00-0D-6F-00-17-60-49-B7:¢ Room Card test bug y11F102 4004238539 2023-08-18 22:25:00 2023-08-18 22:25:00 2023-08-22 12:00:00

7 s0rows perpage - JumpTo 1 /i Page Totalof 7 records

Figure 6.8- 1
All data in the report is derived from the lost card.

Click Clear the record of loss card report can clear all records.
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Electronic Hotel Lock Module

It provides hotel service management functions covering check-in, overstay, check-out, rate settlement,
and lock setup and management.

It helps you quickly understand how to quickly navigate specific function pages, configure settings, and
use the hotel management software.

Hotel Settings

Users can set the basic information about a hotel, including its name, address, phone number, fax
number, zip code, website address, and email address. User can also set the function parameters
regarding the check-in time, check-out time, check-out reminder, and access/elevator control
permissions.

Click [Room Management] > [Hotel Settings]. The page shown in the following figure appears.

% statistic 3 Electronic Hotel Lock / Room Management / Hotel Settings
Hotel Information

ot Hotel Maageniat ¢ Hotel Name" 2K Holel Test

= Hotel Address

.2 Card Management >

Telephone

Room Management ~ Fax

ZipiPost Code
Website
Room Type
E-mail

Hotel Logo EEt | AT

Room

Room Area

Booking Method

1 100KB({JPG.. BMP.. GIF. and. PNG are supported only). The rafic of length o width should be 2:1 to reduce the type vanable.

Hotel Option Settings

Earliest check-in fime’ 09 |00 w (hh:mm) Default Check-Out Time’ 12 w - 00 w | (hh:mm)

Default Checkdn Time* |13 % |00 | (hh:mm) Half-day Overstay Check-Out Time |14 % - 00 % | {hh-mm ) (Hali-dz
Latest check-in ime 23 /00 v |(hh:mm) Full-day Overstay Check-Out Time |18 % 1 00 w | {hh:mm ) (Oversta
Maximum Ecoking Days™ | 100 (Day} Housekeeping Window Hours 1 (minutes)
Days to Stay by Default® |1 (Day) Currency Type® usD -+

[ Report Management >

The fields are described as follows:
Hotels can customize check-in times according to their preferences.
Earliest time a room can be used.
Latest check-in time, after which check-in is not possible.
It specifies the end time of a day use room.

Customizable settings for charging a half-day/one-day room
rate when the specified check-out time is exceeded.

It specifies the default number of days a guest stays. Generally, a guest stays for 1
day.
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The minimum number of hours defined by the user that a guest is required to
stay in a room. If a guest stays for a period less than this limit, the guest is charged the rate corresponding
to this limit.

After selecting this check box, you can select an access/elevator control level on
the card by issuing Ul, so that an issued card can be used not only as a hotel card but also used to access
the devices corresponding to the selected level. (Note: This check box is available on the Hotel Settings
page only after you use the access control module and/or elevator control module and obtain and
activate a license.)

It specifies the time available for cleaning a room after a guest checks out.
It specifies the currency.

= Note: The hotel management system can be used to define buildings, floors, and rooms as well as
handle check-in requests only after you set these parameters.

Room Management

Room Types

User can design information about various types of room, such as the number of beds and number of
guests allowed. You can lock and unlock vacant rooms.

Click[Room Management] > [Room Type] > [New]. The page shown in the following figure appears.

Mew x

Room Type* Room Size{)®
Mumber of Beds* Maximum Mumber of Guests*
Daily Rate® Hourly Rate*
Owerstay Hourly Rate* Deposit Amount®
Owertstay Rate (half day)* Overstay Rate {full day)*
Motes

Amenities

| Air Condifioner ] Bath and Shower BT [] Wireless Internet

| Refrigerator ] Telephone ~| Safe Box ~| Shower

Cancel

25 Note: When the user adds a room type, the system checks whether the hotel setting is configured. If
no, you are redirected to the settings page. All room types must be unique.

Building

User can define buildings of a hotel. When the rooms in a building are not booked or guests have not
checked in, you can lock or unlock the building.
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Click [Room Management] > [Room] > [New]>[Building Name]>[Manual Input]. The page shown in
the following figure appears.

Mew x
Building Name* Manual Input »
Floor Name* | ____ -
Room Type* | -
Starting Room Number®
Room Count® ]

Remarks

Room name Cration rule: Building Mo. + Floor No. + Room Mo

Cancel

#Note: When adding a building, the system first checks for configured hotel settings and room types. If
these are not set up, please configure them before proceeding. Each building’s name must be unique.

Floor
You can define the floors of a hotel. If no rooms on a floor are booked or occupied, you can lock or unlock
the floor as needed.

Click [Room Management] > [Room] > [New]>[Floor Name]>[Manual Input]. The page shown in the
following figure appears.

New X
Building Mame* Victoria Building4- *
Floor Mame* Manual Input x
Room Type* | -
Starting Room NMumber®
Room Count 0

Remarks

Room name Cration rule: Building Mo. + Floor No. + Room Mo

Cancel
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zNote: When you add a floor, the system checks for hotel settings, room types, and buildings in order. If
they have not been configured, configure the settings, types, and buildings first. All floor names must be

unique.

Room

Click[Room Management] > [Room] > [New]. The page shown in the following figure appears.

HNew x
Building Name* Victoria Building&- o
Floor Name* 2Floor b
Room Type* Standard room b
Starting Room Number® 101
Room Count* 3

Remarks

Room name Cration rule: Building No. + Floor No. + Room No

Cancel

Building Name, Floor Name, Room Type: Select the desired Building, Floor and Room type.
Starting Room Number: This sets the first number in the room sequence.

Room Count: It specifies the number of rooms to add. Value 1 indicates only one room is added. A value
greater than 1 indicates that a batch of rooms is added.

Remark: It describes the room.

2z Note: All room names must be unique.

Select one guest room and edit the guest room. Duplication of guest room names is not allowed. Guest
rooms that have been checked in or booked cannot be edited. See the following figure.
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Edit x
Building Name* Victoria BuildingA-
Floor Name* 2Floor
Room Type* Standard room b
Room Mo * 101
Remarks
Cancel

Select one or more guest rooms and delete them.

Only the guest rooms that have not been checked in or booked can be deleted.

Room Areas

User can define a room area, issue a card for the area, and link the locks of the rooms within the area to
the card. This allows a hotel manager to use the card to manage all the guest rooms in the area.

Click[Room Management] > [Room Areal. The interface shown in the following figure appears.

By default, 50 regions are included. If you need to change a region name, click -icon to modify it.
15 statistic > Electronic Hotel Lock / Roem Management / Room Area
Room Area < SelectedRoom:Family universal card
%% Hotel Management >
- Area Name Q B ¢ Building Mame | ———— * | Fioor Namg | | Mer Q@ B &Q
T2 Card Management b
Room Management L  Refresh & Refresh @ Delete Room
Area Name Remarks Operations Public Reom Building Name Floor Name Room Type
Hotel Settings
HeanTine Public Room 4 2 - Victoria BuildingA-2Floor Super v Victoria Building? 2Floor Standard room
Room Public Room 5 z + Victoria BuildingA-2Floor002 Victoria BuildingA 2Floor Standard room
Public Room & 2z + Victoria BuildingA-2Floor003 Victeria BuildingA 2Floor Standard room
Booking Method i _ 2+ Victoria BuildingA-2FioorTwin Ro( Victoria BuildingA 2Flaor Twin Room
Public Room & Z + Serengeti BuildingB-3Floord06 Serengeti Buildini 3Floor Twin Room
—— T Sorsngeti Buildings-3Flaor007  Serangoti Buildin 3Flaor Dl oees
Family universal card £ +
Public Room 11 2 +
Public Room 12 2 +
Public Room 13 2z +
Public Room 14 2 +
Public Room 15 Z +
- 1-5; i 50 rows per page Jump Ta 1” y /1 Page 1-8 50 rows per page Jump To 1 i1 Page  Total of 6 records

£ Report Management >

= Note:

Duplication of room area names is not allowed.

Click [Add] -"** icon and then you can add rooms to the area. See the following figure.
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New ( Family universal card ) Room x

Building Name | v b Floor Name | ———mm— v More Q R <
Altemafive Selected(4)

Public Reom Building Name  Floor Name Room Type Public Room Building Name  Floor Name Room Type

Serengeti BuildingB-3Floor005 Serengeti Buildini 3Floor Twin Room Serengeti BuildingB-3Floor001 Serengeti Buildin; 3Floor Standard room

Serengeti BuildingB-3Floor008 Serengeti Buildine 3Floor Deluxe Room Serengeti BuildingB-3Floor002 Serengeti Buildini 3Floor Standard room

Serengeti BuildingB-3Floor010 Serengefi Buildini 3Floor Family Room Serengeti BuildingB-3Floor003 Serengeti Buildini 3Floor Double Room
=

Victoria BuildingA-2Floor101 Victoria BuildingAd 2Floor Standard room Serengeti BuildingB-3Floor004 Serengeti Buildin: 3Floor Double Room
=

Victoria BuildingA-2Floor102 Victoria BuildingA 2Floor Standard room =
==

1-5 50 rows per page Total of 5 records
Cancel
Booking Methods

User can define methods for booking hotel rooms. During system installation, the basic booking methods
are initialized by default and cannot be edited or deleted.

Click [Room Management] > [Booking Method] > [New]. A new window, as shown in the following
figure, will appear.

Mew -4

Booking Method Mame*

#sNote: Duplication of booking method names is not allowed. Unused booking methods can be deleted.

Access/Elevator Control Levels

Users can assign access or elevator control levels to cards issued through the hotel module. This enables
a user to use the same card for both the hotel module and the access or elevator control module. In other
words, a card issued for the hotel module can also be used to access all devices associated with the
specified access or elevator control level.

& Note: This function and the Edit Personnel For Levels page are available only after you use the access
control module and/or the elevator control module and obtain and activate a license.

Click [Hotel Management] > [Reception] > Select a Vacant room > [Individual] > [Individual Check
in]. A new popup window, as shown in the following figure, appears.
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Check-In Registration x
Room Name® Serengeti BuildingB-3Floord... ¥
Phone Mumber EE - )
Certificate Type™ ] -
E-mail @]
ID Mumber* 1011
Emergency Contact Phone
First Mame™ Morris
Check-in Type™ @Daily Rent ()By Hour
Last N
AL Inaies Guest Count* 1 v
Gender [ -
Check-In Time* 2025-04-11 15:43:05
Home Address
Check-Out Time* 2025-04-12 12:00:00
Days to Stay®
ays o iay 1 Daily Rale® 150.00
Di (%)
OO o) Payable Amount* 250.00

Deposit Amount* 100.00

Fill in the check-in information, then click [Check-In Registration]. A new popup window, as shown in
the following figure, appears.

Register or Issue a Card X
Room Name* Serengefi BuildingB-3Floor(01
Room Type* Standard room
Check-In Time* 2025-04-11 15:43:05
Check-Out Time* 2025-04-12 12:00:00
Check in without card
Cerfificale Type* ]
1D Number* 1011
First Mame* Maorris
Last Mame
Phone Mumber B - ]
E-mail Q

Access Level(s)
Elevator Control

MNumber of Cards Issued: 0 MNumber of Available Guests: 1

First Name ID Type ID Number Card No.

Access Level(s)

Elevator Control

You can click to add and delete access/elevator control levels,

browse personnel of levels, and delete personnel of levels.

Click [Access Level(s)]. A new pop-up window, as shown in the following figure, appears.
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Select Access Level(s) x
Level Hame Q R o

Alternative Selected(0)

Level Name Access Time Period Level Name Access Time Period

General 24-Hour Accessible

No data

11 50 rows per page

Cancel

Select the access control level to be added and click [OK].
Click [Elevator Control]. A new popup window, as shown in the following figure, appears.

Select Elevator Control x
Level Name || | HE HE e

Altemative Selected(0)

Level Name Access Time Period Level Name Access Time Period

m 24-Hour Accessible

No data

-1 50 rows per page

Select the elevator control level to be added and click [OK].

Card Service Center

User can create different types of cards for setting and managing room locks based on daily hotel
business management requirements. Holders of the cards are employees of the hotel. User need to add
the holders using the HR module and specify their departments using the hotel module, so that you can
select the holders when issuing management cards.
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Electronic Hotel Lock / Card Man t / Card Manag

«/ Read Card & Cancel Card Reader Driver:Detected Driver is not installed:Driver Download

Setting Card

Room Area Card

Maintenance Card

X

Repori Card Loss

2.3.1 Setting Cards

User can set the basic information, including authorization, time, room number, and area information
about the locks of the hotel.

1. Authorization card

User can authorize cards for hotel locks by binding cards with related hotel information to ensure card
security. After authorization, the locks can be unlocked only by authorized cards. They will emit alarms if
other cards are used to unlock them.

Authorization Card »
False Lock Alam |

Cardholder Mame? | - |

Card Expiration Time* | 2025-04-12 15:49:16 |

Access Level(s) | |

Elevator Confrol | |

Field description:

Cardholder Name: Select the cardholder from the personnel module, which can be hotel staff, long-term
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residents,

management, etc.

It specifies the expiration time of the card. Select a time as required. The default

time is one day later than the current system time.

Click the drop-down list box to select an elevator/access control level. After the

parameter is specified, the card not only can unlock the specific room, but also can access the

corresponding devices to the elevator / access control level.

= Notes:

User can access the Elevator/Access Control field which is available only after selecting the
Room Management field on the Hotel Settings page.

For the access control devices and all elevator control devices that do not allow one person to
hold multiple cards, bind only one card with one person. This means you can select only one
card per Elevator/Access Control option when issuing cards to cardholders, as shown in the
figure above,, if Elevator/Access Control is set to Floor 1 of Building A (all the access control
devices on floor 1 of building A do not allow one person to hold multiple cards) when an
authorization card is issued to a card holder, only the first card can be assigned the permission
to access floor 1 of building A. You cannot set Elevator/Access Control to Floor 1 of Building A
when issuing any other card to the card holder.

If an access control device allows one card holder to hold multiple cards, you can assign one
access/elevator control level to multiple cards for the same card holder. User can select that
level again when issuing any other types of card or continuous cards to the card holder.

The preceding three points regarding access/elevator control are applicable to all the cards of
the hotel module described in this document.

The models and firmware version numbers of the access control devices that allow one person
to hold multiple cards include:

After selecting this check box, you can specify the number of times to emit an alarm.

False Lock Alarm

Mumber of Alarms i1 (_ Alarm stays on.

After configuring the settings, place a card on the card writer and click [Write Card].

Click [Personnel] > [Person] > [New]. A new pop-up window, as shown in the following figure appears.
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Persannel 1D !h[ma

First Name

Gender

Cediificate Type e
Birthday

Hire Date

Device Verification Password

Biometrics Type
1 Wireless Apartment Lock Access Conirol
Room Setting
Add Select All

F0O

Time Attendance

Unselect All

New

Department* Intemational hotel gr._. ~
Last Name

Mobile Phone

Certificate Number

Email

Position Name hd

Card Number (=]

WhatsApp

Elevator Control Flate Register Personnel Detail 4
7 Send Mofification

User Role ocrease s, -

Card Mumber

Passcode o

Set Valid Time

Cancel

Enter personnel information, select a hotel department, and click [OK]. You can select added personnel in

the card issuing module.

A Time Card can be used to unlock rooms within its validity period. After configuration, synchronize the

time of room locks with the time of the computer system. Otherwise, an alarm of card expiration may be

triggered when you punch the card.
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Time Card

Cardholder Hame* -

Card Expiration Time™ 2025-04-12 15:54:04

Lock Time 2025-04-11 15:54:04

Access Lavel(s)

Elevator Conirol

Click the drop-down list box to select an elevator/access control level. After the

Copyright © 2025 ZKTECO CO., LTD. Allrights reserved.



ZKBio CVSecurity Smart Lock User Manual

parameter is specified, the card cannot unlock the specified room, but can also access the corresponding
devices to the elevator / access control level.

After configuring the settings, place a card on the card writer and click [Write Card].

A room name card is used to unlock rooms with specified room names. You can select multiple rooms to
issue room name cards in batches.

Room Card x
Cardholder Hame* v
Card Expiration Time* 20250412 15:54:47
Room* Victoria BuildingA-2Floor S

Access Lavel(s)

Elevator Control

Click the drop-down list box to select an elevator/access control level. After the
parameter is specified, the card cannot unlock the specified room, but can also access the corresponding
devices to the elevator / access control level.

A room area card is used to unlock rooms in a specified area. If a room is within the specified area, the
card can unlock the room.

Room Area Card x
Cardholder Mame* -
Card Expiration Time" 2025-04-12 15:55:30
Room Area* Ashley clean area Public R

Access Level(s)

Elevator Control

Click the drop-down list box to select an elevator/access control level. After the
parameter is specified, the card cannot access the specified room, but also can access the corresponding
devices to the elevator/access control level.

2 Note: A maximum of 6 areas can be selected for one room area card.
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Employee Card

User can create various access/elevator control cards, such as master cards and emergency cards for hotel
personnel to manage hotel services.

A master card can be used to unlock all the rooms of the hotel within its validity period. By default, it is in
Always Open mode.

Master Card x
Always Open Mode
Cardholder Name* -
Card Expiration Time* 2025-04-12
Effective Time 00 - 00 il 23 59 i’

Access Level(s)

Elevator Control

Click the drop-down list box to select an elevator/access control level. After the
parameter is specified, the card cannot unlock the specified room, but can also access the corresponding
devices to the elevator / access control level.

If you select Always Open Mode, the unlocked rooms are kept unlocked.
Set Effective Time as well. The card can unlock rooms only within the specified periods.

After configuring the settings, place a card on the card writer and click [Write Card].

Emergency cards unlock all rooms. Emergency cards additionally bypass indoor locks.

Emergency Card x
Always Open Mode
Disable Indoor Locked
Cardholder Hame* -
Card Expiration Time* 2025-04-12
Effecive Time 00 : 00 il 23 : 59 il

Access Level(s)

Elevator Confrol

Click the drop-down list box to select an elevator/access control level. After the
parameter is specified, the card cannot unlock the specified room, but can also access the corresponding
devices to the elevator / access control level.

If you select Always Open Mode, the unlocked rooms are kept unlocked.
To disable Always Open Mode, you need to use a card that can unlock rooms, such as a building card or
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floor card.

Disable Indoor Locked is selected, which means that the card can open rooms even though the rooms are
locked from the inside.

A building card can be used to unlock rooms in a specified building in common unlocking mode within
its validity period.

Building Card xX
Cardholder Mame* -
Card Expiration Time* 2025-04-12
Building Mame* i
Effective Time 00 : 00 (223 50 5

Access Level(s)

Elevator Control

Click the drop-down list box to select an elevator/access control level. After the
parameter is specified, the card cannot unlock the specified room but also access the devices
corresponding to the elevator/access control level.

A floor card can be used to unlock rooms on a specified floor in common unlocking mode within its
validity period.

Floor Card x
Cardholder Mame* -
Card Expiration Time? 2025-04-12
Building Name* -
Floor Name* i
Effective Time 00 ;00 il 23 .08 i‘

Access Level(s)

Elevator Confrol

Click the drop-down list box to select an elevator/access control level. After the
parameter is specified, the card cannot only unlock the specified room, but also can access the
corresponding devices to the elevator / access control level.

A floor card can be used to unlock rooms in a specified area in common unlocking mode within its
validity period.
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Facility Card x
Cardholder Mame* -
Card Expiration Time* 2025-04-12
Room Area* Aszhley clean area, Family u
Effective Tims 00 : 00 il 23 . 59 il

Access Level(s)

Elevator Control

: Click the drop-down list box to select an elevator/access control level.
After the parameter is specified, the card cannot unlock the specified room but also can access the

corresponding devices to the elevator/access control level.

Maintenance Card

A maintenance card can be used to maintain and manage the room locks of the hotel.

A report loss card is a card that is invalidated and obsolete (usually due to loss or damage to the card)
during its validity period.

Report Card Loss x
Cardholder Mame* -
Card Expiration Time* 2025-04-12 15:58:45
Card Type® Authorization Card h
Room Card* Iris (2780027152} »

Access Level(s)

Elevator Confrol

Click the drop-down list box to select an elevator/access control level. After the
parameter is specified, the card cannot unlock the specific room, but can also access the corresponding
devices to the elevator / access control level.

A record card can be used to read unlocking records from locks within its validity period. Only S70 Miare
cards can be used as record cards.
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Record Card x

Cardholder Name* -
Card Expiration Time* 2025-04-12 15:59.04
Access Level(s)

Elevator Control

A Blocked card is a special card used to lock and protect a scene in a room in case of an emergency. Once
lockout is implemented, the room can no longer be unlocked by all the cards that can originally unlock it
before the cards are re-authorized.

Blocked Card X

Cardholder Mame* -

Card Expiration Time* 2025-04-12 15:59:20
Access Level(s)

Elevator Control

Click the drop-down list box to select an elevator/access control level. After the
parameter is specified, the card cannot unlock the specified room but also access the devices
corresponding to the elevator/access control level.

Hotel Management

Reception

The function allows users to handle room services and check the hotel room occupancy, such as the total
number of rooms, number of available rooms, and number of available rooms of a specific room type.

See the figure below.
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Electronic Hotel Lock / Hotel Management / Reception

Room Status. Al (16) L] Vacant (16) ® Needs Cleaning (0) @ Checked-in (o) ® Overstayed (0) ®  Maintaining (0) ® StopUse (0)

More: Daily Rent (D) ByHour (0} Duein (0} Dueout  (0)

e ——

Read Card Cancel Card Reader Driver Detected Driver is not installed Driver Download Printer Driver
TR

ilding: it ildi Floor:2Floor = Room No -
19 I Status:

Building:

Checkdn  Reservation Room

o

002 (Standard room) 003 (Standard room) Tuwin Room-0004 (Twin Room) 101 (Standard room)

Super Vip-0001 (Standard room)

No Lock No Lock

102 (Standard room) 105 (Family Room)

i BuildingB-  Floor:3Floor

®  Vacant (15) ® MNeedsCleaning (1) ® Checkeddn {0y ® Overstayed {0) ® Maintaining (D) ® StoplUse (0}

Different colors of the room represent different statuses.

1. Individual management
® Individual check-in

Double-click or right-click a vacant icon and choose [Individual Management] > [Individual Check-In].

Incdividual 4 Individual Check-In

001 (Standard room) Group Management=

Room Status

A new window appears in the following figure appears.
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Check-In Registration x
Room Name® Serengeti BuildingB-3Floor0... ™
Phone Number BEE - )
Cerfificate Type® | ____ - e
E-mail @
-,
1D Number* |
ll Emergency Contact Phone
First Mamsa*
Check-in Type* wDaily Rent (")By Hour
Last M
e Guest Count* 1 hd
Gender | ____ -
Check-In Time* 2025-04-11 16:02:28
H Addi
cloisalas Check-Out Time* 2025-04-12 12.00:00
Days o Stay*
¥ ¥ ! Daily Rate” 150.00
Di (%)
SO Payable Amount* 250,00
Deposit Amount® 100.00

The room you are staying in can be set in [Room Management] > [Room].
Type of document for check-in registration.
Enter the number of days that the guest wishes to stay.

Discount on the room cost. Just enter the discount percentage and the system will

automatically detect the discount from the final amount.
The cost of staying in a room can be set in [Room Management] > [Room Typel.
Amount to be paid at the time of check-in, including the room cost and the deposit.

After the information in the Individual Check-In page is filled in, the Registration or Issuing page appears.

Register or Issue 2 Card x

Room Name* Serengeti BuildingB-3Floor002
Room Type* Standard room
Check-In Time* 2025-04-11 16:08:55
Check-Out Time* 2025-04-12 12:00:00
Check in without card
Cerlificate Type D
1D Number* nm
First Name* Mormis
Last Name
Phone Number BEE -
E-mail
Access Level(s)
Elevator Control
Number of Cards Issued. 0 Mumber of Available Guests: 1

First Name 1D Type 1D Number Card No.

Click the drop-down list box to select an elevator/access control level. After the
parameter is specified, the room card can open not only the specified room, but also the devices
corresponding to the elevator/access control level.
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#5Note: Issue at least one card for each room. The card must be issued to the registered guest. When
issuing the first guest card, the Only registered, no card option is not available. After the first guest card is
issued, you can select Only registered, no card as required. The option indicates that the guest is
registered only and does not hold a guest card.

Right-click a checked-in room icon and choose [Individual Management] > [Individual Overstay]. A
new window open e shown in the following figure appears.

Overstay

)1 (Standard room)

Room Status Change Room o
oeem_ L
Owerstay Registration x
Room Name Serengeti BuildingB-3Floor001
First Name ID Type ID Number Card No.
ppl 1D 45865T756741648765 1326767139
Overstay Days™ 0 Days to Stay 1
Check-In Time 2025-04-15 10:49:13 Check-Cut Time 2025-04-16 12:00:00
Discount{%) 0 Overstay Charge 0.0

«Notes:
If the number of overstay days conflicts with the room reservation, an extension is not allowed.
Select the guest who needs an extension to proceed with the service.
The discount rate cannot be modified for overstay.
Overstay amount shows the amount to be paid for overstay.

After the information in the Individual Overstay page is filled in, the Registration or Issuing page appears,
as shown below.
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Issued for Overstay x
Room Name® Serengeti BuildingB-3Floor001
Room Type™ Standard room
Checlk-In Time* 2025-04-15 10:49:13
Check-Out Time™ 2025-04-18 12:00:00

Mumber of Cards Issued:0  Number of Available Guests 1

First Name 1D Type ID Number Card No. Issuing Status
ppl 1D 45865756741648765 1326767130
2Notes:

Reissue the guest card for the overstay guest. It must be the same card issued at check-in;

otherwise, the issue will fail.

You can click Write Card to automatically write cards for overstay in circulation until all overstay

cards are written in an interval of 3 seconds.

Right-click a room checked-in icon and choose [Individual Management] > [Individual Room Change].

A new window open as shown in the following figure appears.
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SuUnaing.>erengetu sulgings=-  Fioor.rioor

Individual

001 {Standard room} |

Room Status Change Room

Public Room Check-Out

Change Room *
Current Room | Serengeti BuildingB-3Floor001 New Room | Serengeti BuildingB-3Floor002
Room Type Standard room Room Type Standard room
Guest Count 1 Guest Count 1
Days Left |1 Days to Stay "1
Discount(%) ] Discount{%) o
Daily Rate 150 Daily Rate 150
Deposit Amount 100 Additional Deposit Amount 0.00
Prepaid Room 150 FPay Balance 0.00
Building Name | - Floor Mame | ~ | Room Name | Q R= &
Room Name Room Ty... Floor Name Building Name Room Ca... Number .. Daily Rate Hourly R... Depos..
Serengeti BuildingB-3Floor002 Standard ro. 3Floor Serengeti Buildini 2 1 150 100 100

4

€ < 11 » ¥1 50 rows per page - Jump To 1 /1 Page  Total of 1 records

First Name ID Type ID Number Card No.

ppl 1D 456754 1326767130
Check-In Time | 2025-04-15 11:29:42 Check-Out Time 2025-04-16 12:00:00

o< cancel |

Guest Count: Number of guests that require room change.
= Notes:
»  User can check the room information by reading the card.

»  The maximum number of guests in the selected guest room must not be smaller than the
maximum number of guests in the original guest room.

»  Guests without a card are not allowed to change rooms on their own.
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JIf a guest without a card remains in the original room during a room change, the system will
ask whether to include that guest in the room change. If you choose No the room change
cannot proceed.

If the new guest room is reserved, the conflict information is displayed. You can choose
whether to proceed with the service.

The discount can be set for room change.

If the deposit required for the new guest room is greater than that of the original guest room,
the guest needs to make up the deposit. If the deposit required for the new guest room is
smaller than that of the original guest room. All the deposits are returned at check-out.

If the rate of the new guest room is greater than that of the original guest room, the guest
needs to make up the room cost. If the rate of the new guest room is smaller than that of the
original guest room, the overpaid amount is returned at check-out.

After the information is filled in for room change, click [OK], and the Registration or Issuing page appears,
as shown below.

Issued for Room Change % |
Room Mame”® Serengeti BuildingB-3Floord02
Room Type”® Standard room
Check-In Time* 2025-04-15 11:31:55
Check-0ut Time* 2025-04-16 12:00:00

Access Level(s)
Elevator Control
Mumber of Cards Issued:0 Number of Available Guests1

First Name ID Type ID Number Card No. Issuing Status

ppl 1D 456754 1326767139
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Click the drop-down list box to select an elevator/access control level. After the
parameter is specified, the room card can open not only the specified room, but also the devices
corresponding to the elevator/access control level.

#Note: You can click [Write Card] to automatically write cards for all room changes in circulation until
all room change cards are written.

Right-click a checked-in room icon and choose [Individual Management] > [Individual Check-Out]. A
new popup window, shown in the following figure appears.

Checl-Out x

Room Name Serengeti BuildingB-3Floor001
Building Name Serengeti BuildingE- Floor Name 3Floor
Room Type Standard room Guest Count 1
Days to Stay i Mumber of Days 1
Check-In Time 2025-04-15 11:29:42 Check-Cut Time 2025-04-15 11:34:39

First Name ID Type ID Mumber Card No. Issuing Status

ppl ID 456754 1326767139

Check whether the card to be cancelled if the guest card matches the current guest room,
cancel the card if it matches the guest room, and display the notification if it does not match.

#Note: When cards are cancelled one by one, the number of guests checked in is reduced. When there is
no cardholder, the Cancel Card button is unavailable.

Click [OK], and the Checkout settlement page appears, as shown below.
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Bill at Check-Out *®
Ivoice Preview | Guest Information |
ZK Hotel Test Booking mumber: 17446877994085074 Check-in Type: Daily Rent
Telephone: First Name: ppl First Name: ppl
L4 Check In'Time; 2025-04-15 11:29:42 Check-nTime:  2025-04-15 11:28:42
Website: Check-Ont Time: 2025-04-15 11:34:39 Cheibudime: G
Hotel Address: Cashier: admun g
Room Name Days/H days/h Unit Price Discount Subtotal | ROOM list]
Serengeti BuildingB-3F1 1.00 0.00 USD 150.00 0 USD150.00 | Serengeti BuildingB- USD 150.00
oor001( Daily Remt ) Alooe
Total Charge: USD 150.00 )
| Payment Information |
Subtotal: Daily rent => days*unit price*(100-discount)'100+extended rent (half of one day/day/N days) By hour= >hours*unit price*(100 -discount) 100
+extended rent* (hours*extended rent) Total Charge USD 150.00
Total Charge: USD 150.00 | Tax Rate (%): UsD 0.00
Tax Rate (32): USD 0.00 Other Charge Rate (%): USD 0.00
Other Charge Rate (3%): TSD 0.00 Payable Amount: USD 150.00
Total Amount(Including Tax): USD 150.00 Amount Paid: USD 250.00
""""""""""""""""""""""""""""""""""""""""""" Balance: USD 100.00
Thank vou for visiting!
P Detts o]

2. Team Management
®  Group check-in

1)

Right-click a checked-in room icon and choose [Team Management] > [Group Checl-Inl. A new
popup window, as shown in the following figure appears.

No Lock

Individual

Group Management= Group Check-In

001 (Standard room)

Foom Status

Public Room Public Room|
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Check-In Registration *x
Certificate Type” D - Building Name | ——— 4 Floor Name | ——-— - Morer Q B &€
ID Number® 456
First Name (for primary abe Room Name Room Type Floor Name Building Name Room Ca Number ¢...  Daily Rate Hourly Rate Depos .
contact)” : s
Serengeti BuildingB-3Floor001 Standard roo 3Floor Serengeti Buildini 2 1 150 100 100
Last Name
Group Name™ goup1 Serengeti BuildingB-3Floor002 Standard roo 3Floor Serengeti Buildim 2 1 150 100 100
Gender s -
E-mail Q
Home Address
Phone Number .- Q
4 3
Discount(¥) 12 50 rows per page Jump To 1 /1 Page  Total of 2 records
Guest Count™ ‘Z |
Days o Stay” 2 Room Name Room Type Floor Name Building Name Room Ca.. Number o... Daily Rate Hourly Rate Depos..
Check-In Time™ 2025-04-15 11:36:04
Check-Qut Time* 2025-04-17 12:00:00
List of Room Conflicts
Room Name Booking Time
4 3
No data 0 50 rows per page Jump To 1 /0 Page  Total of 0 records

Total Number of Rooms*
Total Charge®

0
0

Deposit Amount™ 0

Enter the mobile phone number used for the reservation and click Q to query for all

guest rooms reserved with the mobile phone number.

Allows you to enter the group check-in information.

Shows the reservation information of the current room. If the room has been reserved, the
reservation information is displayed in the list in Area Il. If the reservation conflicts with the check-in

time, check-in cannot be processed.

Displays the list of available guest rooms (and you can double-click a room to add it to 4).

Displays the reservation and the guest rooms selected in 3.

Shows the deposit amount and room cost for the group check-in.

zNotes:

If the stay period overlaps with the reservation period, the Check-In button is unavailable, and

check-in is not allowed.

If the number of check-in guests is greater than the maximum number of guests for all guest
rooms in total, the Check-In button is unavailable, and check-in is not allowed.

2) Click [Check-In], and the Write Card page for group check-in appears, as shown below.
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Register or Issue a Card ®

Room Name Serengeti BuildingB-3Floor001 Type Name™ Standard room
| Building Mame® Serengeti BuildingB- Floor Name IFloor E
| Check-In Time* 2025-04-15 11:36:04 Check-Out Time* 2025-04-17 12:00:00
Guest Count® 1 - Number of Beds™ 1
I Access Level(s) Elevator Control l_c
Card Information
{ Check in without card Cerfificate Type® |- - i
First Name® [ | ID Number*
[ LastName
Phone Number B - Q
E-mail ]
First Mame ID Type ID Number Card No.
4
L
Number of guests checked in to the room. The number must not exceed the room’s
maximum guest capacity. If this option is selected, only the guest information

is registered, and no card is issued for the guest.

If the access control or elevator control module exists, and the Elevator/Access
Control checkbox is selected in Hotel Settings, the option will be available, and you can assign access
control or elevator control level to a card. For details about hotel settings, see the section Hotel Settings.

#Note: You can click ! or [*]to navigate to the previous or next room.

Right-click a checked-in room icon and choose [Team Management] > [Group Overstay]. A new popup

window opens as shown in the following figure appears.
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. Group Management=

Room Status = Group Overstay

(Standard roo

Group Room Change

Group Check-Out

Group Overstay *®
First Mame (for primary contact) abc Phone Mumber
Group MName goup1 Guest Count 2
Total Count of Rooms |2 Total Number of Cards 2
Room Name Guest Count lssued Quantity Building Name Floor Name Room Type
Serengeli BuildingB-3Floor001 1 1 Serengeti Buildiny 3Floor Standard room
Serengeli BuildingB-3Floord02 1 1 Serengeti Buildini 3Floor Standard room
.. _____________________________________________________________________________] 4
1< < 1-2 3 50 rows per page —~ JumpTo 1 /1 Page  Total of 2 records
Overstay Days® 0 Days to Stay 2
Check-In Time 2025-04-15 11:36:04 Check-Out Time 12025-04-17 12:00:00
Discount(%) 0 Overstay Charge 0.0
[ cancel |

Page description:

1. Information about the rooms checked in by the group and the guest information.
2. List of reserved guest rooms.

3. Check-in information about the group.

#Notes:

»~  The overstay period cannot overlap with the reservation period; otherwise, the Overstay button

is unavailable.
»~ By default, the stay period is extended for the whole group.

»~  The overstay period is one day minimum. For a special condition, the overstay days can be set
to 0.

Click [Overstay], and the Write Card page for group overstay appears as shown below.
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Issued for Overstay x

Room Name Serengeti BuildingB-3Floor001 Type Name™ Standard room
Building Name”* Serengeti BuildingB- Floor Name 3Floor
Check-In Time* 2025-04-15 11:36:04 Check-Out Time* 2025-04-18 12:00:00
Guest Count” 1 Mumber of Beds® 1

First Mame 1D Type ID Number Card No. Status

1 1D 5675 1326767139

.. ] 1]

= Notes:
Re-write all cards issued to the group members for overstay.

When you click [Write Card], all cards are written for the rooms one by one in a cycle at an interval of 3
seconds.

The card issued during guest check-in is required for re-writing. In case any card is damaged or lost,
report of loss, and make-up must be carried out for the card before reissuance.

User can click L1 or =1 to switch to the previous or next room.

Right-click a checked-in room icon and choose [Team Management] > [Group Check-Out]. As shown in
the following figure, a new window pops up.
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Group Check-Out

Serengeti Buildiny 3Floor

Serengeti Buildiny 3Floor

Group Name goup1 First Name (for primary contact)
Guest Count 2 Total Number of Cards
Days to Stay Z Mumber of Days
Check-In Time 2025-04-15 11:26:04 Check-Out Time
Room Name Guest Count Issued Quantity Building Name
Serengeti BuildingB-3Floor001 0 0
Serengeti BuildingB-3Floord02 0 0

Floor Name

abc
0
0

2025-04-15 11:44:52

Room Type

Standard room

Standard room

..}
Jump To 1

1-2 50 rows per page ~ /1 Page

Total of 2 records

=z Notes:

User can choose to check out only some of the rooms for the group. By default, all rooms are

checked out for one group.

The cards for the selected room are cancelled.

User can check out a room before cancelling its cards (and cancel the cards after they are

collected).

Click [Check Out], the Checkout settlement pop window appears as shown below.

Print Group Check-Out Invoice

Subtotal: Daily rent = > days*unit price®(100-discount) 100--extended rent (half of one day/day/N days) By hour= =hours*unit price™{ 100 -d
1zcount)/ 100+extended rent*(hourz*extended rent)

Total Charge: USD 300.00
Tax Rate (%): USD 0.00
Other Charge Rate (%:): TSD 0.00
Total Amount(Including Tax): USD 300.00

Thank vou for visiting!
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Invoice Preview Guest Information
ZK Hotel Test Booking mumber: 17446883330040163 First Name (for primary
Telephone: First Name (for primary contact) abc contact):
Fax: Check-In Time: 511360 Group Name:
Website: Check-Out Time: -15 1152 Check-In Time:
Hotel Address: Cashier: Apaoperation succeeded! Check-Out Time:
Room Name Days/Hours Extended days‘hours Unit Price Discouni Subioial
Room list

Serengeti BuildingB-3 1.00 0.00 USD 150.00 1] USD 150.00
Floer001(Daily Rent) Serengeti BuildingB-
Serengeti BuildingB-3 1.00 000 USD 150.00 0 UsD15000 | 3Fleor001
Floer002(Daily Rent) Serengeti BuildingB-

Total Charge: USD 300.00 S

Payment Information

Total Charge
Tax Rate (%):

Other Charge Rate (%):

Payable Amount:
Amount Paid:

Balance:

goupi
2025-04-15 11:36:04
2025-04-15 11:44:52

USD 150.00

USD 150.00

USD 300.00
USD 0.00
UsD 0.00
USD 300.00
USD 500 00
USD 500.00
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User can view the issuance information of all module cards in the hotel, except for the record cards. The
content is displayed based on the card type (for example, guest cards and authorization cards). When a
record card is read, only the card type is provided.

User can clear all the card (IC) information. For a guest card, the system checks whether the card is the last
card of the room checked in by the guest. If it is, the card cannot be cancelled (as the system does not
support free-of-card check-in). For other types of cards, no verification is performed.

User can set a damaged or lost card to an invalid state. For details, see Report card loss in section
Maintenance Card.

User can re-issue a card for a registered guest or a guest who reports card loss and an additional card for
a checked-in room. If the number of guests checked in a room reaches the maximum, no additional card
is allowed.

Choose [Hotel Management] > [Reception Center] > [Reissue Card]. Select a room for card re-issuance
or locate the room by querying the certificate information (by clicking ©) on the Reissue Card page, as
shown below.

Reissue Card x M
Current Room Serengeti BuildingB-3Flon! Room Type Standard room
Check-In Time 2025-04-15 11:47:37 Check-Qut Time 2025-04-16 12:00:00
Mumber of Cards Issued 1 Maximum Number of Cards 1
Number of Guests 1 Maximum Number of Guesis 1
Access Level(s) Elevator Control
B
First Name 1D Type ID Number Card No
lojk 1D 5425 1326767139
Add Guest O
Certificate Type* First Name*
1D Number* Last Name
E-mail Q Phone Number .- Q

Displays the guest information and check-in information of the room.

Enables input of guest information for the card to be issued.
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Book Management

User can Add, query, edit, delete, and handle check-in for a reservation.

Choose [Hotel Management] > [Reception] > [Reservation] A new popup window, as shown in the

following figure, appears

Building Name

Please enter the search critenia

Check-in Typs* @Daily Rent (C)By Hour Building Name

Start time * |2025.0414 Serengeti Building
End time 2025-07-23

First Name™

Last Name

Cedificate Typpe* | -

1D Number*

Phone Number* M - 11
E-mail

Booking Method* Booking by receptio. ¥ Building Name
Booking Type® Ferson -

Company Name

Days to Stay * 100

Check-In Time* 2025.04-14 12:00:00

Check-Out Time* 2025-07-23 12:00:00
Total Number of Rooms* | g
Deposit Amount* ]

Total Charge* 0

Floor Name

3Floor

Floor Name

Reservation

Floor Name

Room Name

Serengeti BuildingB-3Floar001

50 rows per page Jump To 1
Room Name
50 rows per page - JumpTo 1

*|  RoomType | ——

Room Type  Type

Standard roon Room

/1 Page  Total of 1 records
Room Type  Type
i0 Page Total of 0 records

= | Room Name
Room Cap... Mumber of

2 1

Room Cap... Number of ...

QB ¢
Daily Rate  Hourly Rate  Deposit
150 100 100
Daily Rate  Hourly Rate  Deposit.

Fill in the information for the person checking in and select the room from below. Click Complete when

you are finished.

Choose [Hotel Management] > [Reservation List]. The interface shown in the following figure appears.

User can also enter the guest's name, mobile phone number, Email, Booking Number/Method, and
Reservation Status to query for a required reservation.

JZKBio CVSecurity i &
4B statistic 5 Electronic Hotel Lock / Hotel Management / Reservation List
Hotel Management - First Nams || | Mabile Number
Reception O Refresn @ Delete
Booking number First Name  Last Name
17446178874859197  Marris Morris
174460132053682688  morris morris
17416771358993388  Wes wes
17415622961362861  cydam cydam
«
T3 Card Management >
[ RoomManagement >
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E-mail

Mobile Number

17372062514

17372062514

13266677800

18237152735

More

E-mail Check-in Type
Daily Rent
Hourly

tandiae@zkieco.c Daily Rent

cydam xia@zklec Daily Rent

Q B

<

Booking Method  Booking Time

Booking by recep 2025-04-14 16:04:47

Baoking by recep 2025-04-14 11:25:40

Booking by Phon¢ 2025-03-11 15:12:15

Booking by recep 2025-03-10 15:38:16

Scheduled Check-in Time

2025-04-14 12:00:00

2025-04-14 12:00:00

2025-03-11 12:00:00

2025-03-10 12:00:00

O & 8 O amin -

Scheduled Check-out Ti

2025-07-23 12:00:00

2025-04-14 16:00:00

2025-03-12 12:00:00

2025-03-12 12:00:00

Reservatio

100

4

1

2
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Select the guest’s name of a reservation, slide right, and click [Edit] under Operations.

G Refresh

ng Method

ng by recep

ng by recep

ng by Phone

ng by recep

Booking Time

2025-04-

2025-04-

2025-03-

2025-03-

T Delete

14 16:04:47

14 11.28. 40

11 15:12:15

10 15:38:16

Scheduled Check-in Time

2025-04-14 12:00:00

2025-04-14 12:00:00

2025-03-11 12:00:00

2025-03-10 12:00:00

Scheduled Check-out Ti

2025-07-23 12:00:00

2025-04-14 16.00.00

2025-03-12 12:00:00

2025-03-12 12:00:00

Reservatio

100

P

2

Booking Type

Person

TA

TA

Person

Reservation Room Num
Serengeti BuildingB-3Floor Family Room
Serengeti BuildingB-3Floor Family Room
A2F003

Double Room

B2F001 B2F002

Reservation Type

Valid

Invalid

Invalid

Standard room Standa Checked-In

Reservation Status

Company Name

Operations

Other

5i5

The reservation page below will be displayed. User can change a room or modify the guest information

for the reservation. Modify the details accordingly and click [Save].

Please enter the search criteria

Check-in Type*

aily Rent By Hour

Start time * 5-04-14

End time * 20250723

First Name Morris

Last Name Morris

Ceriificate Type* D

1D Number* 518446

Phone Humber Bl - 17372062514
E-mail

Booking Method® Booking by receptio...
Booking Type* Person

Company Name

Days fo Stay * 100

Check-in Time
Check-Out Time*
Total Number of Rooms*
Deposit Amount*

Total Charge*

2025-04-14 12:00:00
2025-07-23 12:00:00
1

500

100500

Building Name | ——— -

Building Name

Floor Name

Serengeti Buildiny 3Floor

4 Building Name

50 rows per page

Floor Name

Serengeti Buildini 3Floor

50 rows per page

Floor Name  ——eeeme

Room Name

Serengeti BuildingB-3Floor001

Jum

Room Name

Serengeti BuildingB-3Floor002

Jum

Reservation

npTo 1

npTo 1

* |  RoomType |—— -
Room Type  Type Room Cap
Standard reon Room 2

/1 Page  Total of 1 records

Room Type  Type Room Cap

Family Room Room 8

/1 Page Total of 1 records

Room Mame

Humber of _

1

Humber of _

3

Daily Rate

150

Daily Rate

1000

Q B <
Hourly Rate  Deposit
100 100
Hourly Rate  Deposit...
100 500

Select the guest’s name for a reservation, click [Delete] under Operations or the delete button on the top

of the list to delete the reservation.

Select the guest’s name for a reservation and click [Check-In]

Check-In page appears.

G Refresh
ng Method
ng by recep
ng by recep
ng by Phone

ng by recep
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H Delete

Booking Time

2025-04-14 16:04:47

2025-04-14 11:25:40

2025-03-11 15:12:15

2025-03-10 15:38:16

Scheduled Check-in Time

2025-04-14 12:00:00

2025-04-14 12:00:00

2025-03-11 12:00:00

2025-03-10 12:00:00

Scheduled Check-out Ti...

2025-07-23 12:00:00

2025-04-14 15:00:00

2025-03-12 12:00:00

2025-03-12 12:00:00

Reservatio...

100

4

]

Booking Type

Person

A

A

Person

Reservation Room Num...  Reservation Type
Serengeti BuildingB-3Floor Family Room
Serengeti BuildingB-3Floar Family Room
A2ZF003

Double Room

B2F001 B2F002

Reservation Status

valid

Invalid

Invalid

Standard room Standa Checked-In

Company Name

Other

under Operations. The Individual

Operations

ChegkIn
Registration
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Room Mame*

Cerificate Type*

1D Number*
First Mame”
Last Hame
Gender

Home Address
Days to Stay™

Discount({3)

Deposit Amount®

Serengeti BuildingB-3Floorl. ..

D

(51846

Murris
Muorris

100

500.00

Check-In Registration

Phone Mumber

E-mail

Emergency Contact Phone

Check-in Type®

Guest Count”

Check-In Time*

Check-Out Time*

Daily Rate”

Payable Amount*

- 17372062514

@Daily Rent (")By Hour

1

2025-04-14 16:08:09
2025-07-23 12:00:00
1000.00

100500 00

r—-: -~

The system automatically loads the reservation information of the room. Modify and complete the guest

information and click [Check-In]. The Registration or Issuing page appears as shown below.

Room Name
Room Type

CheckeIn Time:

Check-Out Time*

Check in without card
Ceriificate Type®

1D Number

First Name*

Last Mame

Phone Number

E-mail

Access Levells)

Elevator Control

Humber of Cards Issued: 0

First Name

Register or Issus a Card

Serengeli BuildingB-3Floor002
Family Room
2025-04-14 16:03:09

2025-07-23 12:00:00

D
513445
Mortis
Mortis

B - 17372082514

Number of Available Guests: 1

1D Number

Gard No.

Place the guest card on the card writer and click [Write Card] and Complete to complete check-in.

zSNotes:

User cannot process check-in for an expired reservation. Check-in can only be processed on-site.

For details, see Individual check-in in section Reception Center.

The guest can check in before the reserved time.

Report Management

Guest Check-In Report

To view the guest check-in details report, enter the search conditions and view the records. User can

T Exporl

export

Page| 125

the records into an Excel, PDF, or CSV format.
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Electronic Holel Lock / Report Management / Guest Check-in Report

Booking number | | mobile Number First Name Morer Q B &

O Refresh T Export

Status Booking number  Check-in T Room Type Room Name First Name Last Name Card No Check-In Time Check-Out Time Country code  Mobile Nu 1D Type 1D Numb
Invalid 17428876179996: Daily Rent Standard room Victeria Buildin Wes Tan 2129236202 2025-03-25 15:24:47  2025-03-25 15:28.01 254 743222864 1] 34023
Invalid 17416771358993! Daily Rent Family Room  Serengeli Buil Wes Tan 1105281278 2025-03-21 15:12:42  2025-03-21 15:13:27 254 745222884 1D 34023
Invalid 17416771358993! Daily Rent Standard room Victeria Buildin Wes Wes 2732720919 2025-03-21 15:12:26  2025-03-21 15:13.07 86 13266677800 1D 34023
Invalid 174168771358993! Daily Rent Standard room Victoria Buildin Wes Wes 2732720919 2025-03-21 15.08:34  2025-03-21 15.08.58 &6 13266677800 ID 34023
Invalid 17425408748485! Daily Rent Family Room  Serengeli Buil Wes Tan 2732720919 2025-03-21 15.07:46  2025-03-21 15:08:21 254 748222664 1] 34023
Invalid 17425407858019° Daily Rent Standard room Victoria Buildin Wes Wes 1105281278 2025-03-21 15.05:59  2025-03-21 15.06.34 &6 13266677800 1D 34023
Invalid 17425407858019° Daily Rent Standard room Victeria Buildin Wes Wes 1105281278 2025-03-21 15.05:59  2025-03-21 15.06:34 &6 13266677800 1D 34023
Invalid 17425386525674! Daily Rent Family Room  Serengeli Buil Wes Tan 2780027182 2025-03-21 14.29:45  2025-03-21 14:49:31 254 745222884 1D 34023
Invalid 17425386525674! Daily Rent Standard room Victeria Buildin Wes Wes 565273516 2025-03-21 14:29:45  2025-03-21 14:49:31 86 13266677800 1D 34023
Invalid 17425370741152{ Daily Rent Family Room  Serengeli Buil Wes Wes 565273516 2025-03-21 14.03.53  2025-03-21 14:29.24 &6 13266677800 ID 34023
Invalid 17423793257272° Daily Rent Double Room  Serengeli Buil Wes Tan 2780027182 2025-03-19 18:14:44  2025-03-19 18:25:42 254 743222864 1D 34023
Invalid 17423793257272° Daily Rent Family Room  Serengeli Buil Wes Wes 5652735186 2025-03-19 18:14.44  2025-03-19 18:25:42 &6 13266677800 ID 34023
Invalid 17416771358993! Daily Rent Standard room Serengeli Buil Wes Tan 2732720919 2025-03-17 18:42:35  2025-03-21 15:04.27 254 743222864 1D 34023

User can export the records to an Excel, PDF, or CSV file.

Room Occupancy Report

To check the room occupancy information (including the room name, type, check-in type, check-in time,

. . . T Exporl
and check-out time), enter the search conditions and view the records. User can export z the

records into an Excel, PDF, or CSV file.

Electronic Hotel Lock / Report Management / Room Occupancy Report

Buiding Name ———— v Floor Name | ——— - Room Name | ———— | Mmoer Q B €

G Refresh T Export
Status Check-in Type Room Type Room Name Building Name Floor Name First Name  Last Name  Gheck-In Time Check-Out Time
Invalid Daily Rent Standard room Victoria BuildingA-2Flc Victoria BuildingA-  2Floor wes Tan 2025-03-25 15:24.47 2025-03-25 15:28:0"
Invalid Daily Rent Family Room Serengeti BuildingB-31 Serengeti BuildingB-  3Floor Wes Tan 2025-03-21 15:12:42 2025-03-21 15:13:2i
Invalid Daily Rent Standard reom Victoria BuildingA-2Fls Victoria BuildingA-  2Floor Wes Wes 2025-03-21 15:12:26 2025-03-21 15:13:03
Invalid Daily Rent Standard room Victoria BuildingA-2Flc Victoria BuildingA-  2Floor wes Wes 2025-03-21 15:08:34 2025-03-21 15.08:5¢
Invalid Daily Rent Family Room Serengeti BuildingB-31 Serengeti BuildingB-  3Floor wes Tan 2025-03-21 15:07:46 2025-03-21 15:08:2"
Invalid Daily Rent Standard reom Victoria BuildingA-2Fl¢ Victoria BuildingA-  2Floor wes Wes 2025-03-21 15:05:59 2025-03-21 15:06:3¢
Invalid Daily Rent Standard room Victoria BuildingA-2Fle Victoria BuildingA-  2Floor Wes Wes 2025-03-21 15.05.59 2025-03-21 15.06:3¢
Invalid Daily Rent Family Room Serengeti BuildingB-31 Serengeti BuildingB-  3Floor Wes Tan 2025-03-21 14:29:45 2025-03-21 14:49:3°
Invalid Daily Rent Standard reom Victoria BuildingA-2Fls Victoria BuildingA-  2Floor Wes Wes 2025-03-21 14:29:45 2025-03-21 14:49:3
Invalid Daily Rent Family Room Serengeti BuildingB-31 Serengeti BuildingB-  3Floor wes Wes 2025-03-21 140353 2025-03-21 14.29:2¢
Invalid Daily Rent Double Room Serengeti BuildingB-31 Serengeti BuildingB-  3Floor wes Tan 2025-03-19 18:14:44 2025-03-19 18:25:4:
Invalid Daily Rent Family Room Serengeli BuildingB-31 Serengeti BuildingB-  3Floor wes Wes 2025-03-19 18:14:44 2025-03-19 18:25:4%
Invalid Daily Rent Standard room Serengeti BuildingB-31 Serengeti BuildingB-  3Floor Wes Tan 2025-03-17 18.42.35 2025-03-21 15.04:23
Invalid Daily Rent Standard room Victoria BuildingA-2Fl¢ Victoria BuildingA-  2Floor wes Wes 2025-03-17 18:36:07 2025-03-17 18:37:2¢ =

1-25 50 rows per page Jump To 1 1 Page Total of 25 records

User can export the records into an Excel, PDF, or CSV file.

Room Charge Report

To check the room expenses record, enter the search conditions (including time, guest name, room name,
and room type) and view the records.
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Electronic Hotel Lock / Report Management / Room Charges Report

Time From [2025-01-14 00:00:00 | To | 2025-04-14 23:58:59 First Name more- Q B &

O Refresh T Export T Re-print Invoice

Boaking number Check-in Type  Room Type Room Name First Name Last Name Check-In Time  Check-Out Time  Stay Time
17428876178996821 Daily Rent Standard room  Victoria BuildingA Wes Tan 2025-03-25 15:24 2025-03-25 15:28 1
17416771356993388 Daily Rent Standard room  Serengeti Building Wes Tan 2025-03-21 15:12 2025-03-21 15:13 1
17418771358993383 Daily Rent Standard room  Victoria BuildingA Wes Wes 2025-03-21 15:12 2025-03-21 15:13 1
17416771358993388 Daily Rent Standard room  Vicloria BuildingA Wes Wes 2025-03-21 15.08 2025-03-21 15:08 1
17425408748485659 Daily Rent Standard room  Serengeli Buildini Wes Tan 2025-03-21 15:07 2025-03-21 15:08 1
17425407658019777 Daily Rent Standard room Victoria BuildingA Wes Wes 2025-03-21 15:05 2025-03-21 15:06 1
17416771358993388 Daily Rent Standard room Serengeti Buildimi Wes Tan 2025-03-17 18:42 2025-03-21 1504 5
17416771358993388 Daily Rent Standard room  Victoria BuildingA Wes Wes 2025-03-17 18:15 2025-03-21 14:54 5
17425386525674579 Daily Rent Standard room  Victoria Building Wes Wes 2025-03-21 14:29 2025-03-21 14:49 1
17425386525674579 Daily Rent Standard room  Serengeti Building Wes Wes 2025-03-21 14:29 2025-03-21 14:49 1
17425370741152862 Daily Rent Standard room  Serengeli Buildiny Wes Wes 2025-03-21 14:03 2025-03-21 14:29 1
17422056973856216 Daily Rent Doutle Room Victoria Buildingd Wes Tan 2025-03-17 18:01 2025-03-21 14:15 5
17423793257272746 Daily Rent Standard room B2F002 Wes Tan 2025-03-19 1814 2025-03-19 1825 1
17423793257272746 Daily Rent Double Room B2F003 Wes Tan 2025-03-19 18:14 2025-03-18 16:25 1 -
1-24 50 rows per page JumpTo 1 /1 Page  Total of 24 records

Issue card Report

User can also view all card writing records or search for required card writing records with multiple search
conditions. Enter the search conditions (including time, card type, card No., issuing date, and expiration
date) and check the associated card writing records.

Electronic Hotel Lock / Report Management / Issued Card Report

Issued Date | 2025-01-1400:00.00 | To | 20250414 23:59:59 Moe- Q B &

O Refresh T Export B3 Report Card Loss

Card Status  Card Type Room Hame card No Physical Card Num... Name Last Name 1D Type 1D Number Card Issued Dale Card Expiraic
Invalid Master Card 125 2780027182 Kaia 2025-04-11 16:51:57 2025-04-1"
Invalid Emergency Card 124 2780027182 Kaia 2025-04-11 16:51:03 2025-04-1°
Invalid Authorization Car 123 2780027182 Wes Tan 1D 340238 2025-04-11 16:50:01 2025-04-1"
Invalid Authorization Gar 122 2780027182 Harper 2025-04-11 16:48:00 2025-04-1°
g Invalid Emergency Card 121 2780027182 aaaa 2025-04-11 14:52:40 2025-04-1"
Invalid Emergency Card 120 2780027182 lambert 2025-04-11 14:52:15 2025-04-1
Invalid Time Card 119 2780027182 Alvin 2025-04-11 14:50:15 2025-04-1"
Invalid Authorization Car 118 2730027182 Iris 2025-04-11 14:49:26 2025-04-1°
Invalid Master Card 17 2780027182 eletest 2025-04-11 14:12:37 2025-04-1"
Invalid Room Card 116 2730027182 Alvin 2025-04-11 14:11:11 2025-04-1¢
Invalid Time Card 115 2780027182 2025-04-11 14:10:30 2025-04-1°
Invalid Authorization Gar 114 2780027182 2025-04-11 14:10:03 2025-04-1°
Invalid Room Area Card 13 1911881523 2025-04-10 15:58:14 2025-04-11
; -
1-50 > 31 50 rows per page Jump To 1 /3Page  Total of 125 records

T Exporl . .
User can export the records into an Excel, PDF, or CSV file.

Unlock Record Report

User can read a record card to check the lock opening record. Place the record card on a card writer and
click [Read Lock Opening Record] to obtain all lock opening records of the record card. User can enter
search conditions (including the building/floor/room name, start time, and end time) and view the

Page | 127 Copyright © 2025 ZKTECO CO., LTD. Allrights reserved.



ZKBio CVSecurity Smart Lock

User Manual

associated records. You can export the records to an Excel, PDF, or CSV file.

Electronic Hotel Lock / Report Management / Unlock Log Report

Building Name | ————

5 Refresh T Export

Building Name

Victoria BuildingA-
Victoria BulldingA-
Victoria BuildingA-
Victoria BuildingA-
Victoria BuildingA-
Victoria BuildingA-
Victoria BulldingA-
Victoria BuildingA-
Victoria BulldingA-
Victoria BuildingA-
Victoria BuildingA-
Victoria BuildingA-
Victoria BuildingA-

Victoria BuildingA-
1-50 > 4]

User can export

Page | 128

»: Floor Name:

&l Read Unlock Record

Floor Name

2Floor

2Floor

2Floor

2Floor

2Floor

2Floor

2Floor

2Floor

2Floor

2Floor

2Floor

2Floor

2Floor

2Floor

50 rows per page

T Exporl

Jump To

1

- Room Name  ———

Room Name

Victeria BuildingA-2Floor002

Vicleria BuildingA-2Floor002

Victeria BuildingA-2Floor002

Vicloria BuildingA-2Floor003

Victoria BuildingA-2Floor003

Victoria BuildingA-2F1ooro03

Victoria BuildingA-2Floor003

Victoria BuildingA-2Floor003

Victeria BuildingA-2Floor003

Vicloria BuildingA-2Floor Supe

Vicloria BuildingA-2Floor Supe

Victoria BuildingA-2Floor Supe

Victoria BuildingA-2Floor Supe

victoria BuildingA-2Floor Supe

/2 Page  Total of 7 records

e More =

Unlock Mode

Swipe to unlock

Swipe to unlock

Swipe to unlock

Swipe fo unlock

Swipe o unlock

Swipe to unlock

Swips to unlock

Swips to unlock

Swipe to unlock

Swipe to unlock

Swipe to unlock

Swipe fo unlock

Swipe o unlock

Swipe to unlock

Q B €

Unlock Time

2025-03-17 18:16:00
2025-03-17 15.15:00
2025-03-10 18:12:00
2025-03-17 18.01:00
2025-03-17 18:01:00
2025-03-10 19:54:00
2025-03-10 19:54:00
2025-03-10 19:54:00
2025-03-10 19:53:00
2025-03-10 16.42:00
2025-03-10 16.42:00
2025-03-10 16.41:00
2025-03-10 16:42:00

2025-03-10 16:42:00

the records to an Excel, PDF, or CSV file.

Card Type

Guest Card

Guest Card

Guest Card

Guest Card

Guest Card

Emergency Card

Guest Card

Guest Card

Guest Card

Floor Card

Guest Card

Guest Card

Guest Card

Floor Card

First Name

Wes

Wes

Kaia

Wes

LEVIN

LEVIN

LEVIN

1D Type

1D

Passport

Passport

Passport

Passport

Passport

1D Num

340236

340238

123

340237

340237

123

8888888

1000111

1000111

1000111

8888886
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Wireless Apartment Lock Module

Device Management

Interface Description of the Device List

Device management is the page used to manage the Gateway and the apartment lock.

The following sections describe the process of adding the Gateway and the apartment

lock.

(D) Instructions

As shown in Figure 3.1-1, this interface is divided into a list of Gateway devices on the left (Gateway)
and a list of lock devices on the right (Lock List of the Gateway).

The display area can be resized by dragging the center divider.

' ZKBio CVSecurity i &

< Browse Gateway: (CA3894C1A3BE) Lock List of the Gateway

ode @ MCU OTA Upgrad,

Gatews

SLO3-TA20H  1.1.20 2024-07-04 1

ooooo

C49804C1AIBE  C49894C1AIBE
E=xEuE C49894C1AD96 se 2024-07-04 03:42:00 online 2 C49894FFFECE6829  Add Room C49894C1A3BE 90% SLO3-TA20H  1.1.20 2024-07-04 1

C49894FFFECE682E  Add Room C49894C1A3BE offiine. 80% SLO3-TA20H  1.1.20 2024-07-04 1

aaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa

Figure 3.1-1

Gateway Add

MQTT Configuration
Procedure
Step 1: Service Installation

Save the mosquitto-2.0.15-install-windows-x64.exe file to any local directory, then open and
install it. Proceed with the default installation path by clicking 'Next', as shown in Figure 3.1.2.1-

1.
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i

mosquitto-2.0.15-install-windows-x64.exe

& Eclipse Mosquitto Setup = b4
(5 Eclipse Mosquitto Setup - x hoose Components -
. . (Choose which features of Ecipse Mosauitto you want to install s
w to Eclipse quitio
Setup

Check the components you want to install and uncheck the components you don't want to

Setup will guide you through the installation o Eclipse instal. Click Next to continue.

Mosquitto.

Itis recommended that you dose all other applications o Description
before starting Setup, This wil make it possible 2 update Fed et o b o
relevant system files without having to reboat your Visual Studio Runtime

computer, Service

Click Next to continue,

Space required: 19.4MB

ﬁ

N\

Cancel
Cancel

Figure 3.1.2.1-1

Try to use the default installation path: C:\Program Files\mosquitto. Note that this may

involve changes to the username and password.
Replace the file.

Go to the C:\Program Files\mosquitto directory and replace the following two files.

If the installation is not in the default path, please go to the corresponding installation

directory to replace it.

B |

mosquitto.conf  pwfile.example

Step 3: Restart the service.

1. Task Manager -> Services -> mosquitto right-click to restart, as shown in Figure 3.1.2.1-2.

- =
e
PID 7y
LepSue netsye
MagsBroker Bownloaded Maps Manager N
MepManagementSeniice McpManagementSenice Mcph
MescagingSenice MescagingSenice Unista
MessagingSendce 1c6d61 MessagingSarice. 1c5d61 Unista
MicrosohEdgeElevationService Micrasoft Edge Elevation Senice...
MisedRealityOpenXRSu: Windews Mised Reality OpeniR . Lacals
= T i Bkt i
MozilaMairtenance A h Maintenance Senvice
mpssie 5l povs Disferder Firawall Lacals
MSDTC a Juted Transaction Caardina..
MsDteServer 100 ) Brver integration Services
MSiSEs) = BBt iSCSH Indtiator Sendce netsve
maiserver o s Instalier
MeKeyboardFiter ~mwerosof st
MSSOLD Launcher 6808 SQL Full-teat Fikter Daeman Laun.
MSSOLSERVER 3324 SOL Server (MSSQLSERVER]
MSSOLServesADHelper o0 0L Active Diracary Helper
MSSOLServerOLAPService 3348 $QL Server Analysis Services (MS..
Matsiral Sisthentication netaur ¥
H 3
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Figure 3.1.2.1-2
2. Enable firewall in-stack port 1883.

Additional Notes:

Change password method (default admin ZKTecoApartment258! @#edc) _

c¢md into the installation directory

mosquitto_passwd -c . /pwfile.example Username

-c means clear other users, no means add users

twareymosqui ttodmosquitta_passwd -c

Lipwfile. example admin

MQTT passwords, Gateway settings, and apartment lock settings must be consistent. If any MQTT-

related password is modified, ensure that all three are updated accordingly to avoid functionality
issues.

Gateway Backend Configuration

Refer to the section [Device Management] > [Device] > [How to Add Gateway] to add

the corresponding content of the document after the function jump. See Figure 3.1.2.2-1.

ZKBio CVSecurity i &

05 8 O amn -
DeviceManagement  «  Wireless Apartment lock / Device Management / Device

Gateway

< Browse Gateway: (XMHZFTest) Lock List of the >
Gateway Hame

Gateway MAC Address Q B < Lock Name Lock MAG Adcress
GRefresh  Q Search @ Delete =¥ Enable Pairing Mode  ® Disable Pairing Mode | & How to a

G Refresh & Unlocking Records
Gateway Name  Gateway MAC Address  Pairing Sta

Last Sync Time

Lock Name  Lock MAG Address
XM12F-Test ©49894C1AD20

2025-04-16 09.23:55 Online ©00:V1.7.6 wir 0 2 & C49894FFFEC C49894FFFECE6G1E  Fashion /
3F-Test G49894G1AD96 2025.04-08 03:42:00 Offline V1.7.6 wir 16 2 &
¢ Room Management >
7 Basic Management > »
[El ReportManagement > perpeg ¥ ? »
Fi
igure 3.1.2.2-1

Server-Side Software Configuration

Refer to Part lll of this chapter, Basic Setup MQTT Configuration.
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Search Add Gateway

In [Wireless Apartment Lock] > [Device Management] > [Device], click Search, find the

Gateway information, and then click Add to finish adding the Gateway, as shown in Figure

3.1.2.4-1.
New x
Searched devices count 3
Tokat Frogress 100% Number of devices added:2
Gateway MAC Address

Gateway MAC Address Operations

000C43E1762A This device has been added

A0A3B96335CE Add

C49894C1ADI6 This device has been added

Figure 3.1.2.4-1

Gateway Related Functions

Query Gateway

User can query and maintain the added Gateway devices by Gateway name (Gateway Name) or

Gateway MAC address (Gateway MAC Address), as shown in Figure 3.1.3.1-1.

Wireless Apartment lock / Device Management / Device

Gateway
Gateway Mame Gateway MAC Address G| (B [l
Figure 3.1.3.1-1
Refresh

There may be a delay after the device is operated. User can refresh the list by clicking the

3} Refresh

Refresh button.
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Delete
To remove added Gateway devices, select the checkbox next to the device and click the delete

) i Delete
icon.

If a door lock device is linked to the current Gateway, the Gateway cannot be deleted. User must
delete the door lock first before deleting the Gateway.

Enable Pairing Mode
If the Gateway has been added for some time and you need to add a lock device again, you must

enable the distribution network. Select the Gateway to be enabled, click =* Enable Pairing Mode

button, and the distribution network status will display 'Open’ once it is activated, as shown in
Figure 3.1.3.4-1.

Gateway Name Gateway MAC Address  Pairing Status Last Sync Time

Gateway St.. Firmware V. No. of Failed Com... Operations
000C43E1762A 0DDC43E1762A Open 2024-07-05 15:14:12 Online coo'V1.7.6 wir 0 z &
AEIE C49894C1AD96 2024-07-05 15:14:49 Online coo V176 wir O z &8

Figure 3.1.3.4-1

Disable Pairing Mode

When multiple Gateways need to add lock devices simultaneously, irrelevant Gateways must be

disabled to prevent locks from being added to unnecessary Gateways. To do so, select the

Gateways to be disabled, click the 2k Disahle: Faling fode , and once the distribution network

is disabled, the status will display Close, as shown in Figure 3.1.3.5-1.

Gateway Name Gateway MAC Address Pairing Status Last Sync Time Gateway St. Firmware V. No. of Failed Com Operations

000C43E1762A  0D00C43E1762A Close 2024-07-05 15:14:12 Online coo:V1.7.6 wir 0 Z &

o €49894C1AD96 Close 2024-07-05 15:14:49 Online c00V1.7.6 wir 0 v

i®

Figure 3.1.3.5-1

How to add a Gateway?

This feature displays a document that outlines how to configure MQTT and other related
parameters in the Gateway backend upon logging into the Gateway backend.

OTA Gateway Bulk Upgrade (OTA Upgrade)

If the current Gateway needs all Gateways to perform firmware upgrade operation, click, set the

time and upgrade file, and then wait for the OTA upgrade of all Gateways to begin at the
specified time, as shown in Figure 3.1.3.7-1.
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OTA Upgrade %

Select File Not Uploaded

Cancel

Figure 3.1.3.7-1

For OTA Gateway batch upgrades, Zigbee OTA batch upgrades, and MCU OTA batch upgrades, the
setup time must be at least one day apart to avoid conflicts in upgrade schedules, which could
result in upgrade failure.

The upgrade that has already been set up can be modified again or this batch upgrade can be
cancelled before it starts, as shown in Figure 3.1.3.7-2.

OTA Upgrade - Cancelled

Select File gateway.tgz

Start Time | 2024-07-21 16:24:00

Figure 3.1.3.7-2

Edit
User can enter the Edit interface by clicking either Gateway Name or the Operation column &

button, as shown in Figure 3.1.3.8-1.

Edit *
Gateway Name* Egg\%ﬂg%ﬁ
Gateway MAC Address™ 00DC43E1762A
Cancel

Figure 3.1.3.8-1
Failed Command Records

If a device fails to execute commands, the system will retry after the device recovers. When you

No. of Failed Commands

need to check the failed commands issued, click the : number to pop up the

details page of the failed commands, as shown in Figure 3.1.3.9-1.
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Failed Command Records >

 Refresh  Please check the netwerk and power supply.

Command MAC CMD CMD Item Operate us Cperation Time

Gateway C49594C1ADY Sync Gateway - 2025-04-16 03:42:00
Gateway C49894C1ADS Sync Gateway - 2025-04-16 03:11:00
Gateway C49894C1ADS Sync Gateway - 2025-04-15 03:42:00
Gateway C49894C1ADY Sync Gateway - 2025-04-15 03:11:00
Gateway C49894C1ADS Sync Gateway - 2025-04-14 03:42:00
Gateway C48894C1ADS Sync Gateway - 2025-04-14 03:11:00
Gateway C49594C1ADY Sync Gateway - 2025-04-13 03:42:00
Gateway C49894C1ADS Sync Gateway - 2025-04-13 03:11:00
Gateway C49894C1ADS Sync Gateway - 2025-04-12 03:42:00
Gateway C49894C1ADY Sync Gateway - 2025-04-12 03:11:00
Gateway C49894C1ADS Sync Gateway - 2025-04-11 03:42:00

.
Figure 3.1.3.9-1

Adding a Lock

After the Gateway is successfully added, turn on the Gateway distribution network, make sure
the signal of the lock device is within the effective range of the Gateway, click the lock device +/
confirmation button 5 times, wait for the voice prompt to announce "Complete", and then
refresh the software terminal to view the added lock device.

Sync Time

. . .. @ sync Time
When the Gateway time does not match the server time, you can click Y

synchronize the device time to the Gateway again.

Lock Related Function

Query Lock Device

User can query and maintain the added lock devices by Lock Name or Lock MAC Address, as

shown in Figure 3.1.4.1-1.
Browse Gateway: (000C43E1762A) Lock List of the Gateway

Lock Mame Lock MAC Address Q <

Figure 3.1.4.1-1
Refresh

There may be a delay after the device is operated. You can refresh the list by clicking the

7 Refresh
Refresh = "o " pytton.
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View Unlocking Records Details (Unlocking Records)

Select any lock device and click & Unlocking Records ¢4 yiew all the door opening records of

that lock, as shown in Figure 3.1.4.3-1.

Unlocking Records x
O Refresh
Verification Mode Operate user name User Role Operation Time
Remote Unlock 5 Administrator 2024-07-03 16:29:51  ~
Remote Unlock & Administrator 2024-07-03 16:29:11
Remote Unlock o Administrator 2024-07-03 16:29.09
Remote Unlock 5 Administrator 2024-07-03 14:51.22
Remote Unlock o Administrator 2024-07-03 14:45:30
Remote Unlock 5 Administrator 2024-07-03 14:40:33
Uniocked by passcode - Administrator 2024-07-03 14:38:52
Unlocked by passcode - Administrator 2024-07-03 14:19:19
Remote Unlock = Administrator 2024-07-03 14:02:19
Remote Unlock o Administrator 2024-07-03 13:40:14
Remote Unlock = Administrator 2024-07-03 13:49:13
1-34 50 rows per page Jump To 1 i1 Page
Figure 3.1.4.3-1
Delete Lock

Select one or more lock devices, click the W Delete Lock  and the selected devices can be
deleted after a second confirmation, as shown in Figure 3.1.4.4-1.

1% Prompt 2C
1% Are you want to perform the Delete Lock 20

operation?

Cancel

Figure 3.1.4.4-1

Remote Unlock

Select any lock and click B Remote Unlock (5 open the door remotely, but you cannot open
the door remotely if the room is occupied, as shown in Figure 3.1.4.5-1.
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-~

‘Operation failed; a user has already been added to this
room.

Figure 3.1.4.5-1

Generate Dynamic Passcode

Select any lock and click & Generate Dynamic Passcode to open the door remotely, but you

cannot open the door remotely if the room is occupied, as shown in Figure 3.1.4.6-1.

-

‘Operation failed; a user has already been added to this
room.

Figure 3.1.4.6-1

MCU OTA Bulk Upgrade (MCU OTA Upgrade)

If the current Gateway needs all locks to perform firmware upgrade operation,

click & MCU OTA Upgrade et the time and upgrade file and then you can wait for the MCU OTA
upgrade of all locks when the time comes, as shown in Figure 3.1.4.7-1.

OTA Upgrade x

SelectFile oW Mot Uploaded

Start Time
Cancel
Figure 3.1.4.7-1

OTA Gateway batch upgrade, Zigbee OTA batch upgrade, MCU OTA batch upgrade setup time
needs to be 1 day interval to avoid upgrade time conflict, causing upgrade failure.

The upgrade that has been set up can be modified again or cancelled for this batch upgrade
before it starts, as shown in Figure 3.1.4.7-2.
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OTA Upgrade - Mot Started . OTA Upgrade - Mot Started

Y
&

Select File - gateway.tgz Sele - Select File | gateway.tgz

The operation succeeded!
Start Time 2024-07-31 16:24:00 Star Start Time 2024-07-31 16:24:00
Cancel Upgrade S10S¢ / Cancel Upgrade

OTA Upgrade - Cancelled

Select File gateway.tgz

Start Time 2024-07-31 16:24:00

Figure 3.1.4.7-2

Unbind Room
When you need to unbind a room from a lock, you can unbind the lock from the room by
clicking & Unbind Reom | \hich will clear all information in the lock synchronously.

Downstream Get Unlocking Records (Sync Unlocking Records)
When you need to get the unlock record of a lock device, you can send a request to the lock by
clicking B Sync Unlacking Records ¢ get the unlock record of the lock.

Send All Users
When there is a situation such as incomplete staffing down, you can redistribute the full amount
of staffing information for that lock to the lock by clicking & Send All Users

Setting Normally Open (Enable Passage Mode)

When a room needs to be set to normally open, you can enable the normally open status by
clicking the & Enable Passage Mode pytton, but you cannot open the door remotely if the room

is occupied, as shown in Figure 3.1.4.11-1.

~\

2

‘Operation failed; a user has already been added to this
room.

Figure 3.1.4.11-1

If the room is normally open, any code will open the door.
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Disable Passage Mode

When a room needs to be deactivated from being normally open, you can turn off the room's

normally open status by clicking & Disable Passage Mode

A Cancel Normally Open command is issued when the lock binds the room.

Editing and Binding

Once the lock has been added, we need to bind the apartment lock to the specified room, which

T &
can be done by clicking Edit (e ] on the Lock page, as shown in Figure 3.1.4.13-1.

Edit X
Lock Name* |c49894FFFECS681E
Lock MAC Address® C49394FFFECS631E
Room Mame Fashion Apariment1F001
Cancel

Figure 3.1.4.13-1

Click [Room Name] to enter the room assignment screen as shown in Figure 3.1.4.13-2.

Seiect Room Name x
Room Name QB ¢

Alternative Selected(1)

Room Name Room Name

Fashion Apariment1F002
Fashion Apartment1F003
Fashion Apartment1F004

Fashion Apar

5

ent1F005
Fashion Apartment1F007
No data
Fashion Apariment1F008
Fashion Apartment1F009
Fashinn Anartment1FON10
1-8 50 rows per page

Cancel

Figure 3.1.4.13-2

Move the room on the left side to the right side and click OK to complete the room binding.

User can refer to Chapter 2, Tenant Move-In Procedure to move in after binding.
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3.2 Room Management

3.2.1 Real-Time Room Monitoring

3.2.1.17 Interface Description for Real-Time Room Monitoring

Room management page, you can display the room information on the page for room status
query and modification, individual check-in or group check-in and room change and check-out

operations, and at the same time, user can make a reservation for the room, as shown in Figure

3.2.1.1-1.

'(‘JZKBio CVSecurity © @ s

B SmanLeo
o Buiing Room No.:

T
1_Fiooct
= = Cleaning NaLock Lock Name:
= oo
& I _
‘ r

Figure 3.2.1.1-1

3.2.1.2 Room Status
L Functional Description

The Guest Room Status action button, which appears when right-clicking on the Guest Room

icon, provides several actionable options, as shown in Figure 3.2.1.2-1.

Cleaning Maintaining

Room Status =

Needs Cleaning

Maintain

Maintain S

Stop Use

Figure 3.2.1.2-1
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Public Room
e

yihaolou1F100

After Tenant Check-In-------- >After Tenant Check-Out

LB yihaolou1F100

W To be cleaned -------- >Cleaning completed g
Maintaining

yihaolou1F104

3.2.1.3 Room Status Rollover

L Functional Description

yihaolou1F102

yihaolou1F104

Not In Use

yihaolou1F104

yihaolou1F104

Suspension of use -------- >Resumption of use

Note: When the auto-flip feature is enabled, a room in 'Dirty' status will automatically

change to 'Empty’ status at the scheduled time.

3.2.1.4 Room Availability

L Functional Description

¢ When the room is in the state of "\==e @, or "", the tenant

cannot check in.

¢ When the number of people occupying a room exceeds the room's capacity, the tenant
may not check in.

Note: The Housekeeper and Administrator roles do not count toward the total number of

occupants.
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3.2.1.5 Room Information
L Functional Description

* In the guest room list, on the right side of the room page, the current room information is
displayed after any room is selected, and the header contains the room number (Room No.),
status (Status), and lock name (Lock Name), and the tabs are check-in information (Tenant),

and room information (Room), as shown in Figure 3.2.1.5-1.

Room No.:111 Room No.:111
Status:Occupied Status:Occupied
Lock Hamcy ! : Lock Name: |-
Room
Tenant
First Name: Reason
Last Name: Noles:
Phone Number: 12345612345 ;
E-mail: J@zkteco.com Device:
Card No.: Room Type: 1
User Role: Tenant Room Size: 1

Freeze:
Start Time: Wed Jul 03 19:04:54 CST 2024
End Time: Thu Jan 01 00:00:00 CST 2099

Number of Beds: 1
Maximum Number of Guesis: 1

Figure 3.2.1.5-1

¢ When a room in the list is selected, the room information column will be automatically
updated with the corresponding details.

¢ Only the tenant information is displayed in the occupancy details.

e The Room Information section displays the details configured for the room type.

3.2.2 Tenant Occupancy

The tenant's move-in process and related functions are introduced.

3.2.2.1 Tenant Related Processes

Tenant Occupancy

Procedure

Step 1: After creating the room and binding the locks, enter the Personnel module, as Figure
3.2.2.1-1 shows.
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ZKBio CVSecurity i % © O win -

‘‘‘‘‘‘‘‘‘‘

NN
588 e B B

NPage Totalor s recorss

@ Card Hanagement

Figure 3.2.2.1-1

Step 2: Click the New button to open the pop-up window for adding personnel information,
and then fill in the basic details of the occupant, as shown in Figure 3.2.1.7-2.

New

Personnel ID* 1004 Department” International hotel gr. .. ¥
First Mame Last Name

Gender - Mabile Phane

Certficate Type e - Gertificate Number

Birthday Email

Hire Date Position Name -
Device Verification Password Card Number &

Biometrics Type 0 WhatsApp

4 Wireless Apartment Lock Access Conlrol Time Attendance Elevator Control Plate Register Personnel Detail v
Room Setting Send Nafification

User Role [ v

Card Humber

Passcode

Set Valid Time

Add Select All Unselect All

Figure 3.2.2.1-2
The occupant's name will be displayed in the room information.
The mobile phone number is used to receive a captcha for H5 login.
The email address is used to receive H5 login credentials and captcha information after check-in.
The card number is used for swipe verification when unlocking the door.
A randomly generated 6-digit password will be emailed to the tenant upon successful check-in.
If the Send Notification is unchecked, no related information will be sent to the tenant.

The administrator and housekeeper roles for that room will be frozen and unverifiable after the
tenant moves in.

Check-in is not allowed when the room is marked as unavailable.
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When the room occupancy does not reach the room limit, you can check in normally.

If no role identity is selected under the Apartment Lock tab, check-in will not be performed; if a role
is selected, the check-in process will proceed accordingly.

If the tenant is marked as frozen or the check-in start time has not been reached, door opening
verification will not be available.

Step 3: Fill in the information of the occupant, select the room and click confirm to complete
the check-in processing, after the check-in is completed, the server side sends commands to the

device and freezes the housekeeper and administrator, as shown in Figure 3.2.2.1-3.

Edit x
Persannel ID* 4 Department” DepatmentName  ~

FirstName 1 LastName 1

Gender s - Wobile Phone 13344445555

Centiicate Type e - Certificate Number

Birthday Emall @zMeca.com

Hire Date Position Name -

Device Verification Password Card Number 88465295

Biometrics Type ®0 WhatsApp

< SmartLock Access Control Personnel Detail v

Room Setling Freeze

18 Send Notification

UserRole Tenant -
Set Valid Time
Start Time* 2024-07-04 14:50:22

End Time* 2024-07-24 00:00:59

Add Select All Unselect All

Cancel

Figure 3.2.2.1-3

Tenant H5

The tenant will receive the initial password and H5 login link in the registration email address

after successful check-in, as shown in Figure 3.2.2.2-1.

[ZKTeco test apartment] Dear User

Your room name. is 1
the initial passcode of your room door is 056444,

Please click the link https://zkbiocvhotel.zkteco.com/portalApartmentPortall ogin.do?
tinyUrl=QuIZ32UB7RVv&lang=en US to modify your passcode as required.

Figure 3.2.2.2-1

Tenant H5 Login

Procedure

Step 1: Open the link in the e-mail, as shown in Figure 3.2.2.3-1.
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Login

Log in

Phone

Contact Website

Figure 3.2.2.3-1

Step 2: To log in via email, use the email address provided at check-in to receive the verification
code. If you prefer to log in via SMS, switch from 'Email’ to 'Phone' and use the mobile number

registered at check-in to obtain the verification code.

For assistance, click [Address] to open the hotel's location in Google Maps. Click [Contact] to
open the phone dialer and call the apartment's registered number. Click [Website] to visit the

hotel's official website.

These three parameters—Address, Contact, and Website—can be configured under [Wireless

Apartment Lock] > [Basic Management] > [Basic Settings], as shown in Figure 3.2.2.3-2."
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Log in

Wireless Apartment lock / Basic Management f Basic Settings

Baszic Information

Email Phone

Mame” ZKTeco test apartment
Telephone +B613266677800
Fax
Zip/Post Code

Sending... Website hitps:iiwwne zkteco_com/en/

> Address hitps:fimaps.app.goo. gl GJKWIpRXKAGTsZ
Housekeeping Hours 1 iminutes)
Gateway Configuration Time Period | 50 {minutes)

Figure 3.2.2.3-2

Step 3: Login successfully, as shown in Figure 3.2.2.3-3.

Room Details

ZKTeco test apartment

Start Time

2025-04-16
00:00:00

Figure 3.2.2.3-3

A Dynamic Passcode is a time-based code that updates periodically through dynamic refresh.

The start and end times represent the current tenant's effective occupancy period.

Click the B= icon in the center for remote unlocking operation.

Clicking Contact will open the dialing screen, with the apartment's phone number set as the
default.

Click Modify Passcode to navigate to the Modify Passcode screen and update the apartment lock's

unlock code, as shown in Figure 3.2.2.3-4.
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Modify passcode

Figure 3.2.2.3-4

Click on Access/Elevator Dynamic QR code to display the QR code for access control and elevator
control, when the apartment tenant is assigned to access control or elevator control privileges, the
device supports QR code authentication, and Zee can use this QR code to pass. As shown in Figure
3.2.2.3-5.

ZKTeco test apartment

Raom : Fashion Apartment1FO0

Figure 3.2.2.3-5

Click Unlocking Records to navigate to the unlocking statistics interface, where all unlocking

information can be viewed, as shown in Figure 3.2.2.3-6.
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< Back Unlocking Records

Unlocked by passcode

Unlocked by passcode

Figure 3.2.2.3-6

Tenant H5 Failure

The tenant’s H5 link will expire if the move-in period ends, the tenant is frozen, or the tenant
changes rooms. Attempting to access the link after it has expired will trigger an expiration
prompt, as shown in Figure 3.2.2.4-1.

{ Lﬂgil‘l e

The link is imvalid.

Figure 3.2.2.4-1

Tenant Exchange

Procedure

Step 1: On the Personnel Module screen, locate the information for the tenant who requires a

room change, and click Edit.

Step 2: On the SmartLock tab, uncheck the status of the current room, click add to select the
new room for occupancy. Click OK to complete the tenant room change. As shown in Figure
3.2.2.5-1.
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Edit x
Personnel 1D* 1003 Depariment™ International hotel gr . ™
First Name myl Last Name
Gender | - Mobile Phone
Cedificate Type @ | - Certificate Number
Birthday Email 1143447049@qq com
Hire Date Paosition Mame -
Device Verification Password Card Number 455455 [==]
Biometrics Type 20 VWhatsApp
5] Wireless Apartment Lock Access Confrol Time Attendance Elevator Control Plate Register Personnel Detail L ‘
Raom Setting Freeze
Fashion Apartment1F001 1 Send Motification -
User Role Tenant - ‘
Gard Number
Set Valid Time ‘
Add 2 Select All Unselect All ‘

Cancel

Figure 3.2.2.5-1

Tenant Renewal

Procedure

Step 1: On the Personnel Module screen, locate the tenant who requires a room change, and
click Edit.

Step 2: In the SmartLock tab, modify the tenant end time and click Confirm to complete the

tenant renewal. As shown in Figure 3.2.2.6-1.

4 Wireless Apartment Lock Access Confrol Time Attendance Elevator Control Plate Register Personnel Detail L [

Room Sefting Fireze
Fashion Apartment1F001 Send Malification
User Role Tenant o {
Card Number

Set Valid Time.
Start Time* 2025-04-18 14:10:26
End Time* 2099-01-01 00:00-00

Add Select All Unselect All

Cancel

Figure 3.2.2.6-1
Tenant Check-Out

There are two types of tenant check-out. The first is automatic check-out, where all SmartLock-
related content is automatically cleared upon the expiration of the tenant's stay. The second is

manual check-out, which is carried out as follows:

Procedure

Step 1: On the Personnel Module interface, locate the information for the tenant who needs to
change rooms, then click Edit to initiate the move-out process.
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Step 2: In the Apartment Lock tab, update the tenant information to "-----", uncheck the
Checked-in rooms checkbox, and click OK to complete the manual check-out.

Stewardship Related Processes
The tenant move-in process and its related functions are described below.

Butler Check-In

Procedure

Step 1: After creating the room and binding the locks, enter the Personnel module, as Figure
3.2.3.1-1 shows.

ZKBio CVSecurity & %

© Card Managoment

Figure 3.2.3.1-1

Step 2: Click the New button to open the pop-up window for adding personnel information,
and fill in the occupant's basic details, as shown in Figure 3.2.3.1-2.

International hotetgr... ~

0 WhatsApp

< Wircless Apartment Lock Access Contral Time Attendance Elevator Control Plate Register Personnel Detai

Room Sefting Send Notification

User Role Property Manager

Card Number
Passcode
Sef Valid Time

Add Select All Unselect All

Cancel

Figure 3.2.3.1-2
The Steward role will not be displayed in the room information.

The Butler role does not have message notifications enabled at this time, and the Send
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Notification feature is currently unavailable.
The card number is used for swipe verification for opening the door.
The Housekeeper role uses a 7-digit password, which is randomly generated unless manually set.

If there is no tenant in the room, the door can be opened normally after the housekeeper moves in
If there is a tenant, the housekeeper simply freezes the lock after moving in.

The Housekeeper role does not occupy the room capacity.

If the role identity is not selected in the Apartment Lock tab, no check-in will be performed. If it is
selected, the check-in process will be followed.

Step 3: Fill in the occupant's information, select the room and click Confirm to complete the
check-in process, as shown in Figure 3.2.3.1-3.

Edit

Persannel 10 1 Department: Intemational hotel gr... ~
First Name eletest Last Name

Gender - Mobile Phone

Gertificate Typs g - Gertificate Number

Birthday Email marris huang@zkteco com

Hire Date Position Name

Desice Verification Password Gard Number 2000537232 =]

Biometrics Type FO WinatsApp

¢ Wireless Apartment Lock Access Control Time Attendance Elevator Control Plaic Register Personnel Detail »

Room Setting Send Nofification

Fashion Apariment 1F001 User Role Propetty Manager ™

Card Number
Passcode

Set Valid Time

Start Time* 2025-04-16 00:00.00

End Time 2025-04-17 23:59:59

Add Select All Unselect All

Cancel

Figure 3.2.3.1-3
Housekeeping for a House
Step 1: On the Personnel Module interface, locate the information for the housekeeper who
needs to change rooms, then click Edit.
Step 2: In the SmartLock tab, uncheck the current room's check-in status, then click Add to
select the new room. Click OK to complete the room change for the housekeeper.
Housekeeper's Renewal

Procedure

Step 1: On the Personnel Module interface, locate the information for the housekeeper who

needs to change rooms, then click Edit.

Step 2: In the SmartLock tab, modify the housekeeper's end time, and click Confirm to

complete the renewal.

Page | 151 Copyright © 2025 ZKTECO CO., LTD. Allrights reserved.



ZKBio CVSecurity Smart Lock User Manual

Butler check-out

Butler check-out is divided into two cases. The first is automatic check-out upon butler
expiration, where all SmartLock-related personnel information is automatically cleared to

complete the check-out. The second is manual check-out, which is performed as follows:

Procedure

Step 1: On the Personnel Module screen, locate the information for the housekeeper who

needs to check out, then click Edit.

Step 2: In the SmartLock tab, update the housekeeper information to "-----", uncheck the
Checked-in rooms checkbox, and click Save to complete the manual check-out. Similar to the

tenant process.
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Basic Management

Basic Settings

Basic Information
(L Instructions

The name of the content apartment in the basic information is required, and the rest of the
content is non-required, as shown in Figure 3.1.1-1.

The Phone Number field serves as the default contact number when dialing from the H5
link.

The Email Address can be used to receive lock alarm notifications once it is provided.

Housekeeping Hours is used for automatic status rollover of dirty room status after a
person has checked out. If it is not set, it will never be automatically reversed.

Gateway Configuration Time Period is the default time period during which the Gateway
configuration in the device will be automatically turned on and off after the set time. The
Gateway configuration will turn on at the beginning of the set time and turn off
automatically after the set duration.

Housekeeping Hours. (minutes)
Gateway Configuration Time Period 60 (minutes)

LoGo | wEmse,

exceed 100KBUPG,. BUP. GIF, and. PNG are supported only). The ratio of length to wit

Figure 3.3.1.1-1

HTMLS5 Settings
(L) Instructions

The fields in the HTMLS5 Settings are all optional, as shown in Figure 3.3.1.2-1.
You cannot configure ports if domain names are configured.

IP + Port can be configured (Note: H5 functionality is not supported without external
network access).

HTMLS Setiings

Proxy Website https:/izkbiocvhotel zkteco com

Figure 3.3.1.2-1
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MQTT Settings
(L Instructions

The contents of the MQTT settings are all required fields, as shown in Figure 3.3.1.3-1.

MQTT settings must be the same for all 3 (MQTT, Gateway backend, apartment settings).

MQTT Settings

username” admin

FIEISSWDFEI* SN E RSN RERRRORRRRRD
url* 127.0.0.1

port* 1883

Figure 3.3.1.3-1

Administrator Settings
(L) Instructions

The content password is required, and the card number is not required in the administrator
settings, as shown in Figure 3.3.1.4-1.

The administrator password will be used to verify the lock when it is restored to factory
settings.

Administrator Seftings

EEREERE

Administrator's Passcode”

Adminisirator's Keycard

Figure 3.3.1.4-1

Once the above is set, click ok to save.

Room Type

Adding Room Types
(8 Instructions

Add a new room type, fill in the required fields and save, the room type is used to bind the
room and provide a different room types.

Room Type, Customize the room type for subsequent binding and use.

Room Size (Room Size), customize the room size, the unit according to the hotel settings in
the unit display. Convenient for subsequent binding use.
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Maximum Number of Guests, Customize the maximum number of occupants allowed in the room.
This limits the number of occupants at check-in.

To add a new room type, fill out the required fields and save. Click Save and New to continue
adding another room type, OK to save and close, or Cancel to discard changes and close. See
Figure 3.3.2.1-1 shows.

New x

Room Type* | | Room Size()*
Number of Beds® Maximurm Mumber of Guests®
Motes

Amenities

] Air Conditioner [ ] Bath and Shower v [] wireless Internet

] Refrigerator [C] Telephone [[] Safe Box [] Shower

Cancel

Figure 3.3.2.1-1

Editing Room Types

(D) Instructions

. L . &
You can access the edit screen by clicking on the room type name or the action column =

The contents of the edit screen are the contents of the most recently modified page.

All contents can be edited and modified normally. Refer to Figure 3.3.2.2-1.

Edit x

Room Type* » Room Size() 20
Humber of Beds” 22 Maximum Number of Guests”

Notes

Amenities

i

Cancel

Figure 3.3.2.2-1
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Removing Room Type

LD Clarification

T

Check the room type to be deleted and click the action column or the Delete button to delete it.

If the room type is in use, it cannot be deleted. Clicking Delete will display a prompt, as shown in
Figure 3.3.2.3-1.

-\

-~

Initialization data cannot be deleted!

Figure 3.3.2.3-1

Room

Adding a Room
L Instructions
Add a room, fill in the required fields and save, then user can create buildings, floors, and rooms.

Building Name (Building Name) Customize the building name, which will be displayed in the room's
real-time monitor after creation. Used for splicing room names.

Floor Name (Floor Name) Customized floor names, which are created and displayed in the room's
real-time monitor, are used to splicing room names.

Room Type binds the 3.2 room type to the room.
Room Count The total number of rooms to be created.
Remarks (Remarks).Information or notes related to the room.

When a new node is added and a floor is selected, the creation will automatically fill in the building
and floor name, as shown in Figure 3.3.3.1-1. Selecting the hotel node is shown as empty by
default.

New x

Building Name* v -
Floor Name® 2F -
Room Type® T -
Starting Room Number*

Room Count* 0

Remarks

Room name Cration rule: Building No. + Floor No. + Room No.

Cancel

Figure 3.3.3.1-1
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Change the Room Name
L Instructions

To modify the building and floor name, you need to select the corresponding node and click the Edit
button, as shown in Figure 3.3.2-1.

ORefresh =¥ New £ Edit @ Delete Building and Floor OReiresh S New £ Edit @ Delete Building and Floor
e s s ? A ___ ORelresh i Delete

Eait x
4 testhotel = Bu

2] test hotel e *

8
e Building Name* V1 “dhyt Floor Name* o p
N 1 FoF
For ¥
¥ i A
1F

Cancel

[ y11E102 2l

Figure 3.3.3.2-1

To change the room name, select the corresponding room, click the room name, and the comment
in the current field will appear in the comment field of the room's real-time monitoring screen, as
shown in Figure 3.3.3.2-2.

The current field refers to the comment section in the room information displayed on the Real-
time Monitoring screen, as shown in Figure 3.3.3.2-2.

Edit x

Buiiding Name"

Floor Name*

Room Type* shuangren =
Room No.* 200

Remarks

Cancel

Figure 3.3.3.2-2
If the room is in use, it cannot be edited, and editing gives a failure indication.

Removing the Room
L Instructions

Select the rooms to be deleted and click the Action column or the Delete button to remove them.

If the room type is in use, it cannot be deleted. Clicking Delete will display a prompt, as shown in
Figure 3.3.3-1.

%]
S

Please unbind all locks from selected roomy11F102

Figure 3.3.3.3-1
To delete buildings and floors, use the Delete Building and Floor button.

To delete a floor, you must first delete the rooms under that floor; otherwise, the deletion will fail,
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and an error message will be displayed. Similarly, to delete a building, you must delete the floors

first, as shown in Figure 3.3.3.3-2.

Prompt

Please delete the room first!

Figure 3.3.3.3-2

Email Template

L Email Templates Overview

Email templates are used for sending notifications, including H5 account login verification codes,
door lock alerts, low battery warnings, and initial unlocking password notifications, as shown in

Figure 3.3.4-1.

Name Code Content

EmailMobileLoginVeri [##aparimeniName##] Dear User, welcome 1o login app. verifyCode is ##verifyCode## ple Yes Vd
EmallMultipleVerificati [##apartmentName##] Dear User, the smart lock of room No ##roomMo## has been falled Yes
EmailAntiPryingWarnii  [#2aparimentNames#] Dear User, the smart lock of room No_£2roomNo## is in lamper ala Yes

EmailElectricityWarnir [##aparimeniName##] Dear User, the smarf lock of room No ##roomNo## is In low power Yes

EmailSendPwd

[##apanmentNames#] Dear User, the initial passcode of your room door is ##pwd#e. Plez Yes

Enable Operations

k B s

&Y

Figure 3.3.4-1

Preset templates can only be edited, and deletion is not allowed. Some parts of the templates may

have restricted editing permissions.

Refer to Table 3.3.4-1 for email template key fields.

H5 account
code

login verification

Dear User, welcome to the login app. The verify
Code is ##verifyCode##. Complete this operation

within five minutes.

Door Lock Multiple Verification
Failure Alert

[##apartmentName##] Dear User, the SmartLock
of room No.##roomNo## has been failed to verify
continuously,

please confirm the security

immediately.

Door lock picking reminder

[##apartmentName##] Dear User, the SmartLock

of room No.##roomNo## is in tamper alarm state,
please confirm the security immediately.

Door lock low battery alert

[##apartmentName##] Dear User, the SmartLock

of room No.##roomNo## is in low power state,
please replace the batteries immediately.

Initial unlock code issued
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Typology Element

passcode of your room door is ##pwd##. Please
click the link ##tenantEditUrl## to modify your
passcode

Table 3.3.4-1

3.3.4.1 Send Template Content

Procedure

Step 1: Mail delivery requires you to set up the mailbox server in the system settings now, as
shown in Figure 3.3.4.1-1.

Figure 3.3.4.1-1

Step 2: Enable the template and configure the corresponding fields and text as shown in Figure
3.3.4.1-2.

Name* HEBSBRINER
Code’ | EmailobileLoginveryCo|
Enable” Yes -

Coe H B T F I U s

S W
A2m

6 © B @ BE > -

[##apartmentName##] Dear User, welcome to login app. verifyCode is ##eriyCode##, please
complete this operation within five minutes

| Came |

Figure 3.3.4.1-2
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Step 3: After completing the corresponding operation, you will receive the template
email, as shown in Figure 3.4.1-3.

[Apartment] Dear User, welcome to login app. verifyCode is 985319, please complete this operation within five minutes.

Figure 3.3.4.1-3

SMS Template

L SMS Template Overview

SMS templates are used for sending SMS, including templates for H5 login CAPTCHA delivery, as
shown in Figure 3.3.5-1.

Name Code Content Type Enable Operations

SmsMobileLoginVerify aws,whatsapp Yes 2

Figure 3.3.5-1

Preset templates can only be edited, and deletion is not allowed. Some parts of the templates may
have restricted editing permissions..
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Report Management

Device Event Reports

Device Event Reports Overview

The first line is the search bar, you can select the building name, floor name, room name, and time to

ZKBio CVSecurity

B DeviceManagement >

i RoomManagement >
[ BasicManagement >

Report Management v

Device Command List
OTA Upgrade Records
Gateway Response Records

Issued Card Report

®

Buiding Name

GRefiesn T Export

Personnel No

134670255

111

i

134679255

1003

134679258

1003

1003

134679255

1003

1003

134679255

1003

134679255

Event Type

User Management

User Management

User Management

User Management

User Management

User Management

User Management

User Management

User Management

User Management

User Management

User Management

User Management

User Management

Floor Name | ——

Wireless Apartment lock / Report Management / Device Event Reports

~ | RoomName |—

Event Details Building Name Floor Name
Freeze User Fashion Apartment  1F
Unfreeze User Fashion Apartment  1F
Greate or Modify Pass Fashion Apartment  1F
Freeze User Fashion Apartment  1F
Unfreeze User Fashion Apartment  1F
Freeze User Fashion Apartment  1F
Unfreeze User Fashion Apartment  1F
Greate or Modity Pass Fashion Apartment  1F
Unfreeze User Fashion Apartment  1F
Unfreeze User Fashion Apartment  1F
Greate or Modiy Pass Fashion Apartment  1F.
Unfreeze User Fashion Apartment  1F
Delete Passcode  Fashion Apartment  1F
Unfreeze User Fashion Apartment  1F

Reports support exported views.

filter the record data query, as shown in Figure 3.4.1-1.

vore- Q B &

Room Name Lock MAC Address
Fashion Apartment1F0 C40B94FFFECESIE
Fashion Apariment1F0 G4S894FFFECESATE
Fashion Apariment F0. G4SB94FFFECESAIE
Fashion Apariment 1F_ G4S894FFFECESATE
Fashion Apariment F0. G4SB94FFFECESSIE
Fashion Apartment1F0 C4G894FFFECESSTE
Fashion Apariment F0. G4SB94FFFECESAIE
Fashion Apariment 1F)_ G4S894FFFECESATE
Fashion Apariment F). G4SB94FFFECESSIE
Fashion Apariment1F0 G4S894FFFECESATE
Fashion Apartment1F0 C40B94FFFECESIE
Fashion Apariment 1F_ G4S894FFFECESATE
Fashion Apariment F0. G4SB94FFFECESSIE

Fashion Apartment1F0 C49894FFFECS681E

Figure 3.4.1-1

All records in the report are reported by the source locking device.

Device Command List

Instructions

02 € O awmn -

First Name Last Name Submission Time
2025.04.16 17:41:05
cletest 2025.04-16 17:41:03
eletest 2025.04-15 17:40:53
2025.04-16 14:10:34
myt 2025.04-16 14:10:20
2025.04-16 14:00:38
myt 2025.04-16 14:09:33
o 2025.04-16 14:09:35
2025.04-16 14:05:10
it 2025.04-16 14:05:07
myt 2025.04-16 14:05:04
2025.04-16 14:04:50
myt 2025.04-16 14:04:49

2025-04-15 14:03:16.

The first line contains the search bar, where you can filter and query recorded data by selecting the

ZK
7]

CVSecurity

) Room anagoment

[ Basic Management

Report

Management

Devics Event Reporis

OTA Upgrace Recorss

>

Gatenay Response Recorcs

Issued Card Report

e Mo Actress |

SRefiesn @ Cloar Al Commands

cup 10

17asTsestaszt

1744756458400

TaaTsasisTy

1744783064056

1TasTsaTTSses

1rasTassions

1744783557820

seo

casserrrECaIIE

CA9BO4FFFECTSOIE

cessaurrrECsssIE

CesnasFrECTIIIE

CAnBaAFFFECEsOIES

cessaarrrECaRIIE

Conma4FFFECEsOIE S

cossauprreCssstE.

Co9m94FFFECTSIIE

o [wasorre s

Gatemay MAC Acer.

4939414090

4989414090

cassauctansn

4989414090

Can894C1AD0

U C49394C14090

U C49894C1AD50

e U Ce394C13090

49694014090

Zigbes MAC adaress

device MAC address and time range, as shown in Figure 3.4.2-1.

CASIAFFFECHBIE  Lock

CASBUMFFFECHSHIE Lock

CaSBOMFFFECHSSIE  Losk

CASBUAFFFECHSOIE Lock

CASBIMFFFECHSSIE  Losk

CASIAFFFECHOBIE  Lock

CASBOAFFFECHSSIE  Lock

cassssrprECISSIE Lock

CASEOAFFRECIIIE  Lock

Figure 3.4.2-1

Reports support the deletion of all data.

Report data older than 7 days is automatically deleted.
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All records in the report originate from commands issued by the software.

OTA Upgrade Records

LD Clarification

This page records all OTA upgrade records and allows you to view the current upgrade status, as
shown in Figure 3.4.3-1.

ZKBio CVSecurity i 8 08« O i~
Eb DeviceManagement >  Wireless Apartment lock / Report Management / OTA Upgrade Records
OTA Upgrade Records < Upgrade Details >
Room Management
© Refres O Refresn
7 BasicManagement >
Command . Upgrade File Name staws Upgrade Veision Success... Falla  InProgr.. Waltng  Cancelled Hame MAG Address staus
Report Management
Device Event Reports
Device Command List
Gatewiay Response Records
Issued Card Report I
Nocsta
o SOtows perpage - JumpTo 1 [0 Page Totalof O records

Figure 3.4.3-1

The report allows you to view all records that have had an upgrade operation.

Gateway Response Records (GRR)

LD Clarification

This page records logging information for all Gateway responses, as shown in Figure 3.4.4-1.

ZKBio CVSecurity i % 0O & 8 O amin -
b DoviceManagement ~ >  Wireless Apartment lock / Report Management / Gateway Response Records
£ Room Management 73 Toeic | MaC: G ]
[ Basic Management > S Refresh
Topic mac Syne Time PaRANS
Report Management
rexIR101Galeway/C49 C49894C1ADS0 2025.04-16 18:50:57  (fopic™thing/hearlBeal” "l "644" "params[{'productKiey”"R101Gateway", “doviceName" "C49894C1ADIO" version™"cao:V1.7.6 wireless_sdk1.0.19 [May 10

Device Event Reports

rexIR101Gateway/C49 C49894G1ADS0 2025-04-16 18:49:57  {topic" "thing/heartBeat” "id""643" "params"[('productKey""R101Gateway", "deviceName":"C49894C1AD90" “version""coo V1 7.6 wireless_sdk-1.0.19 [May 10
Device Command List
rex/R101Gateway/C49. G49894C1AD90 2025.04-16 16.48:57  {topic™ "lhing/heartBeat "id""642" “params"{{'productey""R101Gateway"."deviceName" "C43894C1ADS0" “version”"coo-V1.7.6 wireless_sdk 1.0.19 [May 10
OTAUpgrade Records
rex/R101Gateway/C49. C49894C1ADS0 2025-04-16 18:47:57  {topic "0 641" params™I{'p i deviceName" Version™"coo V1 7.6 wireless_sdk 1.0.19 [May 10
«  rexR101Galeway/C49 C49894C1ADS0 2025-04-16 18:46:57  {topic: id""640" “params deviceName” Version”"co0V1.7.6 wireless_sdk-1.0.19 [May 10
Issued Card Report g s i g S .
rex/R101Gateway/C49. C49334C1ADI0 2025.04-16 16:45:57  {topic” "thing/heariBeat” "id":*63" “params™[{'produciKey""R101Galeway" “deviceName"-*C49894C1ADS0" “version""coo V1 7.6 wireless_sdk 1.0.19 [May 10
rexIR101Gateway/C49 G49894C1AD90 2025.04-16 18:44:57  ('topic "thing/heartBeat "ia" 638" “params"[("productKey""R101Gateway" "deviceName" "C49394C1ADI0" “version""cooV1 7.6 wireless_sdk:1.0.19 [May 10
rex/R101Gateway/C49. C49894C1ADS0 2025.04-16 164357 {topic™ "thing/heariBeat” "id""637" “params™{{'productey""R101Galeway","deviceName"-*C43894C1ADS0" “version”"coo V17,6 wireless_sdk 1.0.19 [May 10
rex/R101Gateway/C49. C49894C1ADS0 2025-04-16 184257 {topic™ "lhing/heartBeat" "id""636" “params"[{'productey""R101Galeway" “deviceName" "C49894C1ADS0" “version”"coo V1 7.6 wireless_sdk 1.0.19 [May 10
rex/R101Gateway/C49. C49394C1ADS0 2025.04-16 18:41:56  {'topic: " “params™{{'p g deviceName" Version""co0 V1 7.6 wireless_sdk 1.0.19 [May 10
rex/R101Gateway/C49 C49894C1ADS0 2025.04-16 16:40:56  (topic™ "thing/heartBeat "id" "634" “params"[{'productKey""R101Galeway" “deviceName’ "C49394C1ADS0" “ersion™"coo V1 7.6 wireless_sdk 1.0.19 [May 10
rexIR101Gateway/C49 C49894C1ADS0 2025-04-16 18:39:56  {topic" "thing/heartBeat" "id""633" "params"[("productKey""R101Gateway", "deviceName":"C49894C1ADI0" “version""coo V1 7.6 wireless_sdk-1.0.19 [May 10
rex/R101Gateway/C49. G49894C1AD90 2025.04-16 16:38:56  {topic™ "lhing/hearBeat: "id""632" “params™{{'productey""R101Galeway"."deviceName" "C4394C1ADS0" “version”"coo-V1.7.6 wireless_sdk 1.0.19 [May 10
rex/R101Gateway/C49. C49394C1ADS0 2025.04-16 18:37:56  {'topic: g 631 paramsI{'p g deviceName" Version™"co0 V1 7.6 wireless_sdk 1.0.19 [May 10 .
150 > > SOrowsperpage * JumpTo 1 115 Page  Total of 701 records

Figure 3.4.4-1

The report content is derived from the Gateway response content.
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Issued Card Report

L Instructions

This page records all card issuance records, as shown in Figure 3.4.5-1.

1ZKBio CVSecurity
2 Device Management >
Z9 RoomManagement >

Basic Management >

Report Management v
Device Event Reports
Device Command List
OTAUpgrade Records

Gateway Response Records
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®

Wireless Apariment lock / Repert Management / Issued Card Report

© Refresh

Gardnolder Name

Morris

Morris

Morris

Morris

Marris

Morris

Wes

wes

Test

Test

Issued Date |2025-01-16 00.00.00

Card Number

100000

213321321

213321321

213321321

213321321

213321321

603271980

603271980

403271980

2981235024

2992537232

231435

603271980

603271930

50 rows per page

JumpTo 1

Phone Number

254-748222664

254-748222664

254.748222664

254-748222664

254-748222664

11 Page

To | 2025-04-16 235959 Q B ¢

Email
mortis. huang@zkieco.com
lun li@zkleco com

lun li@zkteco com

mortis. huang@zkteco.com
mortis. huang@zkteco com
morris. huang@zkieco.com
tangiao@zkteco com
tandiao@zkteco.com

tandiao@zkteco.com

tandiao@zkteco com

tandiao@zkteco com

Total of 38 records

Figure 3.4.5-1

1D Type

1D Number

340238

340238

340238

340238

340238

O 28 O adin

lasued Time
2025-08-01 15:00:34
2025.04.01 14:41:12
2025.08.01 12.28:45
2025.04.01 14:14:30
2025.04.01 14:05:02
2025.04.01 14:04:04
2025.03.26 20:38:04
2025.03.25 18:53:30
2025.03.25 13:40:44
2025.03.25 18:44:42
2025.03.25 18:43:54
2025.03.25 15:42:00
2025.03.25 13:50:12

2025.03-25 11:43:14
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